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1. INTRODUCTION
1.1. Overview
THERM is a state-of-the-art, Microsoft Windows™-based computer program developed at Lawrence
Berkeley National Laboratory (LBNL) for use by building component manufacturers, engineers, educators,
students, architects, and others interested in heat transfer. Using THERM, you can model two-dimensional
heat-transfer effects in building components such as windows, walls, foundations, roofs, and doors;
appliances; and other products where thermal bridges are of concern. THERM's heat-transfer analysis allows
you to evaluate a product’s energy efficiency and local temperature patterns, which may relate directly to
problems with condensation, moisture damage, and structural integrity.
THERM’s two-dimensional conduction heat-transfer analysis is based on the finite-element method, which
can model the complicated geometries of building products. The program’s graphic interface allows you to
draw cross sections of products or components to be analyzed. To create the cross sections, you can trace
imported files in DXF or bitmap format, or input the geometry from known dimensions. Each cross section is
represented by a combination of polygons. You define the material properties for each polygon and
introduce the environmental conditions to which the component is exposed by defining the boundary
conditions surrounding the cross section. Once the model is created, the remaining analysis (mesher and heat
transfer) is automatic. You can view results from THERM in several forms, including U-factors, isotherms,
heat-flux vectors, and local temperatures.

Figure 1-1. Sample THERM window cross section

This version of THERM includes several new technical and user interface features; the most significant is a
radiation view-factor algorithm. This feature increases the accuracy of calculations in situations where you
are analyzing non-planar surfaces that have different temperatures and exchange energy through radiation
heat transfer. This heat-transfer mechanism is important in greenhouse windows, hollow cavities, and some
aluminum frames.
THERM is a module of the WINDOW+5 program under development by LBNL. WINDOW+5 is the next
(1,2)
generation of the WINDOW software series and is being developed for the Microsoft Windows™ operating
environment. THERM's results can be used with WINDOW's center-of-glass optical and thermal models to
determine total window product U-factors and Solar Heat Gain Coefficients. These values can be used, in
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turn, with the RESFEN program, which calculates total annual energy requirements in typical residences
throughout the United States.
Update information, future releases, and program information about THERM and the other software tools
from the Windows and Daylighting Group at LBNL mentioned above can be found on the World Wide Web
at URL: http://windows.lbl.gov. To obtain a copy of THERM, WINDOW, or RESFEN, fax or email your
address and phone number to Software Request, Fax: 510 486-4089, email: PLRoss@lbl.gov. If you have
questions or problems about using the program, email Thermhelp@lbl.gov.

1.2. New THERM Features
This version of THERM significantly upgrades the calculation and drawing features of the previous program.
1.2.1. New General Features


32-bit program compilation allows multitasking and greater detail in models,



Report of simulation results can be printed,



THERM files can be exported to a format that WINDOW 4.1 can read,



Temperature is displayed at cursor,



Calculation manager can run batch simulations.

1.2.2. New Drawing Features


Automatic cavity fill feature,



Drawing can be flipped and rotated to any angle,



Improved void and overlap detection,



"Undo" of one level when drawing.

1.2.3. New Calculation Features

1-2



View-factor radiation modeling accounts for self viewing effects. This is particularly useful for
modeling projecting products such as greenhouse windows, skylights, and certain aluminum
windows (e.g., sliders) that "see" themselves.



Advanced view-factor radiation modeling for window frame cavities accounts for self-viewing
elements in cavities.



Condensation Index modeling option uses local (as opposed to average) convection correlations
in glazing cavities, as well as the advanced view factor radiation model, resulting in more
accurate local temperatures than in previous version.



"Tape measure" calculates average temperatures across any line segment.
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1.3. THERM Components
THERM has three basic components:


a graphic user interface that allows you to draw a cross section of the product or component for
which you are performing thermal calculations.



a heat-transfer analysis component that includes: an automatic mesh generator to create the
elements for the finite-element analysis, a finite-element solver, an optional error estimator and
adaptive mesh generator, and an optional view-factor radiation model.



a results displayer.

1.3.1. The THERM Graphic User Interface
(TM)

THERM has standard graphic capabilities associated with the Microsoft Windows
example, THERM allows you to use:

operating system. For



Both mouse and cursor operations;



Standard editing features, such as Cut, Copy, Paste, Select All, and Delete;



A toolbar to access frequently used commands and short-cut keys;



Multiple windows so several projects can be open concurrently.

THERM has powerful drawing capabilities that make it easy to model the geometry of the cross section of a
building component.
You can use two methods to draw a cross section:


Trace an imported DXF or bitmap file.



Draw the geometry based on a dimensioned drawing.

The following thermal properties must be defined for the cross section geometry:


Material properties (broken into two classes: solids and cavities) of each component of the cross
section,



Boundary conditions at the external edges of the cross section.

1.3.2. Heat-Transfer Analysis
THERM uses two-dimensional (2D) conduction and radiation heat-transfer analysis based on the finiteelement method, which can model the complicated geometries of fenestration products and other building
elements. (A complete discussion of the solution method is available in Finlayson 1995(4) and Curcija et al.
(10)
1995 as well as in Appendix C of this manual). This method requires that the cross section be divided into
a mesh made up of nonoverlapping elements. This process is performed automatically by THERM using the
(5)
Finite Quadtree method . Once you have defined the cross section’s geometry, material properties, and
boundary conditions, THERM meshes the cross section, performs the heat-transfer analysis, runs an error
(4)
estimation, refines the mesh if necessary, and returns the converged solution. See Appendix C for more
details.
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1.3.3. Results
The results from THERM’s finite-element analysis of a fenestration product or building component can be
viewed as:


U-factors,



isotherms,



color-flooded isotherms,



heat-flux vector plots,



color-flooded lines of constant flux,



temperatures (local and average, maximum and minimum).

The rest of this manual explains how to get started using THERM:

1-4



how to install the program,



how to draw the cross-section geometry,



how to define the thermal properties,



how to perform the thermal analysis,



how to view the results,



how to print a report,



how to export files to WINDOW.
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2. INSTALLATION
2.1. Computer Requirements
First, make sure your computer system meets these specifications:


IBM-compatible 80486 or higher with a math coprocessor. A Pentium-class computer is preferable
for speed.



At least 16 MB of random access memory (RAM). 32 MB or more of RAM is preferable for optimum
operation.



Microsoft Windows 95 , or Windows NT . (Note: If you are running THERM under Windows NT ,
make sure that the Windows 95 checkbox in the Options/Preferences, Preferences tab is unchecked
after you have installed the program).



WINDOW 4.1 (must be installed to create glazing systems).



Hard disk drive with at least 5 megabytes of available disk space.



Printer supported by Microsoft Windows 95TM, or Windows NTTM (serial, parallel, or shared over a
network).

TM

TM

TM

2.2. Installing the Program
1.

Put the program installation diskette in the appropriate floppy drive.

2.

From the Start button in Microsoft Windows 95

TM

TM

or Windows NT , choose Run.

Figure 2-1. Choose Run from the Microsoft Windows 95™ or NT™ Start button.
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3.

When the Run screen appears, type
a:\setup.exe
Click on the OK button.
Substitute the appropriate floppy drive name if the THERM diskette is not in drive "a"

Figure 2-2. Run the SETUP.EXE file on the THERM diskette.

A small Setup window will appear saying that THERM setup is preparing the InstallShield® Wizard.
Wait for this window to disappear; then, proceed to the next step.

Figure 2-3. The Setup window

4.

2-2

The THERM Welcome window will appear. From this window, continue the installation by clicking on
the Next button, or cancel the installation by clicking on the Cancel button. Each installation window
has a Back and a Cancel button, so you can return to previous steps or stop the installation at any time.
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Figure 2-4. The THERM Welcome window
Click on the Next button to install the program.

4.

Setup will display the Software License Agreement screen. You must click on the Yes button and agree
to the terms of the license in order to continue with the installation.

Figure 2-5. The initial THERM Setup window.
Click on the Continue button to install the program.
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5.

In the User Information screen, type your name and company into the input boxes; then, click on the
Next button.

Figure 2-6. Type your name and company in this Setup screen and click on the Continue button.

6.

Setup will automatically install THERM in the Program Files directory on your C: drive. If you want to
change the drive location and/or the name of the directory, you can click on the Browse button to
specify a different drive. When you have finished, click on the Next button.

Figure 2-7. Default location for the THERM installation is C:\Program Files\Therm; you can change the location using Browse.

2-4
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7.

In the Select Program Folder screen, setup will automatically default to a folder called THERM; you can
specify a different folder.

Figure 2-8. Default Program Folder is THERM

8.

Setup will display all the settings you have specified; if you want to change any settings, you can click
on the Back button. Note that the Setup Type is always set to Complete.

Figure 2-9. Setup verifies all the installation settings.
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9.

Setup will decompress the installation files and copy the program files to the directory specified in the
previous screen. Setup will also create all the subdirectories and associated files needed for THERM to
run. Setup will ask for the necessary disks as it progresses through the installation.

Figure 2-10. Setup will decompress and copy the program files to the specified location.

10.

Setup gives you the option of viewing the README file. When you are ready, click on the Finish button
to complete the installation.

Figure 2-11. You can view the README file or click on Finish to complete the installation.

2-6
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11.

Setup will automatically make an entry for THERM in the Programs list, accessible from the Start
button.

Figure 2-12. THERM can be run from the Start Programs list.
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3. QUICK START
This chapter is intended to provide a summary of the steps for drawing a cross section and calculating the
results. Each section references places in this manual that explain procedures in more detail.
The examples shown are for typical window cross sections. However, all of THERM’s features (except for the
Condensation Index Model which only applies to glazing systems) can be used to model two-dimensional
representations of products.

3.1. Draw Cross Section and Select Materials
(for detailed instructions, see Chapter 5, "Drawing Cross-Section Geometry")
1.

If tracing an underlay, bring in a DXF or bitmap file (using File/Underlay); to draw the cross section
geometry yourself, go to the next step.

2.

Press the Draw Polygon or Draw Rectangle toolbar button.

3.

Select the material for the element you are drawing from the pull-down list in the upper right of
screen. (Type the first few letters of the material to scroll through the list without using the mouse).

4.

If using an underlay, trace the cross-section elements with your mouse, or work from a dimensioned
drawing using THERM’s step function (type a value to set the step size; when you press an arrow key
the cursor will move by the step distance in the direction of the arrow key; see Section 5.5, "Drawing
Using the Keyboard"). THERM recognizes the vertices of the DXF file and will snap the lines being
drawn to the underlay. Select new materials as needed before you draw each component, and the
materials will be automatically assigned to that component. Draw all components except the glazing
system, which will be inserted later.
If the cursor is snapping to lines or points inappropriately, zoom in (click on the right mouse button)
to reduce cursor sticky distance (Shift-right mouse click zooms out), or use Draw/Snap Settings.

Step 2:
Push Draw
Polygon button

Step 3:
Select Material

Step 2a (optional):
Click on Repeat button to
stay in Draw Polygon mode.
Note: Do not draw the
glazing system if you
plan to import it from
WINDOW

Note: Do not draw
elements that are not
thermally important

Step 4:
Draw polygons for solids & cavities. Click
your mouse where you want to start drawing,
move the mouse to the next point, click on
the left mouse button, and a line will be
drawn. Continue around the polygon in this
manner. The cursor will snap to points on the
underlay.

Step 1:
Insert Underlay
(File/Underlay)

Select new materials as needed when you
draw the polygons.

THERM 2.0
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3.2. Drawing Features
There are several powerful drawing features in THERM, including fill void; insert, move and delete points;
move, cut, copy, and paste polygons; and flip and rotate the entire cross section. See Section 5.6 "Editing
Polygons" for an in-depth discussion of these features.
1.

Fill Void feature: An area of the drawing that is completely surrounded by polygons can be
automatically "filled" by THERM, using the Fill Void
toolbar button.
To fill an area, first select the Material you want to "fill" with, such as the Frame Cavity (NFRC
Simplified) material shown in the figure below. Then push the Fill Void toolbar button, and a Fill
Void cursor will be displayed. Put the cursor inside the area to be filled and press the left mouse
button. (If the area to be filled is smaller than the cursor, zoom in by pressing the right mouse
button). THERM will automatically create a polygon that fills the area.
For THERM to perform its calculation, the cross section must not contain any voids or overlaps (see
Section 6.3.2, "Finding Voids and Overlaps"). THERM drawing features that are designed to
minimize unintentional creation of voids and overlaps as you are drawing include the fill void
feature, the "snap" feature (see Section 5.3.3, "Snap Settings") and the dynamic overlap checking as
you draw polygons.

Step 2: Push the Fill
Void toolbar button
Step 1:
Select the Material you want to
"fill" with, in this case a Frame
Cavity Material.

This drawing has many
areas that are surrounded
by polygons. These areas
can be "filled"
automatically by the
program.

Step 3: You will see a Fill
Void cursor. Place that
cursor in the vacant area you
wish to fill. The area must be
completely bounded by other
polygons.
Step 4: Click the left mouse
button.
The area will be automatically
filled, creating a new polygon
with points automatically
defined that match the
surrounding polygons.

3-2
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2.

Insert Points: If you need to insert new points into a polygon, use the following steps:


Click on the polygon to which you want to add the point



Click on the Insert Points toolbar button



Move the mouse cursor over the location on the polygon where you want to add the point.



Click the left mouse button. A new point will be added.

Step 2: Click on the
Insert Point toolbar
button.

Step 1: Click on the
polygon to which you
want to add the point.

Step 3: Click on the line
where you want the new
point; THERM will add the
new point.

THERM 2.0
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3.3. Materials
(see Section 5.10, "Assigning Materials After Drawing Polygons" and Section 5.11,
"Defining New Materials")
Materials can be specified as you are drawing; they can also be changed after polygons have been created.
1.

Double-click on a polygon; the Properties for Selected Polygon(s) dialog box will be displayed.
Depending on the type of material selected for the polygon (Solid, Frame Cavity, or External
Radiation Enclosure), different values will be displayed in the dialog box.

Double-click on a
cavity polygon to see
the Properties for
Selected Polygons
dialog box

2.

From Properties for Selected Polygon(s), you can press the Library button, and the Material
Definitions dialog box will be displayed. From Material Definitions, you can view all the entries in
the Material Library in order to see more detailed characteristics of each material.

3.

The THERM material library contains predefined materials that cannot be edited; however, from the
Material Definitions dialog box you can create new material library entries, using the New button.

Click the left mouse button on the
Library button and the Material
Definitons dialog box will open,
displaying characteristics for the
selected material.

The predefined materials in the
THERM Material Library are
protected from editing. However,
you can create new material library
entries using the New button.

3-4
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3.4. Insert Glazing System
(see Chapter 5, "Drawing Cross-Section Geometry")
1.

On the left-hand side of the glazing unit, draw a rectangle to represent the sealant between the
glazing and the frame.

2.

Use the Locator, accessed from Draw/Locator, to define the lower left corner of the glazing system to
be inserted.

3.

Select the Libraries/Glazing System menu choice to access the Glazing Systems dialog box, and
choose a glazing system previously created in WINDOW 4.

4.

From the Glazing System dialog box, use the pull-down list to select a glazing system from the
WINDOW4 (glzsys.w4) library; click on the Import button. You can use the Browse button to change
to a glazing system library in another directory.

5.

The Insert Glazing System dialog box will appear. Enter all information in the input fields, in
particular the cavity height (if you are using the Condensation Index Model), sight line, and spacer
height dimensions. Leave the Draw Spacer box unchecked if you want to paste in a spacer from
another THERM file. Press the OK button.

6.

THERM will insert the glazing system automatically. If you get a message that the glazing system
won’t fit, adjust the frame components as needed.

7.

Add another rectangle for the sealant to fill in any gap between the right side of the glazing system
and the frame.

Step 3:
Choose
Libraries/Glazing
System menu
choice.
Step 1:
Draw polygon to
represent glazing
sealant on left side.

Step 4:
Pick the Glazing System.
Click on the Import button.

Note: Checking this box allows you to
use the Condensation Index model
for WINDOW glazing systems. See
Section 5.7 for more detailed
information on this feature.

Step 5:
Enter the cavity
height, sight line, and
spacer height
dimensions in the
Insert Glazing
System dialog box.

Step 2:
Select Draw/Locator menu
choice, place cursor at lower
left corner where glazing
system will be inserted, and
click the left mouse button.
Locator circle will appear.

THERM 2.0

You can use the
Tape Measure
toolbar button to
measure these
spaces while the
Insert Glazing
System dialog box is
open.
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3.5. Adding a Custom Spacer
THERM’s copy and paste drawing features allow you to have libraries of components that can be used in
many different cross sections. You could, for example, store a spacer in a separate THERM file that can be
copied into any cross section you are drawing. You can also make use of the flip and drawing locator
features during this process.
1.

Open the THERM file containing the spacer. In the example shown, the file contains half of a
spacer.

2.

Use the Draw/Locator menu choice and click your left mouse button on the upper left corner of
the spacer.

3.

Use the Edit/Select All menu choice to select all the polygons in the spacer.

4.

Use the Edit/Copy menu choice or Ctrl-C to copy all the selected polygons into memory in
standard Microsoft Windows™ style.

5.

Use the File/Open menu choice to open the cross section into which you want to copy the spacer.

6.

Use the Draw/Locator menu choice to position the locator in the upper left corner of cavity where
the spacer will go. The location of the Locator in this file should match the position where you
placed the locator on the spacer; the program will match up the two locator positions when you
paste the spacer.

7.

Use the Edit/Paste menu choice or Ctrl-V to paste the spacer into the second cross section. The
program will place the copied spacer by matching the two locator positions. Now you have
positioned your half spacer in the cross section. To complete the spacer, continue with the
following steps.

Step 1:
Open the THERM file
containing the spacer.

Step 2:
Use Draw/Locator to
position locator in upper
left corner of spacer.

Step 5:
Open the cross section
into which you want to
copy the spacer.
Step 6:
Use Draw/Locator to
position locator in upper
left corner of cavity.

Step 7:
Use Edit/Paste to paste
spacer polygons into cavity.

Step 3:
Use Edit/Select All to select
all polygons in spacer.
Step 4:
Use Edit/Copy to copy spacer
polygons into memory.

3-6
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8.

Use the Window menu to select the spacer file.

9.

In the spacer file, use the Draw/Flip/Horizontal menu choice to flip the spacer; this new shape
will form the second half of the spacer when pasted into the cross section. (THERM applies the
flip and rotate functions to the entire cross section).

10. Use the Draw/Locator menu choice and click your left mouse button on the upper right corner of
the spacer.
11. Use the Edit/Select All menu choice to select all the polygons in the spacer geometry.
12. Use the Edit/Copy menu choice or Ctrl-C to copy the "flipped" spacer polygons.
13. Use the Window menu to view the cross section into which you already pasted the first half of
the spacer.
14. Use the Draw/Locator menu choice to position the locator in the upper right corner of the cavity
to which you want to match the upper right corner of the spacer.
15. Use the Edit/Paste menu choice or Ctrl-V to paste the spacer into the cross section. The program
will place the copied spacer by matching the two locator positions. Now the second half of the
spacer is in position.
16. Use the File/Save menu choice to save the cross section containing the new spacer.

Step 8:
Use the Window menu to
select the spacer file.

Step 13:
Use the Window menu to view
the cross section.
Step 14:
Use the Draw/Locator menu
to position the locator in upper
right corner of cavity.

Step 10:
Use the Draw/Locator menu to
position the locator in upper
right corner of spacer.

Step 11:
Use the Edit/Select All menu to
select all the spacer polygons.
Step 12:
Use Edit/Copy to copy polygons
into memory.

Step 15:
Use Edit/Paste to paste spacer
polygons into cavity.

Step 9:
Use the Draw/Flip/Horizontal
menu to flip the spacer.

THERM 2.0
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3.6. Specify Boundary Conditions
(see Section 6, "Defining Boundary Conditions")
1.

Press the Boundary Conditions
toolbar button. The external boundary is automatically drawn,
indicated by a thick line. (A default boundary condition of Adiabatic is assigned).

2.

To change the default boundary condition, select a boundary segment (double-click the left mouse
button on a boundary segment) or multiple contiguous boundary segments (hold the Shift key
down, click the left mouse button on the first segment and the last segment, moving in a counterclockwise direction, and then press Enter; use the Ctrl key in the same manner to select multiple noncontiguous boundary segments). You must have at least two non-adiabatic boundary conditions for
the program to perform a simulation.

3.

The Boundary Condition Type dialog box will appear. Pick the appropriate Boundary Condition
and U-Factor Surface choices for each boundary segment.

Step 1:
Press the Boundary
Condition toolbar button.

Step 2:
Select one or more boundary
condition segments.
To select more than one
segment, click the left mouse
button on the first segment
then double-click on last
segment, moving in a counterclockwise direction.

3-8

Step 3:
Select Boundary Condition & UFactor Surface values.
Additional boundary condition
options will appear in the list
based on the glazing system
inserted.
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3.7. Run Simulation and View Results
(see Chapter 7, "Calculating Results")
1.

Press the Calculation toolbar button.

2.

THERM automatically generates a finite-element mesh to perform the calculation. The status of the
calculation is displayed in the status bar at the bottom of the THERM window.

3.

Results will be displayed as isotherms on the cross section when the calculation is completed.

4.

From the Calculation menu, select Display Options.

5.

Select the desired graphic display option and check the Draw Results box.

6.

Select the Calculation/Show U-factor menu choice to see the U-factor values. If U-Factor values are
blank, then you need to assign U-Factor Surface labels to the surfaces of interest (double-click on the
boundary segment to assign these labels.)

Other graphic results can be accessed using the Calculation/Display Options menu choice.

Select Show U-factors
to see the U-factor results.

Check Background Calc so you
can work on other THERM files
while the calculations are being
performed for this cross section.

After calculating, THERM displays
isotherms by default. Use
Calculation/Display Options for
more results options.

THERM 2.0
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3.8. THERM’s Advances in Modeling
Several features in THERM represent advances in thermal modeling. These include the Condensation Index
Model for glazing cavities and the view-factor radiation model for frame and glazing cavities and external
radiation enclosures.
1.

Assigning frame cavities a material defined with the Detailed Frame Cavity model allows the
program to use the view-factor method when performing the simulation. See Section 5.11,
"Defining New Materials," for a more detailed discussion of this feature.

2.

If you use the Condensation Index Model for an imported WINDOW glazing system, the
program will use local film coefficients and a detailed radiation model to give more accurate local
temperatures. THERM draws a bold red line around the glazing cavity boundaries to indicate
that the Condensation Index Model is in effect. See Section 5.9, "Inserting a Glazing System," for
more details about this feature.

If the Condensation Index
Model is used, THERM draws a
red boundary around the glazing
cavity.

3.

All the frame cavities have been
assigned the Frame Cavity
(NFRC Detailed) material, so
THERM will use the view-factor
method on the caviites when
performing the simulation.

The THERM file below illustrates a greenhouse window cross section in which the Draw/Rotate
feature has been used to tilt the upper glazing. In addition, the interior area enclosed by the
window is defined as an External Radiation Enclosure, so the program will model the window
using the view-factor radiation methodology. See Section 5.11.4 for more information.

The Draw/Rotate feature of
THERM was used to create the
sloping glass in this greenhouse
window.
External
Radiation
Enclosure
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This greenhouse window
illustrates the use of the External
Radiation Enclosure, which
allows THERM to model the selfviewing elements in the window.
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3.9. Toolbar Reference Table
Button

Description

Menu / Choice

Short cut

New THERM file

File / New

Ctrl+N

Open existing THERM file

File / Open

Ctrl+O

Save THERM file

File / Save

Ctrl+S

Print THERM file

File / Print

Ctrl+P

Draw Polygon

Draw / Polygon

F2

Draw Rectangle

Draw / Rectangle

F3

Repeat Mode
This button can be used with the Draw Polygon,
Draw Rectangle, Insert Point, Tape Measure, Edit
Points, Move, and Fill Void buttons to repeat
those functions.

Draw / Repeat Mode

Insert Point

Draw / Insert Point

Shift F6

Turn on Tape Measure

Draw / Measures

F8

Edit Points

Draw / Edit Points

Move polygon or rectangle

Draw / Move

F11

Set drawing origin

Draw / Set Origin

Shift F7

Change Snap Settings

Draw / Snap Settings

F12

Turn on Zoom to enlarge view of drawing

View / Zoom

Zoom to fit: F7
Zoom In: right
mouse button
Zoom Out: shift right
Center: Ctrl-right
mouse button

Fill void

Draw / Fill Void

Define Boundary of cross section

Draw / Boundary
Conditions

F10

Begin Simulation

Calculation /
Calculation

F9

Switch Unit Systems between SI and IP

Options / Switch
Units

THERM 2.0
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3.10. Other Shortcuts
Description

Menu/Choice

Shortcut

Material Library

Libraries/Material
Library

Shift-F4

Boundary Condition Library

Libraries/
Boundary
Conditions

Shift-F5

Set Material

Libraries/Set
Material

F4

Set Boundary Condition

Libraries/Set
Boundary
Condition

F5

Snap to point or polygon
within sticky distance of the
cursor

Space bar

Snap to the last point drawn

End

Decrease the step size by a
factor of 10.

Ctrl-Arrow key

3-12
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4.1. The Main Screen
The Main Menu of the THERM program is shown below. The menu choices allow you to access different
program functions.
The Main Screen, which is displayed when THERM starts, is where you create and edit cross sections, select
the properties (e.g., materials and boundary conditions) associated with the elements of the product you are
analyzing, and perform thermal calculations.

Program Title Bar
Menu Bar
Toolbar

Toolbar
Buttons

Material or Boundary
Condition selection

Menu
Titles

Menu Choices
(checked means
the choice is
turned on)

Vertical Scrollbar

Drawing Area

Origin (cross
hairs)
Locator
(circle)

Horizontal Scrollbar

Status bar
Message bar

Figure 4-1. THERM Main Screen components

The Main Screen consists of the following components:


Program Title Bar: This shows the program name as well as the name of the currently active drawing file
in square brackets. New files are named Untitled followed by a sequence number until you save them
with another file name.



Menu Bar: The Main Menu is below the Program Title Bar and is the way to access all THERM menus.
From the Main Menu, you can set the drawing options, assign materials and boundary conditions, and
run calculations. You can use a mouse to activate a menu by clicking the left mouse button once on the
desired menu title. You can use the keyboard to activate a menu by holding down the Alt key and typing

THERM 2.0

JUNE 1998

4-1

4. GETTING STARTED

the menu’s underlined character. For example, pressing Alt-F, and then typing N would access the
File/New menu choice.


Menu Choices: Every menu option on the Main Menu offers associated menu choices that appear when
you click the mouse on a Menu title. You can activate the choices on the menu list by clicking on them
using the left mouse button. You can also use the keyboard to activate a menu choice by typing the
underlined character or using the arrow keys to move through the choices.



Toolbar: The toolbar contains buttons for the most common activities in the program, such as Save File
and Draw Polygon. A button is activated by placing the mouse cursor on it and clicking the left mouse
button. Each toolbar button corresponds to a menu choice, so you can use either a mouse or a keyboard
to make your selection (see Section 3.9, "Toolbar Reference Table").



Drawing Area: The large white space below the toolbar on the Main Screen is for drawing the geometry
of the cross section you wish to analyze.



Origin: The cross hairs in the drawing area indicate the 0,0 point of the drawing.



Locator: The small circle at the center of the origin cross hairs is the Locator. It can be used to indicate a
location for a drawing component, such as a glazing system imported from WINDOW or a spacer copied
from another THERM file. By default, the Locator and Origin are in the same position when you start a
new drawing. However, the Locator can be moved to any position in the drawing area using the
Draw/Locator menu choice.



Cursor Feedback Bar: The cursor feedback bar displays information about the coordinates of your
drawing cursor. This is explained in more detail later in this section.



Message Bar: The message bar at the bottom of the Main Screen displays information about the currently
selected menu or toolbar button.

4.1.1. Cursor Feedback Bar
The Cursor Feedback Bar is the top row of information at the bottom of the Main Screen. This bar displays
information about the cursor position.
The x,y information gives the absolute x and y coordinates of the cursor relative to the origin (the small cross
hairs). The dx, dy information gives the x and y coordinates of the cursor relative to where you most recently
began drawing; if you place the cursor anywhere in the drawing window and click the left mouse button, the
dx,dy values go to 0,0. These values will change as you move the mouse, showing the coordinates relative to
the position where you most recently began drawing. The len information gives the distance traveled since
the last click of the left mouse button. This length is reset to 0 every time the left mouse button is clicked.
The Step information displays the current Step Size, which is defined by typing a number with the keyboard.
The Step Size is the distance traveled by the cursor for every keystroke with the arrow keys. For example, if
the Step value is set to 10 mm, then pressing the right arrow once will move the cursor 10 mm.
Step Size

Relative position
Absolute position

Length

Step Units

Figure 4-2. Cursor Feedback Bar notations
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4.2 Main Menu
Figure 4.3 shows THERM’s main menu choices.

Figure 4-3. THERM Main Menu choices

To use the keyboard for selecting menu options, press Alt plus the underlined character to select the menu;
then, type the underlined letter of the menu choice. For example, to choose the New choice under the File
menu, type Alt F; then, type N.
File
Edit
View

THERM 2.0

Used to start a THERM drawing file, edit an existing file, and save work on open files.
Also used to access printing options, and to import an underlay file.
Used to modify the components in a currently open THERM drawing.
Used to change the view options such as to zoom in on the drawing, view the underlay,
and change the position of the drawing origin.
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Draw

Used to access the drawing options, such as to draw a rectangle or polygon, move
objects, and insert points.

Libraries

Used to access the Materials, Boundary Conditions, and Glazing Systems libraries.
From this menu, you can add new library entries, edit existing entries, and import
Glazing Systems from WINDOW 4.

Options

Used to access some of the THERM program options, such as the measuring units (SI or
IP), drawing options, and simulation options.
Used to access the finite-element calculation, which simulates the thermal performance
of the cross section. Also used to access the Calc Manager and define the format in
which you wish to view the results.
Used to access each of the open drawings in THERM and display them either as tiled or
cascaded. This menu show the names of all open drawings.

Calculation

Window
Help

Used to access the THERM Help file, which contains the information in this manual, as
well as the About Therm choice, which contains information about the program version
and authors.

4.2.1. Pull-down Lists
A pull-down list displays choices for an input value. To display the choices, use the left mouse button to click
the arrow to the right of the input box. You can select an item from any pull-down list using one of the
following methods:


Click on the arrow of the pull-down list: This will cause the first set of items in the list to show. A
vertical scroll bar will appear on the list if there are more items than can be displayed in one view.



Type the first few letters of the item: If you type the first letter of the item, the first option that starts with
that letter is chosen. If you add the next letter of the item, the program will go to the option in which
these first two letters appear. When the correct item it highlighted, you can select it by clicking on Enter.

Pull-down List

Vertical Scrollbar

Figure 4-4. Example of a pull-down list

4.2.2. THERM Files
You should save each cross section that you draw as a THERM file, using the File/Save menu or the Save File
toolbar button. THERM will automatically add a THM extension to the file name you type. Two sample files,
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SAMPLE.THM and SPACER.THM, are included in the installation diskettes. You can open these, or any
other THERM file, using the File/Open menu choice, or the Open File toolbar button. A list of files with a
THM extension will be displayed, and you can select the file you want.
You can also start a new file using the File/New menu choice or the New File toolbar button. You will see a
blank drawing area, and you can begin drawing. When you save the file, using the File/Save menu choice,
THERM will automatically assign a THM extension to the name.
THERM allows you to have multiple THM files open at one time. You can see a list of all opened files using
the Window menu. You can close each open THM file independently, using the File/Close menu option.
You can close all the files, and still have the THERM program active. However, the File menu becomes
reduced to a few choices, such as New or Open, when there are no files open.
You can see a list of the last four open THERM files at the end of the File menu. You can open one of these
files by either clicking your mouse on the file name or typing Alt-F and the number of the file.

Four most recently
used THERM files

Figure 4-5. Last four open THERM files are shown at the end of the File menu.
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5.1. Overview of Drawing a Cross Section
You can start drawing a cross section in THERM using either of two approaches:


Import a DXF file or a bitmap file as an underlay. Then, use the DXF file autoconvert feature or trace the
underlay using a mouse.



Work from a dimensioned drawing and use the “step size” function and arrow keys to specify the crosssection dimensions and draw the elements.

In general, the subsequent steps are the same whether you trace an imported file or start from a dimensioned
drawing:
1.

Draw polygons and rectangles to represent the cross-section geometry (for more details, see Sections 5.45.5). When modeling windows, we recommend that you import a glazing system from the WINDOW
program (see Section 5.9), but you can also represent the glazing systems with individual rectangles
(recommended only for advanced users).

2.

Assign materials to polygons and rectangles as you draw (recommended) or after the drawing is
completed (see Section 5.10). Use the THERM default material library to model solids or frame cavities
and to define new materials as necessary (see Section 5.11).

3.

Add, delete, or move polygons and points as necessary (see Section 5.6).

4.

Insert a glazing system created in WINDOW. Glazing systems from WINDOW are imported into
THERM with all material properties, including the effective conductivity of the glazing cavity and
boundary conditions, automatically defined (see Section 5-9). Use of the Condensation Index Model
requires that the glazing system be imported from WINDOW (see Section 5-9).

When you have finished these steps you are ready to go to Chapter 6, "Defining Boundary Conditions."
The following sections explain in detail how to draw cross sections with or without an underlay.

5.2. Importing a DXF or Bitmap File as an Underlay
THERM reads and interprets DXF and bitmap formatted files, which simplifies the process of creating
thermal models.


DXF Files: A DXF (drawing exchange format) file is an export format supported by many CAD and
graphics programs. When you export DXF files from another program, it is best to keep them simple,
eliminating elements such as text, shading, and dimensions that are not needed for the thermal model.
Section 5.2.3 provides suggestions on how to make a DXF file for use with THERM. A DXF filter function
(see Section 5.2.2) in THERM can be used to restrict what entities (points, polylines, and arcs) are
included in the underlay. Using an imported DXF file has the following advantages:


Autoconvert: Closed polylines and curves are automatically converted into polygons.



Snap to Underlay: When tracing an underlay, the cursor will automatically snap to the underlay
vertices, making drawing fast and accurate. Section 5.3.3 discusses Snap Settings, which govern how
THERM decides where to snap.
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Bitmap Files: THERM can also import bitmap files (files with a BMP extension), made, for example by
scanning a drawing or capturing a screen from another drawing tool. However, BMP files do not contain
information about points or lines, so THERM cannot perform autoconvert or “snap” to the bitmap
underlay as with DXF files. It is often easier to work from a dimensioned drawing than to try to get the
correct dimensions by tracing a bitmap underlay.

Use the following steps to import a DXF file to use as an underlay for your THERM drawing:


Select Underlay from the File menu.



Select the DXF or bitmap file name from the Underlay dialog box.

5.2.1. Select Underlay from the File menu

Figure 5-1. To import a DXF file, pick the Underlay option from the File menu.

5.2.2. Select DXF or Bitmap File
1.

The Underlay menu choice will bring you to the Underlay dialog box.

Figure 5-2. The Underlay dialog box

2.

5-2

Click on the Browse button to see all files in your current working directory with a file extension of *.DXF
or *.BMP.
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Figure 5-3. Click on the Browse button to get to the Open dialog box.

3.

Highlight the desired file and press the OK button, which will bring you back to the Underlay dialog
box.

Figure 5-4. Select the DXF file using the Underlay dialog box.

Options you may want to set in the Underlay dialog box include:


Scaling: Scaling inputs allow you to change how THERM scales the imported underlay in both
horizontal and vertical directions. This feature is usually used only for BMP files. If you change the
horizontal value, the vertical value will automatically change to match it, but you can then change the
vertical value and the horizontal value will not change. The default values are 100% in both
directions. For DXF files, use the program default value of 100% unless the DXF file is not 1:1. Make
sure the Units value is set to match the system that the DXF file was drawn in. The default is IP, so if
you are using an underlay created in SI units, make sure you switch this value.



Autoconvert: This feature converts closed polylines and curves into polygons. If a DXF file is
exported from a drawing made up of closed polylines, THERM can automatically convert the
drawing into polygons. The polygons will have the currently selected material property. If the DXF
file is exported from a drawing made up of lines or open polylines, THERM will not be able to
convert the drawing to polygons. You can always try to use the Autoconvert feature by checking the
box and seeing what happens. If THERM does not find any polylines, it will not generate any
polygons. Make sure to check the polygons generated by THERM. A common problem is
overlapping polygons; polygons are sometimes completely hidden underneath other polygons. Use
View/Show Voids/Overlaps (see Section 5.3.5) after using the Autoconvert feature to check for
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overlapping polygons. See Section 5.2.3 for a more complete discussion on how to make DXF files
that THERM can correctly autoconvert.
With autoconverted DXF files, curves are converted into a series of straight line segments at a degree
o
specified by the user. The default value for this division is that every 15 of arc is converted into a line
segment. This value can be changed using the Options/Preferences menu choice, by entering a
different value in the Arc to Polygon conversion input box on the Drawing Options tab. It is
recommended that you do not over specify curves.


Underlay Origin: This box indicates the underlay’s x and y coordinates relative to the THERM
origin. These coordinates represent the position of the lower left corner of the underlay; their values
default to 0,0.



Set Color: This button allows you to set the color of the underlay as it will appear in your drawing
area. If you have a color monitor, this feature allows you to differentiate the underlay from other
drawing components.



DXF Filter: This button leads to another dialog box where you can indicate which elements you want
THERM to import from the DXF file. This feature is used to eliminate unnecessary elements in the
DXF file.

Figure 5-5. The DXF Filter dialog box

When you import an underlay to THERM, the program will zoom the drawing to fit in the drawing area.
The following two figures show a DXF file drawn with polylines that THERM can interpret. Figure 5.6 shows
the underlay without Autoconvert, and Figure 5.7 shows the same underlay imported with Autoconvert
turned on. The underlay in Figure 5.6 can be traced when drawing the polygons; in Figure 5.7, the polygons
already exist.
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Figure 5-6. A DXF file imported as an underlay with Autoconvert turned off, so no polygons are drawn

Figure 5-7. A DXF file imported as an underlay with Autoconvert turned on, so closed polylines are converted into polygons

THERM only allows one DXF file at a time to be associated with a model. If you want to use multiple DXF
files, first remove the existing file using the File/Underlay menu choice, and press the Remove button. You
can then import a new underlay.
Once you have finished working with a DXF file, you can use the View/Underlay menu choice to hide the
underlay; the underlay view is off if there is not a check mark to the left of the menu choice. Although you
cannot see the underlay, it is still associated with the model until you remove it using the method discussed
above.
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5.2.3. DXF File Conversion
The DXF file underlay feature in THERM allows you to create simulation models quickly and accurately.
With this feature, you can export a drawing created in a computer drafting program using a DXF file format
that can be read by THERM and automatically converted into polygons.
You can take many steps when creating your drawing and DXF file to simplify the process of using the DXF
file with THERM. These modifications can be made after a drawing is created in the drawing program but
will be most efficient if they are incorporated into standard drawing practices.
When you make your drawings:


Put dimensions and shading on different layers from the main drawing. When you export the DXF file,
turn off these layers, so the underlay will not be complicated with information that is not needed for the
thermal analysis.

If you want to use the THERM DXF Autoconvert feature:








Use closed polylines when creating your DXF file. THERM can autoconvert DXF files that have the crosssection elements drawn as closed polylines. A drawing can be converted to closed polylines by using
commands such as Boundary in AutoCAD™. This feature works very well with straight-line drawings
but is somewhat unpredictable with polylines that contain curves.
You can use AutoLISP programs that clean up drawings by creating closed polylines and deleting
duplicate entities. In AutoCAD™, this can also be done by hand using the Trim, Extend and Delete
features.
Modify the cross section to break up places where a polyline intersects itself. THERM does not draw
regions that have multiple connections (i.e., donuts). Make this modification while the object snap is set to
ensure that these line segments intersect existing lines. Line segments can be drawn on a separate layer
that can be turned off when the drawing is used for non-THERM purposes.
Test the DXF file import into THERM; if THERM has difficulty picking up some details of the drawing,
exploding the DXF file may help. Unfortunately, once closed polylines are exploded, they cannot be
autoconverted.

When you Export the DXF file:




Only export the elements in the DXF file that are needed for the thermal analysis. For example, in
AutoCAD™, you can use the “object” option of the dxfout command and select only the items that you
want to export. This eliminates extraneous elements in your DXF files, such as extra views of the drawing
or elements that were deleted but remain in the database.
DXF files are often in the form of assembly drawings, so snap-in pieces are usually not placed accurately,
and deformable pieces are usually drawn as overlapping entities in their nondeformed state. These
features make an assembly drawing difficult to use in THERM. It is easier to create a THERM model if
you provide the parts unassembled in one or several DXF files and then assemble them. You can make
use of the Flip and Rotate features in THERM to create multiple cross sections using the DXF files. The
placement of these pieces can also be corrected within the drawing program that generates the DXF file.

If you have unexpected results when you export a DXF file, consider the following possibilities:
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Sometimes the DXF file comes into THERM with long vertical lines that do not show up on the original
drawing. When this happens, it is best to reimport the DXF file into the drafting program, cut and paste
it into a new drawing, and export it again.
Computer-generated drawings often contain entities on top of other entities. This can occur when a
drawing is exploded on top of itself. When files like this are autoconverted, they arrive as overlapping
polygons in THERM. Duplicate entities need to be removed before drawings are exported as DXF files.
AutoLISP routines are available that perform this task, but it is time consuming. The overlapping entities
can be deleted easily in THERM. If you delete one too many layers you can reinstate a layer using
THERM's Undo feature. The View/Show Voids/Overlaps feature is very useful for detecting overlapping
entities; however, multiple layers of overlaps may be difficult to detect because the first overlapping
region will be displayed as blue, the second one of top of it will be displayed as white, the third on as
blue, and so on.
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5.3. Drawing Features
It is important to understand the following THERM features before starting your drawing.
5.3.1. Sticky Distance
The sticky distance is 3mm (1/8") when a drawing is at 100% scale, which corresponds to about half of one
side of the cursor cross hair. As you zoom in or out, the sticky distance remains constant. This means that you
can zoom in to do finer detail because the sticky distance will get smaller relative to your drawing as you
zoom in and larger relative to your drawing as you zoom out. Sticky distance only applies to mouse clicks,
not to numeric cursor positioning (see Section 5.5, “Drawing with the Keyboard” for a discussion of numeric
cursor positioning).
5.3.2. Drawing Preferences
Use the Options/Preferences menu choice and go to the Drawing Options tab to change the following
drawing settings:

Figure 5-8. Setting the drawing preference options


Arc to polygon conversion: This option tells THERM how to translate an arc in a dxf file into a polygon in a
THERM file. The smaller the value, the more line segments THERM will construct when translating the
arc. The default setting of 15o is recommended.



Stay in Draw mode after drawing: This option turns the Repeat Mode on by default.



Always check for overlapping polygons: This option tells THERM to check for overlapping regions each time
you edit or draw a polygon. (Note: This checking procedure sometimes reports and overlap when there
isn't one. If you repeatedly get an error message saying you have overlapping polygons, you may want to
temporarily turn this feature off by unchecking the box.) The program will check for overlaps at
simulation time; you can also check the drawing after it is finished using the View/Show Voids/Overlaps
menu choice.
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Snap Preview: This option affects how the cursor reacts to movement of the mouse. Snap Preview causes
the cursor to snap to any point that is within sticky distance. For complicated drawings this can be very
time consuming because the program must check every point to see if it is within sticky distance. This
option only affects what you see as you move the mouse, but does not affect snapping when you draw.



Tape Measure Average Temperature: This feature enables display of the average temperature over a straight
line segment measured by the tape measure. This feature is only available for a THERM file with current
and available results.



Allow editing of IG polygons: This checkbox allows you control whether a glazing system imported from
WINDOW can be edited. If you activate this feature, you can then insert and delete points in a glazing
system. Use this feature with extreme care. The default value is unchecked, meaning the feature is not
activated.



Prompt before deleting polygons: This feature determines whether the program prompts you before deleting
polygons. The default setting is to ask for confirmation before deleting polygons. If this box is unchecked,
the program will not ask for confirmation before deleting a polygon. Under this circumstance, a polygon
that is inadvertently deleted can be restored using Edit/Undo.



Drawing Size: This option displays the overall size available for the THERM drawing. These dimensions
are modified automatically and will rarely need to be changed manually.

5.3.3. Snap Settings
THERM has several “snap” settings that can be used to make drawing easier. These settings instruct the
drawing cursor to automatically go, or snap, to certain points, lines, or angles. How THERM decides where
to snap is determined in part by the sticky distance of the cursor. If the cursor is snapping to points that you
don't want, use the zoom feature to zoom in and decrease the sticky distance. (See Section 5.3.1 "Sticky
Distance" for more details).
Use the Snap Settings tab under the Options/THERM File Options menu choice to control the “Snap”
features in THERM.

Figure 5-9. Setting the Snap Settings options, accessed from the Options/Therm File Options menu
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Snap to Vertical: If your drawing cursor is within the sticky distance of drawing a vertical line, the
program will snap the cursor to the exact vertical position.



Snap to Horizontal: If your drawing cursor is within the sticky distance of drawing a horizontal line, the
program will snap the cursor to the exact horizontal position.



Snap to Underlay: If your cursor is within the sticky distance of an underlay point as you trace a DXF
underlay, the program will snap the cursor to that point. If two points on the underlay are both within
the sticky distance to the cursor, the cursor may snap to the wrong point. Zooming in will decrease the
sticky distance and allow the cursor to snap to the desired point.



Snap to Angle: Much like Snap to Horizontal & Vertical, this feature allows the program to snap the
drawing cursor to a defined angle.



Smart Snap: This feature extends edges of polygons past the end points of polygons and checks to see if
the point that you want to insert is close to one of these lines. This option is useful for lining up edges
when there is a gap between them. The View/Crosshair menu choice, which turns the drawing cursor
into a cross hair that fills the drawing area, can also be used for this purpose.



Show Grid: This option allows you to control whether the grid shows on the drawing area.



Snap to Grid: This feature forces the program to snap the drawing cursor to grid points. If you use this
feature, you should also check the “Show Grid” option.



Grid Spacing: This option allows you to change the spacing of the drawing grid. The default grid spacing
is 5 mm for both width and height. The minimum grid space is 0.3 mm; a smaller spacing is not visible on
most monitors.



Grid Origin: By default, the origin of the grid points falls on the drawing origin; by changing the x and y
values in the Grid Origin box, you can specify a different origin for the grid points.

When Grid Spacing and
Grid Origin are changed
(grid origin set to x=5 and
y=5, the grid changes but
the drawing origin stays in
it’s original location.

Figure 5-10. Changing the grid origin relative to the drawing origin

Snapping occurs according to a defined priority sequence. The list below shows the priority the program will
use to determine what to stick the cursor to.
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Snap Priority:
The snap priority is largely determined by what Snap Settings have been checked. The Snap Settings are
discussed in the previous section. Assuming that the Snap Settings are turned on, THERM will snap points
and polygons in the following priority order:


Polygon point: The highest priority is to stick to a point on another polygon. This feature is always
enabled. If the cursor is sticking to a point that you don’t want it to stick to, you need to zoom in (click
your right mouse button).



Underlay point (for DXF only because bitmaps don’t have defined points): The next level of priority is to
snap to underlay points. This option can be turned on and off. See the previous discussion of Snap
Settings, Snap to Underlay.



Grid point: The third level of priority is to snap to a grid point. You can define the grid origin and
spacing, and the “snap to grid” feature can be turned on and off. In the previous discussion of Snap
Settings, see Snap to Grid.



Polygon line: The fourth level of priority causes the cursor to stick to a line at the point perpendicular to
where the mouse clicks if the cursor is within the sticky distance of that line. This feature cannot be
turned on and off.



Smart Snap: The fifth level of priority is enabled if Smart Snap is turned on. In the previous discussion of
Snap Settings, see Smart Snap.



Snap to Horizontal/Vertical: The sixth priority is to snap so that an exactly horizontal or vertical line
segment is created. In the previous discussion of Snap Settings, see Snap to Vertical and Snap to
Horizontal.



Snap to Angle: The last level of priority is to snap to a defined angle. In the previous discussion of Snap
Settings, see Snap to Angle.

5.3.4. Zoom
The zoom feature makes a drawing appear larger or smaller. Click the Zoom toolbar button or use the
View/Zoom menu choice; a dialog box will appear with different percentage enlargements and reductions.


This box will show the current zoom percentage. You can change this value to a specific percentage.



The cursor becomes a magnifying glass. Place the magnifying glass over the center of the area to be
magnified and click the left mouse button.

You can also use the mouse to zoom as you are drawing:


Zoom in (Right mouse click): click the right mouse button to zoom in (make the drawing larger by a factor
of 2). The program will zoom in, using the cursor position as the center of the newly zoomed screen.



Zoom out (Shift right mouse click): hold the Shift key down and click the right mouse button to zoom out
(make the drawing smaller).



Zoom to Fit (Ctrl right mouse click): hold the Ctrl key down and click the right mouse button; the
program will zoom the drawing to the largest scale at which the entire drawing still fits in the view
window.



Scrolling: You can scroll your drawing both horizontally and vertically while zoomed in.



Maximum Zoom: You can zoom your drawing to 50,000%.
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NOTE: The drawing features in THERM were developed using a 32-bit operating system, Microsoft Windows NT™.
THERM also runs on Windows 95™ and Windows 98™, which use 16-bit drawing functions. The zoom feature is one
of the few places where this difference is apparent. If you are using Windows 95™ or Windows 98™ and you experience
distortion of your drawing when zooming at a high level, make sure that the Windows 95 box is checked under
Options/Preferences. Even with this box checked, you may still see some display distortion of your drawing. If this
happens zoom out (Shift key + right mouse click) until the drawing appears accurate.
5.3.5. Voids and Overlaps
In order for the automatic mesh generator to create a mesh there can be no voids or overlapping regions in
your drawing. There are many drawing features that help you to create a valid model as you draw, such as
snapping to points, filling voids, checking for overlapping and invalid polygons.
There is also a view option, View/Show Voids/Overlaps, that allows you to easily identify large voids and
overlaps. This feature draws the model in white and displays all overlaps and voids in blue (the area outside
the boundaries of the model will also be displayed in blue), and allows you to discover problems before you
define the boundary conditions. It is also a useful feature to fix similar problems after autoconverting a DXF
file; depending on how the DXF file was defined, overlapping polygons may be created during the
autoconvert process. See Section 5.2.3, "DXF File Conversion" for more details. Figure 5-11 shows an example
of this view option.
Voids and overlaps that are smaller than a pixel at the zoom level of the model when the View/Show
Voids/Overlaps feature is selected may not show up even after subsequent zooms. THERM has a feature that
can detect small voids and overlaps that is activated later in the modeling process. See Chapter 7 for more
details.

With View/Show Voids/Overlaps
turned on, THERM displays any
voids or overlapping regions as
one color and all the defined
regions as white.

Figure 5-11. Use the Draw/Show Voids/Overlaps menu to view voids.
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5.3.6. Other Drawing Features
Other drawing features that may help you create the cross-section geometry are:


Draw Repeat Mode: This feature, accessed from the Draw/Repeat Mode menu choice or the Draw Repeat
Mode toolbar icon, keeps you in the drawing mode you are currently in. For example, if you are drawing
polygons with the Repeat Mode feature on, your cursor stays in "draw polygon" mode, so you don’t have
to continually reselect the Draw/Polygon menu choice or toolbar button.



Material Colors: The View/Material Colors menu choice allows you to turn the polygon colors on and off.



Set Draw Color: The View/Set Draw Color menu choice allows you to select a color for the drawing line
when drawing polygons. This feature helps you keep track of where you are when drawing a
complicated polygon. The default color is black.



Set Polygon Border Color: The View/Set Polygon Border Color menu choice allows you to select a color
for the borders of the polygons. The default color is black.



View Polygon Vertices: The View/Polygon Vertices menu choice displays the vertices of all the polygons
in the model. This feature can be very useful when drawing polygons that share a common complicated
edge.



Select Materials: You can select materials as you draw each polygon; when you are in "draw polygon" or
"draw rectangle" mode, pick the material for the component you are about to draw from the material list
in the right-hand section of the toolbar. This material will then be assigned to the polygon. You can also
assign materials after the polygons have been drawn.



Set Drawing Scale: This feature allows you to convert drawings to full scale (1" = 1"). Changing the
drawing scale changes all of the dimensions in the drawing. It should not be used to resize individual parts.
THERM will allow imported glazing systems to be rescaled, but this is not recommended because the
properties of the glazing system are dependent on the dimensions of the geometry as defined in
WINDOW. In this version of THERM, these properties are not corrected when the glazing system is
rescaled.

1.

Select the Draw/Set Drawing Scale menu choice.

Figure 5-12. Select Set Drawing Scale from the Draw menu.
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2.

A small tape measure will appear. Put the tip of the arrow on the tape measure at the point from which
you want to start measuring and press the left mouse button. Then move the tape measure arrow tip to
the point where you want to finish measuring, and press the left mouse button (the cursor will snap to
points within the sticky distance). Type in the actual line length value.

Figure 5-13. After measuring the distance, type in the dimension to which you want that distance to be set.

5.4. Drawing Using a Mouse
This drawing discussion assumes use of a mouse; this is the technique most likely to be used when tracing an
underlay. See the discussion following (“Drawing Using a Keyboard”) for methods to use the keyboard for
drawing, which may be faster and more accurate than using a mouse if you have a dimensioned drawing.
For this example, we are tracing an underlay and will draw many polygons to represent the model. The
figure below shows numbered steps for creating a polygon.

Step 1:
Push the Draw
Polygon button.

Step 2:
Select Material

Steps 3-7:
Place the drawing
cursor where you want
to start the first
polygon, click the left
mouse button and
drag the mouse,
following the lines in
the underlay. Click the
mouse to end the line.
Repeat this until the
polygon is closed.

Figure 5-14. Steps for drawing cross-section geometry

1.

To draw the first polygon, press the Draw Polygon toolbar button or use the Draw/Polygon menu
item.

2.

Pick the material for the polygon from the material list in the right-hand section of the toolbar.

3.

Place the drawing cursor where you want to start the first polygon.

4.

Click the left mouse button to set the starting point for the first line. (THERM will snap to the nearest
vertex if you are using a DXF file).

THERM 2.0

JUNE 1998

5-13

5. DRAWING CROSS-SECTION GEOMETRY

5.

Move the mouse to the right and a line will follow the mouse. Click the left mouse button when you
get to the end point for the line, and THERM will draw the line. A point is automatically created at
each end of this new line.

6.

Continue drawing the edges of the polygon in the same manner, moving the cursor to the next line
end point, and clicking the left mouse button to define that point.

7.

When you only have one line left to draw, you can double-click the left mouse button, click on the
first point, or press C to close the polygon.

Figure 5-15. Drawing a polygon by tracing an underlay element

If you find that the program is “snapping” lines to points that you don’t want, try zooming in. If you
are still having problems, you may need to turn off some of the options in Options/THERM File
Options menu, under the Snap Settings tab.
After you have drawn the first polygon, use the same procedure to draw all the other polygons
required to provide an accurate representation of the cross-section. For THERM to perform its
calculation, a cross section made out of multiple polygons must not contain any voids or overlaps.
(See Sections 5.3.5, "Voids and Overlaps", and 6.3, "Error Detection in THERM" for more
information). The "snap" feature (see Section 5.3.3, "Snap Settings") as well as THERM's dynamic
checking as you draw are intended to minimize unintentional creation of voids and overlaps.
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Figure 5-16. The first polygon is complete; start the next polygon.

5.4.1. Suggestions for Drawing Cross Sections
You will be able to successfully draw complicated cross-sections in THERM if the following guidelines are
adhered to. These guidelines apply to the drawing of extrusions and how to best represent arcs and curves.


Extrusions: Currently THERM does not draw multiply connected regions or "donuts". This limitation is
most noticeable when drawing components created from extrusions (or pulltrusions). Here are some
suggestions to aid in the creation of THERM models for extruded products.


The standard method for drawing an extrusion in a CAD program is to draw the outside edge of the
extrusion and then draw the cavities. Creating a model in THERM uses a different logic. First draw
the extrusion and then fill the cavities using the automatic fill void feature.



THERM can handle very complicated polygons but it is easier to keep track of what you are doing if
you use many less complicated polygons. It is easy to forget where you started drawing the polygon
if it is too complicated.



Complicated intersections between two pieces of the same material in intimate thermal contact can be
simplified without effecting the thermal performance of the cross section.



When breaking up extrusions you should avoid introducing detail into the cross section to do this:


Make the breaks at vertices that already exist in the drawing.



Avoid creating acute angles.



Avoid creating very small rectangles.

The next two figures give an example of how the above drawing principles can be applied to an extruded
product.
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Do not draw acute angles
when it is not necessary.

Do not create small
polygons in the process of
breaking up the extrusion.

Simplfy the geometry
between polygons with
the same material.

Figure 5-17. This cross section illustrates drawing mistakes when breaking up an extrusion.

Breaks are made
at existing points.

The segments
used to prevent
drawing a donut
are composed
of large
rectangles.

Angles are not acute.

The boundary between
these two polygons of
the same material has
been simplified.

Figure 5-18. This cross section illustrates a better way to draw the extrusion geometry in Figure 5-17.


Arcs and curves: The default value converts arcs into line segments every 15 degrees. This level of detail
is appropriate for curves with a radius greater than 3mm. If the curve has a radius greater than 1 mm
and less than 3 mm then breaking up the arc every 30 degrees (or combining two segments on the DXF
file underlay) is adequate. If the radius of the curve is less than 1mm then every 45 degrees (or
combining three segments on the DXF file underlay) is sufficient. These guidelines are based on an
attempt to keep the difference between the approximated curve and the real curve small, approximately
0.1 mm. This distance can be checked using the tape measure. Using many points to model curves in
THERM may create problems for the mesher. The guidelines listed above should result in a good
representation of the geometry for the purposes of thermal analysis.
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5.5. Drawing Using the Keyboard (Numeric Cursor Positioning)
If you are working from a dimensioned drawing, it may be easier and more accurate to use the keyboard and
THERM’s numeric cursor positioning rather than using the mouse. Numeric cursor positioning allows you to
move the cursor to either an absolute or relative location by typing a number and pressing an arrow key.
Follow the steps below to draw polygons with the keyboard:
1.

Type Alt-D: Shows the Draw menu.

2.

Type P or R: With the Draw menu showing, type P for Polygon or R for Rectangle. The cursor will
appear on the drawing area. (These functions can also be accessed with the mouse by clicking the
appropriate toolbar button).

3.

Move the cursor to the starting point of the drawing: There are several different methods for moving the
cursor to where you want to start:


If you want to start drawing at the origin, press the Home key.



If your starting point is not at the origin, type the x coordinate; the Step Size dialog box will
appear. Select Absolute (Relative is the default), and press the right arrow key; then type the
y coordinate followed by the Up Arrow key, and the cursor will be positioned at those
coordinates.

4.

Press Enter: Press the Enter key to start drawing (the equivalent of clicking the mouse button).

5.

Type the first dimension (a number): Type the first line length for the polygon you are going to draw.
The Step Size dialog box appears, and the step size value is set to the dimension you typed. Do not press
Enter and do not click on the OK button with the mouse. (The OK button is used when you are setting
the step size for future use.)

Figure 5-19. Type a number to bring up the Step Size dialog box.

6.

Press the Up, Down, Left, or Right Arrow: Press the appropriate arrow key (i.e., the right arrow to draw
a line to the right); a line of the specified step size will be drawn in the direction of the arrow.

7.

Press Enter to commit the line: Press Enter to commit the line to the drawing. The new line will appear;
a vertex has been established where the cursor is positioned.

8.

Type the next dimension (a number).

9.

Press the appropriate arrow key.

10. Press Enter to commit the line.
11. Continue drawing lines until you have only one line remaining to complete the polygon.
12. Press C to Close: Press C to draw the last segment of the polygon. The program will automatically draw
a line from the point where the cursor is resting to the first point drawn for the polygon.
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Other conventions to know when using the keyboard to draw:


Enter starts drawing: Pressing the Enter key to start drawing a polygon will cause the cursor to snap
(according to the snap settings). This makes it easy to start drawing from a point that you have already
defined.



Mouse-driven commands: Mouse-driven commands work even when using the keyboard; there are several
short-cut keys designed for keyboard drawing. (See Sections 3.9 and 3.10 for more details about short
cuts).



Absolute Locations: Absolute locations can be entered by using the Absolute setting in the Step Size
dialog box. For example, to move the cursor to x=10 and y=5, click on the Absolute button, type 10, press
the up arrow, type 5, and press the right arrow.

Figure 5-20. Type the step value to bring up the Step Size dialog box, and click on the Absolute button.


Ctrl + arrow key: If you press the Ctrl key while moving the arrow keys, the cursor will move 10% of the
specified step size. For example, if the step size is set to 1 mm, pressing the Ctrl+Right Arrow keys will
move the cursor 0.1 mm to the right. This feature can be very useful when extreme accuracy is needed to
place a point or line.



Space bar: Press the Space bar if you want to snap to the point or polygon that is within the sticky
distance of the cursor.



End: While you are drawing a polygon, you can press the End button to get back to the most recent
previous point you drew.



Esc: If you draw a point by mistake, press the Esc button and it will be deleted. If you press Esc again, a
dialog box will give you the choice of deleting the point previous to the last point you just deleted (this
can be done several times, but the video display tends to get garbled), deleting the polygon, or canceling
the Escape command.

5.6. Editing Polygons
Once a polygon has been drawn, it can be edited. For example, the entire polygon can be moved; points can
be added, deleted or moved; etc. Because a rectangle is one type of polygon, any reference in this manual to
polygons also applies to rectangles.
5.6.1. Selecting a Polygon
Several different techniques can be used to select a polygon:


Left Mouse Click: Put your mouse cursor over the polygon you want to select and click the left mouse
button. You can tell that a polygon has been selected because all the points on it will be displayed as
squares.
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Ctrl or Shift left mouse click: If you want to select multiple polygons, you can hold either the Ctrl or Shift
keys down as you click your mouse on the polygons to be selected.



Tab: You can use the Tab key to select any polygon in the drawing; each time you press Tab, the
program will select the next polygon. By pressing Tab multiple times, you can "tab around" to all the
polygons in your drawing. This is sometimes a good way to select very small polygons that you can’t
easily select using the mouse.



Selection box: You can draw a "selection box" around a polygon or a group of polygons by clicking and
holding down the left mouse button in the drawing area and dragging the mouse in a diagonal motion so
that a dashed box is drawn around the polygon(s) that you want to select. Release the mouse button, and
the polygons surrounded by the dashed box will be selected.

Step 1: Position the mouse cursor where you
want to start the "selection" box.

Step 2: Hold the
left mouse
button down and
drag the mouse
cursor from
1 to 2.

1

Step 3: Release the mouse
button, and all polygons
completely surrounded by the
selection box will be selected.

2

Figure 5-21. Selecting polygons using the selection box


Select Special: You can use the Edit/Select Special menu choice to select polygons or boundary conditions
of a certain type or ID. This menu choice brings up a dialog box that allows you to specify the type of
object you want to select. This is an efficient way to change the materials of many identical objects with
one command.
When you do a calculation, you will occasionally get an error message saying that there is a bad polygon
in the model. This message returns a polygon ID number. Using Select Special allows you to quickly
locate that polygon in the model. See Chapter 7 for information about fixing invalid polygons.
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Step 2: Go to
the
Edit/Select
Special menu
choice.

Step 3: The Select
Special dialog box opens.
Make sure all the input
values are as you want
them; then, click on OK.

Step 4: All polygons
of the type specified
will be selected.

Step 1: Select a polygon
(or boundary condition) of
the type you wish to use
so you can select all the
elements in the drawing
of this type.

Figure 5-22. Using Select Special for selecting polygons

5.6.2. Moving a Polygon
To move a polygon:
1.

Click the mouse on the Move toolbar button, or use the Draw/Move menu choice.

2.

Place the mouse cursor inside the polygon that you want to move. Click and hold down the left
mouse button as you move the mouse to the new location; release the mouse button. The polygon
will move to the new location. Any snap settings in effect during the move will apply to the moved
polygon.

When moving a polygon, you can hold the Shift key and the left mouse button down together as you drag
the mouse and move the object; in this situation, THERM constrains the movement to the horizontal and
vertical directions.
It is recommended that you use the drawing locator feature when moving multiple polygons.
1.

Place the locator (select the Draw/Locator menu choice or press Shift F2, and click the left mouse
button) on a point on one of the polygons to be moved; this point will be used to place the polygon in
its new location.

2.

Select all of the polygons to be moved, using any of the methods discussed in Section 5.6.1.

3.

Cut (Ctrl-X) the selected polygons.

4.

Place the locator (use Shift F2 and click the left mouse button) at the location to which you want the
point selected on the polygon in Step 1 to move. (The locator can be moved with the keyboard Step
Size functions. It will stick to existing points within the sticky distance.)

5.

Paste (Ctrl-V) the selected polygons. If no overlaps are created, the polygons will be pasted in the
new location.
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Step 1: Click on the Move Polygon
toolbar button.
Step 2: Position the mouse cursor over the
polygon to be moved. Click and hold down the
left mouse button, drag the mouse (and the
polygon) to the new location, and release the
mouse button. The polygon will be moved to
the new location.

Figure 5-23. Moving a polygon

5.6.3. Deleting a Polygon
To delete a polygon:
1.

Select the polygon (click the left mouse button while the cursor is inside the polygon) that you want
to delete.

2.

Press the Delete key on your keyboard.

3.

A message will appear asking if you want to delete the selected polygon. If you do, press Enter to
accept the default “Yes” response. (Note: You can disable this question in the Drawing Options tab
accessed from the Options/Preferences menu, by unchecking the "Prompt before deleting polygons"
checkbox.)

4.

The polygon will disappear. (If you delete a polygon by mistake, use the Edit/Undo menu choice or
Ctrl-Z to have the program reinstate the polygon).

5.6.4. Moving a Point
To move a point on a polygon:
1.

Click the mouse on the Edit Points toolbar button or use the Draw/Edit Points menu choice.

2.

Select the polygon (click the left mouse button while the cursor is positioned inside the polygon) so
that the vertices are displayed.

3.

Move the cursor to the point to be moved.

4.

A double-arrow cursor is displayed when you are within sticky distance of the point.

5.

Use the Step Size and Arrow keys to move the point, or click and drag the point with the left mouse
button.
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6.

The lines attached to the point are pulled along with it.

When moving a point, you can hold the Shift key and the left mouse down together as you drag the mouse to
move the point; in this situation, the program constrains movement to the horizontal and vertical directions.

Step 1: Click on the Edit Points
toolbar button.
Step 2: Move the mous e cursor over
the point you want to move; the
cursor will change to a double
arrow.

Step 3: Click the left mous e
button, hold the button
down, drag the curs or to the
new location for the point,
and release the mouse
button when the point is in
the desired location. The
point will be moved, and the
polygon lines attached to
the point will stretch to
follow.

Figure 5-24. Moving a point on a polygon

5.6.5. Moving a Line
To move a line on a polygon:
1.

Select the polygon (by clicking the left mouse button) so that the points are displayed.

2.

Press the Edit Point toolbar button, or use the Draw/Edit Point menu choice.

3.

Move the mouse cursor over the line you want to move; a four-point arrow cursor appears when you
are in a position that allows you to move a line. (Note that you need to be outside the sticky distance
of any nearby points in order to see the four-point arrow; use the zoom in feature by clicking the right
mouse button if you are sticking to points).

4.

When the four-point arrow cursor appears, hold down the left mouse button and drag the line to the
new location, or use the arrow keys to move the line a specified distance. When the line is in place,
release the mouse button, which will cause the line to move and the polygon to be resized.

When you are moving a line, you can hold the Shift key and the left mouse down together as you drag the
mouse to move the points; and the program will constrain the movement to the horizontal and vertical
directions.
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Step 2: Click on the
Edit Points toolbar
button.

Step 1: Click on the
polygon that has the
line you want to move.

Step 3: Position your
mouse cursor over the
line you want to move,
and you should see a
cross hair with arrows.
Hold the left mouse
button down, drag the
cursor to the new line
location, and release the
mouse button. The line
and all the lines and
points attached to it will
move to the new location.

Figure 5-25. Move a line by pressing the Edit Point button and placing the "move line" cursor over the line to be moved; hold the
left mouse button, and move the mouse in the desired direction.

5.6.6. Adding a Point
To add a point on a polygon:
1.

Move the mouse cursor over the polygon that is to contain the new point, and press the left mouse
button. This selects the polygon so that the points of the polygon are displayed.

2.

Press the Insert Point toolbar button, or use the Draw/Insert Point menu choice (Shift-F6).

3.

Move the mouse cursor to the point on the polygon edge where you want to add the new point.
When the mouse cursor is properly positioned, click the left mouse button, and the new point will be
displayed. It is also possible to use the keyboard input method (see Section 5.5) to move the cursor to
the location where you want the point to be inserted, and then use the Draw/Insert Point menu
choice. The Insert Point command does not recognize the snap priorities. If you are using the
keyboard input method to insert a point at a set distance from an existing point, move the cursor near
that point, and press the spacebar so the cursor snaps to that point. This will ensure that the point is
inserted the exact distance specified by the keyboard input method.

A common cause of the message saying the program cannot create overlapping regions is when you try to
insert a point within the sticky distance of an existing point. In this situation, zoom in to the drawing by
clicking the right mouse button.
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Step 1: Click (left mouse
button) on the polygon
that will contain the new
point.

Step 2: Click (left
mouse button) on the
Insert Point toolbar
button.

Step 3: Move the cursor (a
single arrow) to the point on
the line where you want the
new point. Click the left
mouse button, and THERM
will add the point.

Figure 5-26. Add a point by pressing the Insert Point button and clicking where the point is to be inserted.

5.6.7. Deleting a Point
To delete a point on a polygon:
1.

Click the mouse on the Edit Points toolbar button, or use the Draw/Edit Points menu choice.

2.

Select the polygon (click the left mouse button) so that the points are displayed.

3.

Move the cursor to the point to be deleted (get within sticky distance of the point).

4.

A double-arrow cursor is displayed.

5.

Press the Delete key on your keyboard, and the point will be removed. If you delete a point by
mistake, use the Edit/Undo menu or Ctrl-Z to undelete it.

5.7. Flip and Rotate
THERM has two drawing features that allow you to manipulate the entire cross section, Flip and Rotate. You
can use these functions to create sloped cross sections, as well as to use the same components multiple times
in different orientations. Keep in mind that:


Complicated drawings may take a few seconds to flip.



If the drawing isn’t visible in the drawing area, use Ctrl-Right mouse button to center it.
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5.7.1. Flip
From the Draw menu, select the Flip choice, and then either the Horizontal or Vertical options. Figure 5-28
shows the result of horizontally flipping the cross section in Figure 5-27.

Figure 5-27. Select Flip from the Draw menu.

Figure 5-28. The cross section has been flipped in the horizontal direction.
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5.7.2. Rotate
From the Draw menu, select the Rotate choice, and then either the Left 90o, Right 90o, 180o or Degree options.
Choosing Degree displays a dialog box which allows you to enter the exact degrees of rotation. Figure 5-30
shows the result of horizontally flipping the cross section in Figure 5-29.

Figure 5-29. Select Rotate from the Draw menu.

Figure 5-30. The cross section has been rotated 180 degrees.
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5.8. Fill Void
THERM has a drawing feature that allows you to create a polygon by "filling" a void or undefined area in the
cross section that is completely surrounded by other polygons. When this polygon is created, THERM
automatically creates all the necessary points to match the points on the surrounding polygons. This feature
eliminates the need for you to draw these potentially complicated polygons.
Figure 5-31 contains a cross section which has an undefined area completely surrounded by polygons, which
is a perfect candidate for using the fill void feature. To create a polygon for this cavity, follow these steps:


Click the left mouse button on the Fill Void toolbar button.



The drawing cursor will change to the Fill Void cursor.



Place the Fill Void cursor inside the undefined are that you want to fill with a polygon.



Click the left mouse button, and THERM will draw a polygon that fills the area and contains points
matching all the vertices on the adjacent polygons, as shown in Figure 5-32.



You may need to select the newly created polygon and change the material. See Section 5.10, "Assigning
Materials After Drawing Polygons".

Step 1: Click on the Fill Void
toolbar button.

Step 2: The drawing cursor
changes to the Fill Void cursor.
Step 3: Place the drawing Fill Void cursor
inside the area you want to "fill" and click the
left mouse button.

A polygon for this undefined
cavity area can be created
using the Fill feature.

Figure 5-31. Click on the Fill Void toolbar button, place the drawing cursor inside the void to be filled, and click on the left mouse
button.
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THERM creates a polygon
in the cavity that includes
points matching all
vertices on the adjacent
polygons.

Figure 5-32. The Fill Void feature creates a polygon in the cavity containing points matching all vertices on the adjacent polygons.
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5.9. Inserting a Glazing System
When you have drawn the nonglazed elements of your cross section, you are ready to add a glazing system.
If you used Autoconvert for a DXF file, you should delete any polygons that may have been automatically
drawn by THERM for the glazing system. Although it is possible to draw the glazing system from individual
components and assign materials to them, it is much easier to insert a glazing system from the WINDOW
library. Material properties and boundary conditions are predefined if you use this feature. A sample glazing
system library (glzsys.w4) is included with THERM. Additional glazing systems can be created using the
WINDOW program.
5.9.1. Inserting a WINDOW4 Glazing System
THERM can read the Glazing Systems Library created by WINDOW4 and automatically insert glazing
systems into your cross section drawing if you do the following:
1.

Specify the location for the glazing system to be inserted by selecting the Draw/Locator menu choice.

Figure 5-33. Select Locator from the Draw menu.

2.

Click with the left mouse button on the location for the lower left-hand corner of the inserted glazing
system; a small circle will appear at the selected location.
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Position Locator:
Place the drawing cursor in the lower left
corner of the area where the glazing
system will be inserted, and click the left
mouse button. A small circle will appear,
which is the Locator. The program will
automatically place the lower left corner of
the glazing system where the Lcoator is.

Figure 5-34. A small circle indicates the location of the lower left corner of the glazing system to be inserted.

3.

Select the Libraries/Glazing Systems menu choice.

Figure 5-35. Select the Glazing Systems choice from the Libraries menu.

4.

From the Glazing Systems dialog box, shown below, specify the path by which the program can find the
Glazing System Library file, GLZSYS.W4. Use the Browse button to find GLZSYS.W4 files; all Glazing
Systems defined in the specified GLZYSYS.W4 library will appear in the Glazing System pull-down list.

Figure 5-36. Select a WINDOW4 glazing system from the Glazing Systems dialog box.

5.

Pick the desired Glazing System from the pull-down list. If you want THERM to use the Condensation
Index (CI) Model when simulating the cross section, check the Use CI Model for Window 4 Glazing
Systems check box. If you do not check this box when you import the glazing system and later decide to
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do a CI calculation, you may select this model under Options/Therm File Options. If you select this
option, you will get U-factors based on the CI algorithms which are slightly different from the algorithms
in WINDOW4.1; these U-factors are not consistent with current NFRC U-factor procedures.
6.

Press the Import button.

7.

Another dialog box will appear, asking for the position of the glazing as well as dimension information.
While the Insert Glazing System dialog box is open, it is possible to use the Tape Measure toolbar
button to go to the drawing, determine the dimensions needed, highlight the dimension and press
Ctrl-C to copy the value from the Tape Measure results box, and then press Ctrl-V to paste the value
into the Insert Glazing System input boxes.

Figure 5-37. Specify the location and dimensions for the inserted glazing system.

Orientation

Actual cavity
height
Site line to
bottom of glass

Spacer height

Edge of Glass
Dimension

Orientation of the glazing system. Up means the spacer will be at the bottom of the
drawing. Down turns the glazing system upside down, placing the spacer at the top of
the drawing. This orientation can be changed using the flip and rotate features once the
glazing system has been imported. Default: Up.
The total height of the glazing system cavity. Default: 39.37 inches (IP); 1,000 mm (SI).
This value is only important when doing a CI calculation.
Distance from the frame sight line to the bottom of the glass, which forms the
demarcation point between the frame and the edge. For NFRC window modeling
purposes, the sight line is the demarcation point between the frame and the edge Ufactor calculations. Default: 0.5 inches (IP); 12.7 mm (SI).
Distance from the top of the spacer to the bottom of the glazing system. This dimension
determines how THERM will draw the generic spacer or how much space to leave if the
Draw spacer box is not checked. Default: 0.5 inches (IP); 12.7 mm (SI).
Dimension of glazing that is used to calculate the impact of the frame "edge effects."
Default: 2.5 inches (IP); 63.5 mm (SI).

Draw spacer

If this box is checked, the program will draw a rectangle of the chosen material when the
glazing system is imported. If it is unchecked, the program will leave the spacer area
blank, and you can draw your own spacer or paste in a spacer from another THERM file
(see Section 5.12, "Creating a Component Library" later in this section). Default:
unchecked.

Spacer material

If the Draw spacer box is checked, this pull-down choice will determine the material of
the rectangle that the program draws to represent the spacer.
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The drawing below illustrates the dimensions being defined in the Insert Glazing System dialog box. These
dimensions are used by the program to determine how much area to leave for the spacer, and to determine
the demarcation point between the frame and the edge.

OUTSIDE

INSIDE
Edge of glass
dimension

2.5"

Line of Sight
Spacer height

Sight line to
bottom of glass

Generic spacer drawn
by THERM if "Draw
spacer" is checked.

Figure 5-38. Illustration of dimension definitions used in the Insert Glazing System dialog box

8.

THERM will insert the glazing system, as shown below, including the appropriate number of glazings
and cavities. If the Draw spacer box was unchecked, an opening is left for a spacer, which must be
defined separately. You can draw rectangles to represent the spacer or paste a spacer from another
THERM file into this drawing (see Section 5.12, "Creating a Component Library" for more details.)
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Figure 5-39. THERM inserts the glazing system in the drawing based on the position of the Glazing Locator.

9.

You may need to move the glazing system after it is inserted (see Section 5.6, "Editing Polygons"). The
glazing layers and cavities are grouped together and can be moved as a unit. Although it is possible to
separate these layers (if you turn on the Allow editing of IG polygons from the Options/Preferences
menu choice, on the Drawing Options tab), it is recommended that you do not do this. Instead, to change
the glazing system, you should delete the existing glazing system (using the same technique as for
deleting any other polygon except that all glazing system polygons will be deleted as a group) and
import a new glazing system from WINDOW4. Although it is possible to create a glazing system in
THERM by drawing polygons and assigning materials, this is only recommended when you are
modeling a nonstandard product because the process is time-consuming and difficult to do correctly.

10. If you checked the Use CI Model for Window 4 Glazing Systems box when importing the glazing
system, you will see red boundary conditions in the cavity between the layers of glass (for multipane
systems). These are drawn automatically by the program.
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THERM draws boundary conditions for the glazing
cavity. Click once on the boundary segment to
see the definition; click twice to display the dialog
box with features of the Glazing Cavity Surface.

Figure 5-40. Condensation Index procedure for glazing cavities

The Glazing Cavity Surface dialog box appears when you double-click on a glazing cavity boundary
condition created using the Condensation Index feature of THERM. The fields are the following:
Emissivity

The emissivity of the surface.

Side

The side of the surface relative to the cavity. The choices are:


Adiabatic



Left



Right



Open

Temperature

The temperature of the surface.

Blocking Surface

This check box is used to indicate whether the surface is blocking radiation transfer. The
default value in the program is that all surfaces are blocking. Unless you are worried
about calculation speed (under default conditions, calculation time may be longer), it is
easiest and most accurate to keep the default on.

5.9.2. Condensation Index
The Condensation Index (CI) Model provides an alternative method for determining heat transfer through
glazing systems. It was developed to improve the accuracy of local temperature modeling which is important
in predicting where condensation will occur in a fenestration product. Glazing systems imported from
WINDOW4 use an effective conductivity model to account for conduction, convection, and radiation. The
convection model is based on a single value determined from the average behavior of the entire glazing
cavity. The traditional radiation model assumes infinite parallel plates of constant temperature within the
component being modeled(2). These assumptions have been shown to yield acceptable results for the average
(13)
heat loss (U-factor), but they are inadequate for predicting local temperatures . The condensation index
(14,15)
uses local film coefficients and a detailed radiation model. This more detailed
model included in THERM
model has been shown to give more accurate local temperature results then the effective conductivity model.
The condensation index model calculates U-factors based on the CI algorithms which are slightly different
from those in WINDOW 4.1; these U-factors are not consistent with current NFRC U-factor procedures. It is
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currently limited to modeling glazing cavities with pure gas (air, argon, or krypton). This restriction will be
eliminated in future versions of the program.


Turn on the Condensation Index Model. The Condensation Index Model can be activated in two
different ways:


Turn it on for all imported glazing systems: By checking the Use CI Model for Window 4 Glazing
Systems checkbox in the Therm File Options choice of the Options menu, as shown in Figure 5-41,
you set this option for all glazing systems that are imported into THERM.



Turn it on for each glazing system as you import it: By checking the Use CI Model for Window 4
Glazing Systems checkbox on the Glazing System Library dialog box when you import a system
from WINDOW, as shown in Figure 5-42, you can specify for individual systems whether to use the
CI Model.

If the Condensation Index Model is not checked when the glazing is first imported, it can be changed
before the final calculation in the Therm File Options dialog box; checking the CI Model checkbox at that
time will change the model of a glazing system already imported into THERM. This way, you can do a
calculation for U-factor and then do a condensation index calculation without redrawing the model.

Click on this check box
(either before or after you
import a glazing system
from WINDOW) to use the
Condensation Index Model
for glazing cavities

Figure 5-41. Check box for turning on the Condensation Index feature for glazing cavities
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Click on this check box when
you import a glazing system
from WINDOW to use the
Condensation Index Model for
glazing cavities

Figure 5-42. Check box for turning on the Condensation Index from the Glazing System Library
when importing a system from WINDOW.


Import a glazing system from WINDOW4. The glazing system appears with the glazing cavity
surrounded by a red line. This is an easy way to tell whether an effective conductivity or condensation
index model is being used. The condensation index model does not treat the glazing cavity as a solid
material but as an additional boundary condition. This boundary condition is automatically defined
when the glazing system is imported. Double-click on this boundary to make sure it is correct for your
model.

Glazing Cavity Surface boundary conditions are
atuomatically generated for an imported
WINDOW glazing system if the Condensation
Index model is activated (either when imported,
or using the Options/Therm File Options menu.
Double-click on one of the Glazing Cavity Surface boundary
conditions to see the properties of that boundary condition.

Figure 5-43. Condensation Index procedure for glazing cavities

The Glazing Cavity Surface dialog box appears when you double-click on a glazing cavity boundary
condition created using the Condensation Index feature of THERM. The fields are the following:
Emissivity

The emissivity of the surface. This value comes from the WINDOW glass library which
must be in the same subdirectory as the glazing system library; otherwise, a default
value of 0.84 is used. This value can be overridden.

Side

The side of the surface relative to the cavity. The choices are:
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Adiabatic: assigned to the bottom of the glazing system.



Left: assigned to the left surface of the glazing cavity.



Right: assigned to the right surface of the glazing cavity.
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Temperature

Blocking Surface

Open: assigned to the top of the glazing cavity. When this condition is chosen,
THERM sets the temperature equal to the average glazing cavity temperature.
The temperature of the surface. These values are obtained from the WINDOW glazing
system library. The temperature of the Open boundary is the average glazing cavity
temperature. There is no temperature shown for the Adiabatic surface because it is not
used in the calculation.
This check box is used to indicate whether the surface is blocking radiation transfer. The
default value in the program is that all surfaces are blocking. See Section 6.4.1, "Frame
Cavities with Detailed Radiation Model" for a definition of blocking surfaces. For a
typical glazing cavity with parallel glazing layers, the spacer is the only component that
could provide a blocking surface. Changing the default on a surface that is actually
nonblocking may provide a modest increase in calculation speed. Labeling a blocking
surface as nonblocking will result in incorrect results. It is recommended that you use
the program default value, which causes the program to determine whether or not the
surface is blocking.

5.9.3. If the WINDOW4 Glazing System Doesn’t Fit
When you try to insert the W4 glazing system, you may get the following message:

Figure 5-44. Message displayed if the Glazing System cannot be inserted

Either reposition the Locator, or move elements of the cross section to allow the glazing system to fit. In
addition, you can obtain the width of the glazing from WINDOW4 and edit the cross section to fit. Glazing
systems are usually separated from the frame on both sides by tape or sealant. The best way to insert a
glazing system is to draw a polygon representing the sealant on one side. This polygon helps to locate the
glazing system. Once the glazing system is imported, draw a polygon to represent the sealant on the other
side of the glazing system. These sealant polygons are small, so you will probably need to zoom in to draw
them.
Another possible reason that the glazing system doesn’t fit is due to a round off discrepancies. The thickness
of the glazing system in WINDOW 4.1 is calculated to three decimal places in either SI or IP units. However,
the tape measure gives lengths to four decimal places in IP units and three decimal places in SI units. If you
are having trouble fitting the glazing system, you may want to try measuring the space for the glazing system
with the tape measure in SI units to eliminate the possible round-off error.
5.9.4. Inserting Multiple WINDOW4 Glazing Systems
You can place more than one glazing system in a drawing. When you add systems, the program asks if you
want to replace the existing system or add another.
5.9.5. Information about the Glazing System
You can view information about the inserted glazing system by double-clicking your mouse on any part of
the glazing system. The following window will appear:
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Figure 5-45. Double-click on the inserted glazing system to see information about the system.

5.10. Assigning Materials After Drawing Polygons
Material properties must be specified for each polygon. While you are drawing, THERM assigns the most
recently used material. You can select the material as you are drawing or change the material assignments
after the polygons have been drawn.
There are two different classes of materials, solids, and cavities. Solids have a specified thermal conductivity.
A frame cavity model is used to calculate the effective conductivity for cavities commonly found in
aluminum, vinyl, and fiberglass window frames. The glazing cavity in an insulated glazing unit is treated as
a solid with an effective conductivity that accounts for conduction, convection, and radiation (see Section
5.9.2, "Condensation Index" for an alternative way of treating the gas cavity). It is recommended that the
glazing cavity be modeled by importing a glazing system from WINDOW4.
After the polygons are drawn, you can assign a different material to them by using one of the methods
discussed below. You can select multiple polygons that all need to be assigned the same materials using the
selection techniques discussed in Section 5.6.1, "Selecting a Polygon."
5.10.1. Use the Material pull-down list to the right of the toolbar:
1.

Select the polygon by placing your mouse inside the object and clicking the left mouse button.

2.

The vertices of the selected polygon are indicated as squares.

3.

Select the appropriate material from the list in the upper right corner of the toolbar. The choices in
the list show all the entries in the Material Library[16]. A fast way to move through the list is to type
the name or even just the first few letters of the material you want. For example, typing Wood would
put you on the first instance of Wood in the Material List, Wood (Cedar or Redwood). You could
then use the down arrow key to get to Wood (Pine, Spruce, Fir). You can then press Enter or click on
the material with your left mouse button, and the selected material will be assigned to the polygon.
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Figure 5-46. You can select polygons after they are drawn and assign materials to them.

5.10.2. Access the Properties for Selected Polygon(s) dialog box:
Another way to assign a material to a polygon is to double-click on the polygon you want to change, or, if the
polygon is already selected, press Enter, use the Library/Set Material menu choice, or press F4. This causes
the Properties for Selected Polygon(s) dialog box to appear, as shown in the following figure.

Double-click (or
press Enter) on a
polygon, and the
Properties for
Selected
Polygon(s) dialog
box will appear.

Figure 5-47. Material properties for solid material are accessed by double-clicking mouse on polygon.

The advantage of this method is that you can access the Material Library by using the Library button if you
want to add a new material or change the properties of a material.
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The information displayed in the Properties of Selected Materials dialog box is dependent on the type of
material, which is discussed in more detail in Section 5.11, "Defining New Materials." However, all material
types will have the following fields:
•

Material: a pull-down list, which shows the currently defined material for the selected polygon. With
this pull-down list, you can change the material for the selected polygon. This list contains the same
choices as the list on the right side of the toolbar.

•

ID: a field below the Material pull-down list, which is a unique number that is assigned to every
polygon in the cross section. This number is useful for identifying specific objects in the THERM
reports and when using the Select Special feature (discussed in Section 5.6).

5.10.3. Solid Materials
For solid materials, the Material name and ID number are the only values displayed; however, if you press
the Library button, you can access the Material Definitions dialog box for that material and see the
Conductivity and Emissivity.

Click the left
mouse button on
Library and the
Material
Definitions dialog
box will open,
displaying the
Conductivity and
Emissivity values
for the solid.

Figure 5-48. Material Definitions dialog box accessed from the Library button shows the Conductivity and Emissivity for
Solids.

5.10.4. Frame Cavities
For cavities, several values are listed in addition to the material name and ID number:


Keff, the effective conductivity, and Nu, the Nusselt number, which are calculated by THERM based on
the model choices specified in the Material Library and cannot be edited.



The Vertical and Horizontal dimensions are the actual dimensions of a rectangular cavity or the effective
dimension determined by the Cavity Model selected in the Material Library for nonrectangular cavities.
These values can only be edited if the User Dimensions Cavity Model is selected.
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The Heat Flow Direction can be selected from a pull-down menu. The three choices are Horizontal, Up
and Down. This choice determines what correlation will be used to calculate the convective film
coefficient. Horizontal heat flux assumes that the governing temperature difference is between the
vertical walls of the cavity. Heat flow Up assumes that the governing temperature difference is between
the horizontal walls of the cavity and that the lower wall is warmer than the upper wall. Heat flow Down
assumes that the governing temperature difference is between the horizontal walls of the cavity and that
the upper wall is warmer than the lower wall.



The Temperatures are used to calculate the convective film coefficient in all cavity models and the
radiative conductance in the simplified radiation model. For horizontal heat flow these would be the
average temperatures of the vertical sides of the cavity. These values can be edited.



The Emissivities appear for the simplified radiation model only. These are the emissivities of the surfaces
perpendicular to the heat flow direction, i.e., the vertical sides of the cavity for horizontal heat flow.
These values can be edited either by selecting a predefined value from the pull-down menu or by typing
in a value.

See Section 5.11, "Defining New Materials" for a more detailed explanation of how to use this information.

Double click on a
cavity polygon to see
the Properties dialog
box

Figure 5-49. Material properties for cavities accessed by double-clicking mouse on polygon.

5.11. Defining New Materials
There are four material types in THERM:
•

Solid

•

Frame Cavity

•

Glazing Cavity (not currently implemented)

•

External Radiation Enclosure.

THERM comes with a set of predefined materials that cannot be edited (the input values are disabled).
Materials can be added to the Material Library using the following technique.
1.

Open the Material Library by selecting the Library/Material Library menu choice, and the Material
Definitions dialog box is displayed. You can use the pull-down list at the top of Material
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Definitions to view the characteristics of any of the materials, but because the predefined materials
are protected from editing (they are grayed out), you cannot change any of the values, as shown in
Figure 5-50. However, you can make new materials in this library, as explained in the following
steps.

Figure 5-50. The default Material Library that comes with THERM has only "Protected" materials that cannot be edited.

2.

To make a new material, click on the New button.

3.

You will be asked for the name of the new material. Type a name that is not already in the library,
and click on the OK button.

Figure 5-51. Type a unique name for the new material.

4.

Now you are presented with the same Material Definitions dialog box, but all the fields are available
for you to edit. Different fields are available for editing depending on the Material Type that you
choose, i.e., solid, cavity, or external radiation enclosure. These different types are discussed in detail
in the following sections. Enter the input values as appropriate.

5.

Click on the Color button to select a color for your material other than the default blue.

6.

When you have defined the characteristics of the material, click on the Save Lib As button in order to
save the material permanently to the default library (named material.lib) so that it can be used again.
(If you forget to save it, you will be asked when you close THERM if you want to save the changes
you made to the library unless you turn this feature off using Options/Preferences/Prompt for
saving libraries on program exit). See the discussion in Section 5.11.5, "Making Custom Material
Libraries" for details about having material libraries other than the default.
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Figure 5-52. To define a new material, click on the New button; a nonprotected Materials Definition dialog box will appear,
allowing you to define the characteristics of the new material.

5.11.1. Solid Materials Type
For the Solid material type, the relevant input values are found in the Solid Properties group box on the
Material Definitions dialog box, which contains the following values:
Conductivity

Units: W/m-K (SI); Btu/h-ft-oF (IP)

Emissivity

Default value: 0.9

Figure 5-53. Material Library definition for solids

For the predefined materials, these values are not editable. However, if you click on the New button and
make a new material, you will be able to edit these values, as discussed previously in Section 5.11, "Defining
New Materials".
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5.11.2. Frame Cavity
There are two materials in the default THERM library defined with the Material Type of Frame Cavity. These
materials have the following characteristics (the Radiation and Cavity Model definitions are discussed at the
end of this section):


Frame Cavity (NFRC Simplified):

Radiation Model: Simplified
Cavity Model: NFRC



Frame Cavity (NFRC Detailed):

Radiation Model: Detailed
Cavity Model: NFRC.

Figure 5-54. Default Frame Cavity (NFRC Simplified) protected Material Library

If you want to make new frame cavities, follow the instructions above for making new materials; specify the
new input values in the Cavity Properties group box in the Material Definitions dialog box. It is not
necessary to create a new material for each frame cavity. The following discussion explains the values needed
for many of these inputs.
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Figure 5-55. Creating a new frame cavity entry in the Material Library

For a frame cavity material, you need to specify the type of Radiation Model and Cavity Model the program
should use. The most common case for NFRC compliance will be the Simplified Radiation Model and the
NFRC Cavity Model.
Radiation Model

Cavity Model

THERM 2.0

The radiation model to be used by THERM.
(16)



Simplified: uses the method in ASHRAE SPC 142P , modeling radiation effects as
an effective conductance based on the temperature and emissivity of the two
parallel faces perpendicular to the heat flow. For nonrectangular cavities, this
conductance is determined using the dimensions of the approximate rectangle in the
Cavity Model (see below) and a curve fit model. The default values for the
temperatures in the frame cavity are 7 °C and –4 °C. The default emissivities are
0.90 for both surfaces. The temperatures and emissivities of each frame cavity can
be edited in the Properties for Selected Polygons dialog box, which you can access
by double-clicking on the cavity.



Detailed: does an element-by-element view-factor calculation taking into account
the temperature and emissivity of each element; these THERM algorithms are based
(12)
on FACET . The detailed model reads the emissivity of the surrounding material
from the material library. These emissivities can be overridden by double-clicking
on the red boundary that appears around the cavities once the boundary conditions
have been defined. For more discussion about the detailed model, see Section 6.5.1,
"Frame Cavities with Detailed Radiation Model" and Appendix C, "Theoretical
Background."

The cavity model to be used by THERM. This model accounts for convection as well as
the way the nonrectangular cavities are approximated.


NFRC: In this model, the effective conductivity is calculated based on a rectangle
that fully encloses the cavity. Convection correlations are based on the Handbook of
(11);
Heat Transfer Fundamentals ; the specific correlations used can be found in
(16)
ASHRAE SPC 142P .



CEN (unventilated): This model calculates the effective conductivity based on a
rectangle with the same aspect ratio and area as the cavity being analyzed. This is a
European standard. When this Cavity Model is used with the Simplified Radiation
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Model, THERM uses the CEN version of the radiation model, which is slightly
different than the SPC 142 method.


CEN (slightly ventilated): This model is also part of the European standard. It is to
be used for cavities that have an opening to the environment of greater than 2 mm
and less than 10 mm.



User dimension: In this model, the user can define the rectangular dimensions for a
nonrectangular shape; the effective conductivity is based on the SPC 142P method.
(11)

The effective conductance of frame cavities is obtained from standard correlations . The material Frame
Cavity NFRC (Standard) assumes a horizontal heat flow. For a rectangular cavity, the governing
temperature difference is assumed to be between the vertical walls of the cavity. An average emissivity for
these surfaces needs to be determined. Horizontal heat flux assumes that the governing temperature
difference is between the vertical walls of the cavity. Heat flow Up assumes that the governing temperature
difference is between the horizontal walls of the cavity and that the lower wall is warmer than the upper wall.
Heat flow Down assumes that the governing temperature difference is between the horizontal walls of the
cavity and that the upper wall is warmer than the lower wall. When drawing window models, take care that
the heat flow in the cavities is defined according to the conditions that will apply when the cross section is
positioned in the window. In some cases, the vertical and horizontal dimensions will have to be switched (or
the cross section rotated) for these definitions to be correct.
After a polygon has been assigned a frame cavity material, you can view the cavity dimensions as well as the
effective conductivity and Nusselt number of the cavity by double clicking on the polygon. (This is discussed
in more detail in Section 5.10, "Assigning Materials After Drawing Polygons.")
5.11.3. Glazing Cavity
This material type is not currently being used. Glazing cavity properties should be obtained from WINDOW,
which occurs automatically when you use imported glazing systems.
5.11.4. External Radiation Enclosures
The external radiation enclosure feature uses the detailed radiation view-factor model to accurately simulate
the radiant exchange between the building component being analyzed and its surroundings. This radiation
view-factor model takes into account the extent to which the component “sees” or radiates to itself. In
thermal modeling of fenestration products, radiation accounts for half of the heat loss on the room-side
surface. The simplified method assumes that the component only has radiant exchange with its
surroundings. This assumption does not hold true for projecting fenestration products such as greenhouse
windows and skylights and may also be problematic for sliding windows with deep channels.
The radiation enclosure is one of the standard classes of material included in the material library. Radiation
enclosures are bounded by the model and by boundary conditions of specified temperature. Radiation
enclosures are unique because every point on the bounding surface of the model must be included in the
radiation enclosure. (For all other materials, THERM can add any missing points.) It is possible to draw the
radiation enclosure by hand, making sure a vertex exists on the radiation enclosure polygon for every vertex
on the adjacent polygon. The fill void feature, however, can simplify this procedure. The following steps
explain how to use this feature to create radiation enclosures:
1.

Draw a temporary polygon that surrounds the outside of the radiation enclosure.
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Step 1: Draw a polygon
that surrounds the area of
the radiation enclosure.

Figure 5-56. Draw a temporary polygon around the area that will become the External Radiation Enclosure.

2.

Click on the Fill Void icon on the toolbar.

3.

Place the Fill Void cursor inside the undefined area surrounded by the temporary polygon, and click the
left mouse button. The fill void feature will create a polygon with points defined that match the points on
all adjacent polygons.

Step 1: Click on the
Fill Void toolbar
button

Step 2: Place the Fill
Void mouse cursor inside
the area you want to fill
with the radiation
enclosure, and click your
left mouse button. The
cavity will be
automatically filled.

Figure 5-57. Use the Fill Void toolbar button to create the External Radiation Enclosure polygon.

4.

Select the polygon that is created by using a single click of the left mouse button, as shown in Figure 5-58.
Assign the material of the radiation enclosure polygon from the Materials pull-down list on the right side

THERM 2.0

JUNE 1998

5-47

5. DRAWING CROSS-SECTION GEOMETRY

of the toolbar, or from the Libraries/Material Library menu choice. Select the predefined material in the
Material Library called Radiation Enclosure which has the Material Type of External Radiation
Enclosure, shown in Figure 5-59. Any material of this type will have special boundary conditions
automatically assigned to it; these are called Radiation Surface. See Chapter 6, "Defining Boundary
Conditions" and Section 7, "Calculating Results" for more information about External Radiation
Enclosures.

Step 2: Select the predefined
Radiation Enclosure entry
from the Materials pulldown
list.

Step 1: Select the newly
created Radiation
Enclosure polygon.

THERM will automatically
create points at the
intersection between the
radiation enclosure and the
adjacent polygons.

Figure 5-58. Assign the predefined material Radiation Enclosure to the Radiation Enclosure polygon.

Figure 5-59. The predefined Radiation Enclosure material can be used for the External Radiation Enclosure polygons

5.

Delete the temporary polygon used to surround the radiation enclosure. If a radiation enclosure is
completely surrounded by other materials (either solids or cavities), it will be considered a void in the
model. This is an incorrect use of the radiation enclosure feature; instead use the detailed frame cavity
model for cavities surrounded by other materials.
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The final Radiation
Enclosure, with the
temporary polygons deleted,
and the Radiation
Enclosure material
assigned.

Figure 5-60. The completed Radiation Enclosure (the temporary surrounding rectangle deleted).

6.

Complete the analysis by defining boundary conditions (see Section 6.5.2, "External Radiation
Enclosures" for special information about boundary conditions for this situation) and calculating the
results (see Chapter 7).

5.11.5. Making Custom Material Libraries
The default THERM library is called "material.lib" and is located in the THERM installation directory. The
default library can be customized by adding new material entries, or other custom material libraries can be
created, using different names and different directories if desired. Use the Save Lib As button in the Material
Definition dialog box to create custom libraries and load them using the Load Library button in the same
dialog box.

Step 1: Click on the
Save Lib As button.

Step 2: In the Save As dialog box, type
a name for the new library. You can
change the directory where the library
will be located.

If you want to
load a custom
library, click on
the Load Lib
button.

Figure 5-61. Material properties for cavities accessed by double-clicking mouse on polygon.
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5.12. Creating a Component Library
In modeling windows, you will probably find that there are some components you need to draw again and
again. THERM allows you save these frequently used components as separate files from which you can copy
and paste. This is useful when the separate components that make up a window cross section are provided
as separate drawings. It is also useful for drawing small, finely detailed objects, such as spacers.

Figure 5-62. THERM file containing just a spacer

To cut and paste components between THERM files:
1.

Open both a current working THERM file and the THERM file containing a component you wish to copy
and paste.

2.

In the working file, place the locator (Shift F2) on the point where the matching point on the component
will be placed.

3.

Use the Window menu to switch to the component file, and select the portions of the component that you
wish to copy and paste into the working file. A single THERM file, for instance, could contain all the
spacers from a single manufacturer. Use the Edit/Select All menu to include all the features in the
component file, or use the other polygon selection methods to select specific elements of the component
(see Section 5.6.1, "Selecting a Polygon" for more details.)

4.

Place the locator (use Shift F2 and click the left mouse button) at the point which will match the location
in the working file.

5.

Press Ctrl-C to copy the selected polygons into the Windows™ clipboard.

6.

Using the Window menu, switch to the working file.

7.

Press Ctrl-V to paste the selected polygons into the working file. THERM will position the pasted
polygons into the working file by matching the positions of the locator points defined earlier for the
component file and the working file.

5.13. Importing a FRAMETM F30(3) File
TM

(3)

THERM can import FRAME F30 files. The program brings these files in as rectangles. In order to perform
TM
a calculation on a FRAME F30 file, insert a glazing system, and assign materials, boundary conditions, and
U-factor tags. F30 files are created for use with a finite-difference program and are limited to rectangularized
geometry, and are limited in the number of available rectangles used to define a cross section, often resulting
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in over simplification of cross sections. In addition, cavities which have been divided up into rectangles must
be redrawn in THERM. THERM is a finite-element program that allows for geometry to be represented by
general polygons. Use of F30 file is recommended for comparison purposes only.
Check the THERM website (go to the "Software" section of windows.lbl.gov) for updates about FRAME file
conversions.
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6.1. Overview of Boundary Conditions
Chapter 5 describes procedures for drawing a cross-section geometry and assigning materials to components,
which are the first steps toward performing a heat-transfer analysis. The next step is to define the boundary
conditions for the cross section. The procedures for defining boundary conditions are not dependent on how
the cross section was drawn.
The steps for assigning boundary conditions are summarized below and explained in detail in the sections
that follow.


Click on the Boundary Conditions toolbar button (or use the Draw/Boundary Conditions menu choice
or the F10 keyboard shortcut). This causes THERM to draw the boundary conditions for the cross section.
Under most circumstances, boundary conditions are drawn automatically around the outside of the
completed cross section (see Section 6.5, "Special Boundary Condition Cases" for exceptions). THERM
moves around the model counterclockwise and indicates the boundary by a heavy line.



The program checks for characteristics in the geometry that will cause a problem in the heat-transfer
simulation. These include undefined voids, overlapping polygons (see Section 6.3.2, "Finding Voids and
Overlaps"), and polygons that are not contiguous. If problems are detected, THERM will issue a message.
You may need to resolve these problems before the boundary conditions can be defined. When you have
fixed any problems, click on the Boundary Conditions toolbar button again.



Reassign boundary conditions as necessary. The boundary is actually composed of many small boundary
segments that default to the condition of Adiabatic unless you have imported a glazing system from
WINDOW in which case THERM assigns predefined boundary conditions to the glazing. You can change
the boundary conditions of each segment of the cross section using the procedure described below in
Section 6.2.3.



Define U-factor tags if desired. These tags allow you to specify a group of boundary segments as one unit
for which a single U-factor is to be calculated.

When these steps are complete, you have finished assigning the boundary condition definitions and can now
perform the heat-transfer calculations for your cross section and then view the results (see Chapter 7,
"Calculating Results," for a detailed discussion of the calculation procedure.)

6.2. Assigning Boundary Condition Definitions
The general method for defining boundary conditions is explained below. The example given does not
involve any detailed or comprehensive modeling conditions for frames or glazing cavities, which are
described in Section 6.5, "Special Boundary Condition Cases."
6.2.1. Generate Boundary Conditions
1.

Make sure you save your file, then click on the Boundary Conditions toolbar button
Draw/Boundary Conditions menu choice.
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2.

The program draws an exterior boundary around all the cross section components, indicated by a heavy
bold line, as shown in the following figure. This line is actually composed of many boundary segments,
each of which is individually assigned a boundary condition.

3.

A default boundary condition of Adiabatic is automatically assigned to all segments except those on
glazing systems imported from WINDOW, which have predefined boundary conditions. The Adiabatic
boundary condition is defined by a black color. In the predefined Boundary Condition Library that is
included with THERM, boundary conditions for segments exposed to a cold environment are indicated
with shades of blue; conditions for segments exposed to a warm environment are indicated by shades of
red.

Step 1: Press the Boundary
Conditions toolbar button

Step 2: THERM will
automatically draw the
boundary condition segments
around the entire geometry,
indicated by a heavy line.
Different boundary condition
types will be indicated by
different colors; in the
predefined Boundary
Conditions Library,
Adiabatic is black, conditions
exposed to cold are blue, and
conditions exposed to heat
are red.

Figure 6-1. Click on the Boundary Condition (BC) toolbar button; THERM will automatically draw the boundary
condition segments, indicated by a heavy line.

6.2.2. Automatic Check of Geometry Definition
When THERM draws boundary conditions, it checks the cross-section geometry to make sure that there are
no problems that will cause the thermal calculation to fail. If the program finds such problems, it displays
messages describing the problems; the boundary conditions may not be drawn until you correct the
problems. Problems that cause the program to issue boundary condition error messages are:


Noncontiguous polygons, i.e., polygons that are not touching any other polygon in the cross section.
The error message will say, ”There are materials that are outside of the Boundary Conditions."



Regions inside the cross section that are not defined as a polygon are classified as voids. Polygons
whose edges overlap an adjacent polygon are classified as overlapping. The error message will say,
"The geometry contains voids or overlapping regions. The edges surrounding these regions will be
highlighted in red. You must fix this problem before simulating." (THERM usually detects this
problem as you are drawing, but it does not catch every instance.)

If you get these error messages when you push the Boundary Conditions toolbar button, you will have to
correct the problems before simulating. See Section 6.3, "Error Detection in THERM" later in this chapter for
more information about correcting these problems.
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6.2.3. Reassign Boundary Conditions
THERM comes with a predefined Boundary Conditions Library that can be used to assign boundary
condition to each segment. It is also possible to add new definitions to the Boundary Conditions Library,
which is discussed in detail in Section 6.4, "Defining New Boundary Conditions". In most cases, you will want
to change the boundary condition Adiabatic that THERM assigns automatically. THERM cannot perform the
simulation without at least two nonadiabatic boundary condition, and will issue a message if this condition is
not met. To reassign boundary conditions:
1.

Select one or more boundary segments.
To select one segment for assigning boundary conditions, place your mouse cursor over the segment and
click the left mouse button once. You will see that the segment you have selected is indicated by rounded
endpoints.
To select multiple boundary segments:


For contiguous segments, select the first segment (by placing your cursor on the segment and clicking
the left mouse button once), hold the Shift key down, move your cursor in a counter-clockwise
direction to the last segment, and, keeping the Shift key down, click the left mouse button on the last
segment and then press Enter (or, keeping the Shift key down, double click the left mouse button on
the last segment) to select the series of segments and display the Boundary Condition Type dialog
box.
OR



For noncontiguous boundary segments, hold the Ctrl key down and click on multiple segments, then
press Enter on the last segment (or, hold the Ctrl key down and double-click the left mouse button on
the last segment) in order to access the Boundary Condition Type dialog box.

Step 2: Still working in a
counter-clockwise
direction, double-click on
the last boundary condition
segment.

Step 3: The Boundary Condition Type dialog box
will appear, and you can set the fields
appropriately.

Step 1: Working in a counterclockwise direction, click once on the
first boundary condition segment.

Figure 6-2. Select multiple boundary segments by pressing down the shift key and clicking the mouse on segments as you move in a
counter-clockwise direction, OR click on the first segment and then double-click on the last segment, in a counter-clockwise direction;
all segments in between will be selected.
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2.

When you have the selected boundary segments, you can use two methods for reassigning boundary
conditions to them:


Select the boundary condition definition from the pull-down list on the right-hand side of the toolbar;
this list shows the entries in the Boundary Condition Library.

Step 2: Select the
appropriate boundary
condition from the pulldown list.

Step 1: Click your left
mouse button once to
select a boundary
condition segment. The
segment end points will
be indicated by
rounded points.

Figure 6-3. One method for defining the boundary condition properties is to click on one or more boundary segments and pick the
desired boundary condition definition from the pull-down list.

OR


Press Enter after you have selected the boundary condition segment(s), which accesses the Boundary
Condition Type dialog box. This method has the advantage of allowing you to change the U-factor
Surface tags (see Section 6.2.4, "Define U-factor Surface Tags") and also accessing the Boundary
Condition Library in addition to selecting the boundary condition. (Alternatively, you can select the
boundary segment with one left mouse click; and then select the Library/Set Boundary Condition
menu choice to access the Boundary Condition Type dialog box, or select the Library/Boundary
Condition Library menu choice to access the Boundary Conditions library dialog box.)
Select the appropriate values from the pull-down lists for Boundary Condition and U-Factor Surface.
The choices in the Boundary Condition list show all the entries in the Boundary Condition Library,
and the choices in the U-Factor Surface list show all the entries in the U-Factor Surface Library.
These libraries can be accessed directly from this dialog box using the two buttons at the bottom of
the box. If you have imported a glazing system, the boundary conditions for that glazing system will
also appear in the Boundary Condition list (the glazing system name appears as a prefix to the title)
for both U-factor and Solar conditions.
You can access the Boundary Condition Library (shown in the following figure) to view the
properties associated with a boundary condition by clicking the Boundary Condition Library button
at the bottom of the Boundary Condition Type dialog box. The predefined boundary conditions that
are provided with THERM cannot be edited, but you can add new boundary conditions to the library
(see Section 6.4, "Defining New Boundary Conditions" later in this chapter).
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Step 2: In the
Boundary
Condition Type
dialog box, you
can choose the
Boundary
Condition and the
U-factor Surface
tag.

Step 1: Double click your left mouse
button to select a boundary condition
segment and open the Boundary
Condition Type dialog box.

Figure 6-4. Another method for assigning boundary conditions is to double-click on a segment to access the Boundary Condition
Type dialog box where you can select the Boundary Condition as well as the U-factor Surface tag name.

Glazing systems that are imported from WINDOW have predefined boundary conditions; THERM
assumes that the outside surface is on the left unless you flip the glazing system horizontally after it is
imported. Four boundary conditions are imported with the glazing system:


U-factor Inside Film, U-factor Outside Film: calculated under environmental conditions equivalent to
ASHRAE winter.



Solar Heat Gain Inside Film, Solar Heat Gain Outside Film: calculated under environmental conditions
equivalent to ASHRAE summer.

These boundary conditions show the WINDOW glazing system name as a prefix. For example, the name
of an inside glazing system boundary condition would be "Dbl, low-e, Ar U-factor Inside Film" if the
name of the glazing system imported from WINDOW was "Dbl, low-e, Ar."
3.

Continue to define all the boundary conditions. When you are finished your cross section should look
similar to the following figure. You can see boundary conditions more clearly if you turn off the material
colors (go to the View menu and uncheck the Material Colors choice; then, you will see only the polygon
outlines, and the boundary conditions appear prominent). Similarly, you can turn off the display of the
boundary conditions by unchecking the Boundary Condition choice in the View menu.
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Boundary Condition: Adiabatic
U-Factor Surface:
None
Boundary Condition: Dlb,low-e,Ar U-factor Inside Film
U-Factor Surface:
Edge

Boundary Condition: Dlb,low-e,Ar U-factor Outside Film
U-Factor Surface:
None

Boundary Condition: Dlb,low-e,Ar U-factor Inside Film
U-Factor Surface:
Frame (if applicable)

Boundary Condition: Interior Wood/Vinyl Frame
U-Factor Surface:
Frame
Boundary Condition: Exterior Surface
U-Factor Surface:
None

Figure 6-5. Final boundary condition configuration for a simplified model

6.2.4. Define U-factor Surface Tags
U-factor surface tags are used to label and group boundary segments for the program’s U-factor calculation.
Without these tags the program will not calculate U-factors. The U-factor is a measure of the heat transfer
through a cross section under specific environmental conditions. The U-factor calculation integrates the heat
flux for the boundary segment (or group of segments that have been given the same tag), divides that flux by
the projected length of the segment(s) and the defined temperature difference, and displays a U-factor. A
single U-factor tag can be assigned to a group containing as many segments as you wish. You can create as
many tags or groups as you wish. A U-factor will be calculated for each unique tag name. U-factors can be
calculated for a group of boundary segments even if individual segments within the group were defined with
different boundary conditions.
It is common practice in the analysis of building components to define the U-factor on interior (room)
boundary surfaces. Interior and exterior surfaces are often separated by adiabatic boundaries. The U-factor
of adiabatic boundaries (those having no heat flow) will be zero, so there is no need to tag these surfaces. If
U-factors are desired for the exterior boundary surfaces, these surfaces should be tagged separately from
interior surfaces. THERM assumes that no heat is stored in the cross section, so all energy that enters the
cross section on the interior surface leaves through the exterior surface. If the full length of the interior and
exterior surfaces are given the same U-factor Tag, the resulting U-factor will be zero.
The choices for the U-factor Tag pull-down list are the values that come with THERM:




None: Use None for adiabatic boundary segments or any segment where a U-factor result is not
desired.
Frame: Use Frame for interior frame boundary segments and for glazing boundary segments that are
between the frame and the sight line.
Edge: Use Edge for all the glazing system boundary segments that are above the sight line.

You can make new values in the U-factor Names Library by clicking on the U-factor Surface Library button
on the Boundary Condition Type dialog box. Click on Add and type in a unique U-factor Surface Tag name,
and the program will add that name to the U-factor Names Library.
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THERM automaticallly creates a boundary
condition segment for the exterior glazing system,
and assigned a U-Factor Surface tag of "None".

In general, the U-Factor Surface tags for the exterior
frame should be assigned a U-Factor Surface tag of
"None".

THERM automaticallly
creates a boundary
condition segment for
the interior glazing
system 2.5" up from
the site line, and
assigns a U-Factor
Surface tag of "Edge".

THERM automatically
generates a boundary
condition segment for
the interior glazing
system between the
frame and the site
line, and assigns a UFactor Surface tag of
"Frame"

NOTE: U-Factor Surface tags should only be
assigned over one surface of the cross section,
either the interior or the exterior but not both.

Figure 6-6. Assigning U-Factor Surface tags to different boundary segments. THERM automatically makes two boundary segments
on the interior surface of the glazing system, one from the frame to the sight line (with a U-Factor Surface tag of "Frame") and one
from the sight line up to 2.5" of the glass (with a U-Factor Surface tag of "Edge").
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6.3. Error Detection in THERM
Defining the boundary conditions invokes several features in THERM which detect errors made during the
drawing process. The error detection features are intended to help you fix questionable (or “bad") points and
find small voids and overlaps in the geometry so that the automatic mesh generator can create a well formed
mesh. Other error detection features in THERM that identify invalid polygons and polygons which cause the
automatic mesh generator to fail are discussed in Section 7.3.
THERM's error-detection algorithms rely on the definition of two minimum allowable distances between two
adjacent points in a cross section:


Floating point tolerance: The distance between two points at which THERM will automatically merge
the points, set to 0.01 mm.



Checking tolerance: The distance between two points at which THERM will mark the points as bad, set
to 0.1 mm.

When checking for geometry errors, THERM does the following:


First, THERM checks the polygon edges because the mesher needs exactly matching points on any
polygons that are adjacent to each other. If a point exists on the edge of a polygon but not on the edge of
an adjacent polygon, and if the adjacent edge is less than the floating point tolerance (0.01 mm), THERM
automatically adds a point to the adjacent edge and merges the points so that there is an identically
placed point on both polygons. If the distance between the adjacent edges is greater than the floating
point tolerance, the program does nothing, and an unmatched edge is created resulting in either a void or
an overlapping region, as shown in Figure 6.7.



Next, THERM checks to see if any points are closer together than the checking tolerance (0.1 mm), and
marks such points with red circles, indicating they are "bad" points. It is important for you to check and
correct these marked areas before the simulation continues.
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In the case where the gap
is greater than the floating
tolerance of 0.01, THERM
does not move the edge or
create a matching point. In
this case, the unmatched
edges cause a void, and
are marked in red. Red
circles are also drawn at
the unmatched points, and
segment midpoints.

Polygon A has a point
that is not matched
on Polygon B.

Polygon B.

THERM automatically
moves the line in Polygon
A and adds a matching
point on Polygon B.

In the case where the gap
is less than the floating
tolerance of 0.01, THERM
adds a matching point to
Polygon B and merges it
with the point on Polygon
A.

Figure 6-7. The size of the void in a drawing will determine how THERM will handle the error checking.

6.3.1. Finding and Fixing Bad Points
As discussed above, THERM marks points as bad if they are separated by a distance of less than the checking
tolerance (0.1 mm). If these points are mistakes or flaws in the model they should be fixed but in some cases
they may be intentional details that should be left alone. Because you may want to keep these points in the
model, THERM draws red circles around the points and displays a message, shown in Figure 6-8, which
gives you the option of having the program either mark the points so that you can evaluate them or
automatically adjust them:

Figure 6-8. This message may appear when you create the boundary condition


Mark the points but don’t adjust them: This is the default option and it is recommended that you choose this
option for your first attempt at assigning the boundary conditions. It allows you to check the circled
points and either correct the points manually or leave them in the model if you want to keep them.
Occasionally points exist on the edges of both adjacent polygons, but they are not exactly aligned. In this
case the program adds matching points to the edges of each polygon resulting in points on both polygons
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that are very close together (which may be detected as bad points). In this case, you need to delete one of
the points, remembering to delete the point on both polygons. This can be done by selecting one
polygon, holding down the shift key, selecting the other polygon and then using the Draw/Edit Points
menu choice to delete the point from both polygons in one step. If you do not delete the point on both
polygons THERM will automatically recreate it when you reassign the boundary conditions. Be careful
in choosing which point to delete that you select the one that will allow the geometry of the model to be
accurately represented.
If you choose to have the program mark the bad points, you may want to improve the clarity of the
display by turning off the material colors. Go to the View menu and uncheck the Material Colors choice.
Then you will see only the outlines of the polygons, and the circled points will become very obvious. You
can zoom in (click the right mouse button) on the circled area to see if you need to fix the points.
Sometimes there will be a red circle in an area that looks fine. If you select the vertices attached to that
point one at a time and move them a short distance (less than the sticky distance) from the point and
release the point, the vertices will snap to a common point and the problem point will be removed. If
your model only contains areas like this you can use the Automatically Adjust Points within Tolerance
options without negative consequences.
If there are fine details containing points less than 0.1 mm apart that you want to preserve in your model,
you can turn off the display of the red circles using the View/Bad Point command. However, even
though you can’t see the circles they are still there. If you want to remove the red circles, they can be
cleared using the Draw/Clear Bad Points command.

Polygon A with point on an edge
adjacent to Polygon B.

Polygon B with point on an edge
adjacent to Polygon A. The two
points are not exactly aligned.

< 0.1 mm

THERM automatically detects that the points on the
adjacent edge of Polygons A and B are not aligned, but
because they are farther apart than the floating point
tolerance (0.01 mm), they are not merged by THERM, but
instead matching points are added to both polygons.
Then THERM automatically checks for bad points based on
the checking tolerance of 0.1 mm. Because these points
are less that 0.1 mm apart, they are marked as bad points.

The circles at the boundaries of
the model represent intentional
small detail that should not be
changed

This is an instance where THERM created the bad points
during the geometry checking process.
THERM will be unable to adjust these points, so you will
have to fix them manually by deleting one of the two points,
making sure to delete it on both Polygons A and B.

Figure 6-9. An instance where THERM created bad points in the process of checking for matching points on adjacent polygons.
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Step 3: With your mouse cursor
over the circled area, zoom in
(click on the right mouse
button) to a scale that enables
you to see the problem points.
In this case, two adjacent
polygons have points within the
checking tolerance of 0.1 mm
of each other. Use the Edit
Point method to remove the
points that are causing the
problem. Remember to delete
the problem points on both
polygons.
Step 2: Uncheck
the Material
Colors choice in
the View menu to
see the circled
points more
clearly.

Step 1: THERM circles the
areas that have points
closer than the checking
tolerance of 0.1 mm.

Figure 6-10. To view the circled "bad" points more clearly, "uncheck" the Material Colors choice from the View menu.


Automatically adjust points within tolerance: When this option is chosen, THERM will automatically merge
any two points that are within the checking tolerance of 0.1 mm. In cross sections with fine detail the
automatic fix feature can make unwanted changes in your model. It is strongly recommended that you
save your work before using this feature. Once this option is selected it cannot be undone with the undo
command.
Sometimes when using the automatic adjust option you will get a message saying that THERM cannot fix
all the bad points, as shown in Figure 6-11. The unfixed points will be marked and you must fix them
before the simulation continues.

Figure 6-11. This message may appear if you select the automatic adjustment option and THERM cannot correct the problem.

The existence of bad points does not keep THERM from assigning the initial boundary conditions. When you
are adjusting the model to correct bad points, if you do not make changes to the segments that make up the
boundary, the boundary conditions will not be deleted and you can continue with the simulation process
without reassigning the boundary. This is the recommended way to proceed as it ensures that you have
correctly fixed all problems in the model. It is recommended, however, that you do recreate the boundary
conditions to ensure that you have correctly fixed all problems in the model. If you do recreate the boundary
conditions make sure to delete the existing red lines and circles using the Draw/Clear Bad Points menu
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option. THERM will remember the boundary condition assignments so you will not need to redefine the
boundary segments.
6.3.2. Finding Voids and Overlaps
Defining the boundary conditions also causes THERM to check the model for small voids and overlaps that
are caused by unmatched polygon edges as discussed in Section 6.3, "Error Detection in THERM." (Large
voids and overlaps can be detected using the View/Voids and Overlaps featured discussed in Chapter 5). An
unmatched edge is an edge on a polygon that does not have a matching edge on an adjacent polygon, which
indicates that there is either a void or an overlap in that area. THERM marks small voids and overlaps by
drawing the unmatched edge in red with a circle at its midpoint and displaying the warning message as
shown in Figure 6-12. These areas must be fixed before the simulation process can continue.

Figure 6-12. THERM issues a warning if it detects voids or overlapping regions when trying to define boundary conditions.

Zoom in (click on your right
mouse button) to see that
THERM has detected a
void.

Zoom in (click on your right
mouse button) to see that
THERM has detected an
overlapping region.

Figure 6-13. Voids and overlaps are indicated by circles once the boundary conditions have been assigned.

6.4. Defining New Boundary Conditions
THERM includes a Boundary Conditions Library with a set of predefined boundary conditions that are
protected from editing (the input values are disabled). If you do not find the boundary condition you need in
the Boundary Condition pull-down list, you can add it to the Boundary Condition Library using the
following technique.
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1.

Open the Boundary Condition Library by selecting the Library/Boundary Condition Library menu
choice; the Boundary Conditions dialog box will be displayed. The predefined boundary conditions
cannot be edited, but you can use the pull-down list at the top to view the characteristics of any of the
entries.

Figure 6-14. The default Boundary Condition Library that comes with THERM has boundary condition definitions that cannot be
edited.

2.

To make a new boundary condition, click on the New button.

3.

You will be asked for the name of the new boundary condition. Type a name that is not already in the
library and click on the OK button.

Figure 6-15. Type a unique name for the new boundary condition.

4.

Click on the Color button to change the color from the default value of blue.

5.

Now you are presented with the same Boundary Conditions dialog box, but all the fields are available
for you to edit, so you can create your custom boundary condition. Different fields are available for
editing depending on the Boundary Condition Model that is chosen, i.e., simplified, comprehensive, or
radiation enclosure surface. These different types are discussed in detail in the following sections. Fill
out the input values as appropriate.

6.

When you have defined the characteristics of the boundary condition, click on the Save Lib button; the
boundary condition will be saved permanently to the default library (named bc.lib). If you forget to save,
THERM will ask if you want to save when you exit the program (unless you turn this feature off using
Options/Preferences/Prompt for saving libraries on program exit).
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Figure 6-16. To define a new boundary condition, click on the New button, and the Boundary Conditions dialog box will appear,
allowing you to define the characteristics of the new boundary condition.

In the Boundary Conditions dialog box, you can set the Model pull-down list to Comprehensive, and the
input values that will be available are the following:
Convection

Constant
Heat Flux

Define the convection values for:


Temperature -- surrounding temperatures for convective heat transfer
Units: oF (IP); oC (SI)



Film coefficient -- film coefficients to use for convective heat transfer
2 o
2 o
Units: Btu/h-ft - F (IP); W/m - C (SI)

Used to model a constant heat flux on the surface, such as solar gain


Radiation

Constant
Temperature

Used to define the radiation component of the model


Enclosure Model: use this if you are defining boundary conditions for the crosssection elements that "see" the external radiation enclosure.



Black-Body Radiation: use this if you want to model radiation exchange with a black
body as an alternative to drawing a radiation enclosure. For this case you have to
define the values for view factor and temperature (Ti).

Used to define the temperature at the surface being specified


6-14

Flux -- constant flux value
2
2
Units: Btu/h-ft (IP); W/m (SI)

o

o

Temperature: Units: F (IP); C (SI)
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Figure 6-17. Sample boundary condition library entry for a comprehensive model

6.5. Special Boundary Condition Cases
There are two special boundary condition cases in THERM, for the following conditions:
•

Detailed frame cavity radiation model

•

External Radiation Enclosure

6.5.1. Frame Cavities with Detailed Radiation Model
If you used a detailed radiation model within a frame cavity, then, when you create the boundary conditions
for that cavity, THERM will automatically highlight the cavity surfaces in red and label them Frame Cavity
Surface (shown in the following figure).
Sometimes frame cavities are broken up into multiple cavities to better model convection heat transfer. If this
is done with a detailed frame cavity model THERM treats the sub-cavities individually for convection
purposes but merges them for radiation purposes. The red boundary will show this.
If you change the cavity to another type of material after the boundary conditions are drawn, you must
redefine the boundary conditions.
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Frame Cavity Surface
boundary conditions are
automatically generated for
a frame cavity with a
material defined with a
"Detailed" cavity model.

Double-click on the Frame Cavity Surface
boundary condition to see the Emissivity
and Blocking Surface properties.

Figure 6-18. When the frame cavity is assigned a material with a Detailed cavity model, THERM automatically assigns boundary
conditions to the cavity.

To see the Frame Cavity Surface properties, double-click on one of the red segments; a dialog box will appear
with the following values:
Emissivity

This value is the emissivity of the frame cavity surface, automatically determined by
THERM based on the emissivity of the surrounding materials as defined in the Material
Library. You can override the definition by changing the value in this input box. If the
emissivity value is changed in the Material Library after the boundary conditions are
drawn, the change will not take effect until the boundary conditions are redrawn (by
clicking on the Boundary Conditions toolbar button or pressing F10.)

Blocking Surface

This check box indicates whether the surface that you are defining should be checked
automatically by the program to determine if it blocks radiation. A radiation blocking
surface is a surface that interferes with the radiation that would otherwise travel
between surfaces, as shown in the following figure. Checking this box does not
automatically make it a blocking surface, it just tells THERM to determine whether or
not the surface is blocking. If the box is not checked, the program will not make this
determination. Default: Checked, which means that all surfaces will be checked by
THERM to see if they are blocking. This default is recommended because it guarantees
that the radiation is modeled correctly. However, for simple rectangular surfaces, there
is no need to check for blocking surfaces.
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Radiation nonblocking
surfaces

Radiation-blocking
surfaces.

Figure 6-19. An example of radiation-blocking surfaces

6.5.2. External Radiation Enclosures
If you assign a radiation enclosure material to a polygon, then, when you create the polygon’s boundary
conditions, THERM will automatically assign boundary conditions named Radiation Surface (shown in the
following figure).
To see the Radiation Surface properties, double-click on one of the boundary conditions; a dialog box will
appear showing the emissivity and temperature, as well as a checkbox indicating whether the surface is
blocking radiation.

Radiation Surface
boundary conditions are
automatically generated
for a polygon defined with
a material type of
External Radiation
Enclosure.

Double-click on a
Radiation Surface
boundary condition to
see the properties of that
boundary condition.

Figure 6-20. THERM automatically assigns Radiation Surface boundary conditions to the external radiation enclosure surfaces.
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In order for the program to model an external radiation enclosure, it may be necessary to change the
boundary conditions of the cross section elements that "see" the enclosure, in this case the interior frame and
glazing assembly elements.
Changing these boundary conditions requires you to first create custom Boundary Condition Library records
(see Section 6.4, "Defining New Boundary Conditions") that have the following definitions, as shown in
Figure 6-21:
Model

Set to Comprehensive.

Convection

Define the appropriate temperatures and film coefficients for each element type. Make
sure that the film coefficient only accounts for convection and does not contain a
radiation component. (The film coefficients in the simplified boundary condition are a
combination of convective and radiative effects.)

Radiation

Set to Enclosure Model.

Define custom boundary
conditions for the crosssection elements that
"see" the external
radiation enclosure.

Figure 6-21. Define new boundary conditions for the elements that "see" the radiation enclosure with the Comprehensive model.

When you have defined the new boundary condition in the library, you need to assign it to the appropriate
boundaries, as shown in Figure 6-22.
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Select the boundary segments
that "see" the radiation
enclosure. Press Enter and the
Boundary Condition Type
dialog box appears. Choose
the new boundary condition
entry created for them, in this
case named Indoor
Comprehensive. Also check
the Blocking Surface box.

Figure 6-22. Set the boundary conditions for the surfaces that "see" the radiation enclosure.
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7.1. Overview of THERM Calculation Methods
THERM is a two-dimensional (2D) finite-element heat-transfer analysis tool. Many excellent reference books
(8,9)
(10)
describe the finite element method in detail . THERM’s steady-state conduction algorithm, CONRAD , is a
(6,7)
derivative of the public-domain computer program TOPAZ2D . THERM’s radiation view-factor algorithm,
(12)
VIEWER, is a derivative of the public-domain computer program FACET . THERM contains an automatic
(5)
mesh generator that uses the Finite Quadtree algorithm. THERM checks solutions for convergence and
automatically adapts the mesh as required using an error-estimation algorithm based on the work of
(18,19)
Zienkiewicz and Zhu .
THERM’s calculation routines evaluate conduction and radiation from first principles. Convective heat
(11,17)
transfer is approximated through the use of film coefficients obtained from engineering references .
See Appendix C, "Theoretical Background" for more information about the calculation methods in THERM.

7.2. Calculations
When you have finished drawing a cross section, specifying its materials, and defining boundary conditions,
you are ready to calculate the cross section’s thermal performance.
7.2.1. Calculation Menu
The Calculation menu choices are shown in the figure below. If the results are not current, the Display
Options and Stop Current Calculation menu choices will be inactive (grayed out) until you calculate current
results.

Figure 7-1. The Calculation menu choices

Calculation (F9)

Display Options
(Shift-F9)

THERM 2.0

Use this menu choice or the F9 keyboard short cut to start the calculation for a
currently active THERM file. This is equivalent to pressing the Calculation
toolbar button.
Use this choice or the Shift-F9 keyboard short cut to access the Results Display Options
dialog box. The default setting is to display isotherms when a calculation is finished. The
results will display with the last choice selected. If the Display Options menu choice is
inactive (gray), the results are not current, so you need to calculate them before you can
access this choice.
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Figure 7-2. The Results Display Options dialog box

Show U-factors
(Ctrl-F9)

Calc Manager

Use this choice or the Ctrl-F9 keyboard short cut to display the U-Factors results dialog
box. See Section 7.4.1, "U-factors" for more information about the U-Factors results
display.
Use this choice to run a list of THERM files in batch mode. The program runs the files
one at a time, starting from the file at the top of the list. Selecting the Calc Manager
menu choice opens the Calculation Manager dialog box, shown in the figure below:

Figure 7-3. Selecting the Calculation/Calc Manager menu choice opens the Calculation Manager dialog box
which shows a list of THERM files that can be run.

The Calculation Manager buttons are as follows:
 Close: The Close button closes the Calculation Manager dialog box. Even if this box
is closed, the THERM files in the queue will still run.
 Add: The Add button is used to add another THERM file to the end of the list of
files to run. Pressing Add opens a browse window which allows you to select files
from anywhere on your computer or network. You can select multiple files using
your mouse with either the Shift key (to select multiple contiguous files) or the Ctrl
key (to select multiple noncontiguous files), in standard Microsoft Windows™ style.
 Remove: The Remove button deletes a file from the list. Highlight a file in the list by
clicking on it once with your mouse; then, press Remove. The file will be deleted
from the list.
 Start or Pause: The Start or Pause button toggles between starting and pausing files.
If the button says Start, clicking on it causes the program to start running the files in
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the list, beginning with the first file. If the button says Pause, clicking on the button
causes the program to pause running all of the files in the list. You can click on the
button when it says Pause (which changes the button to say Start) and then you can
click the Add button to select additional files to be run. When you are ready for the
files to begin running, click on the Start button.
Interrupt: The Interrupt button causes the currently running THERM file to be
stopped after the program finishes the current calculation step (such as Reading
Geometry or Generating Input.)
Log: The Log button displays a list of the files that have been run as well as any
error messages generated during the calculation. This log can be cleared manually
using the Clear Log button on the Calculation Log dialog box, and it is
automatically cleared when you close the THERM program.

Figure 7-4. Calculation Log accessed from Calc/Calc Manager.

Background Calc

Selecting the Background Calc menu choice causes the program to run the simulation in
the background, allowing you to do other work in THERM while a model is being
calculated. When Background Calc is on, the program displays the file name and the
current calculation status (such as "Generating Input" or "Simulating") in the THERM
status bar (see Chapter 4 for the location of the status bar). If Background Calc is
selected, a check mark will display to the left of the menu choice, and the feature will
remain on until it is unchecked. If this option is not turned on, an hourglass will be
displayed while the program runs a THERM file, and you will not be able to do any
other work until the calculation is finished.

Add to queue

Selecting the Add to queue menu choice causes the currently active THERM file to be
added to the Calc Manager list.

Stop Current
Calculation

Selecting the Stop Current Calculation menu choice causes the currently active and
running THERM file to be cancelled. THERM will finish the current calculation step,
such as "Reading Geometry" or "Generating Input", before stopping.

7.2.2. Calculating Results for a THERM file
To start calculating a THERM file, do the following:
1.

Set the appropriate Options/Therm File Options and Options/Preferences, Simulation settings (see
7.2.3, "Calculation Options" for a description of these values).
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2.

Turn on Background Calc from the Calculation menu. When it is on, a check mark will appear to the
left of the Calculation/Background Calc menu choice.

3.

Press the Calculation toolbar button,
start the calculation.

4.

The program will show the calculation steps being performed (because Background Calc is turned
on). Depending on the complexity of the cross section and the fineness of the mesh as well as the CPU
speed and amount of memory of your computer, calculation steps can take several seconds to a few
minutes.

use the Calculation/Calculation menu item, or press F9 to

Click on Background Calc (a check
appears to the left of the menu choice
indicating that it is "on") so you can
work on other THERM files.

The status of the calculation is
displayed when Background
Calc is checked. The
calculation steps are:






Premeshing
Reading Geometry
Meshing
Generating Input
Simulating

Figure 7-5. THERM displays the steps in the calculation when the Calculation/Background Calc menu option is on.

7.2.3. Calculation Options
There are several calculation options which may be changed. In most cases, the default values for these
options will be appropriate.
One category of calculation options is accessed from the Options/Therm File Options menu, which opens a
dialog box with the following settings:
Quad Tree Mesh
Parameter

7-4

The mesh parameter determines the maximum element size in the mesh. The larger the
mesh parameter, the smaller the maximum size. When modeling cross sections with
very fine detail, you may need to increase this setting. Increasing the mesh parameter
also increases the number of elements and, as a result, increases the time required to
generate the mesh. Lower numbers produce coarser mesh, higher numbers produce a
finer mesh. (Note: The mesh parameter is based on geometry, and if a fine detail in the cross
section is not being meshed to the level you think is necessary, and increasing the mesh parameter
doesn’t change this, you should check the Run Error Estimator check box and the mesh will be
refined in this region if it is necessary.) Default: 6.
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Run Error
Estimator

The Run Error Estimator check box governs whether THERM runs its error estimator.
The purpose of the error estimator is to locate regions of potential error, so the mesh can
be refined there to increase the accuracy of the program’s calculation. The error
estimator calculates a percent error energy norm. The percent error energy norm is a
function of the heat flux integrated over the area of the element. If the percent error
energy norm is high, the program refines the mesh so that the regions of high heat flux
are integrated over smaller elements. This can be mathematically proven to result in a
(18,19)
converged solution . The default value for this percentage is 100%, which means
THERM will not refine any areas of the mesh even when the error estimator runs. You
can change the default value, but this is not necessary in all cases. The value of the
percent error energy norm for your simulation will be displayed under
Calculation/Show U-factor.
The following approach is suggested if you want to use the error estimator to have
confidence that your solution is converged. First, simulate your cross section using the
default setting for the error estimator. Check the percent error energy norm results,
which appear under Show U-factors in the U-Factor dialog box, which is accessed by
the Calculation/Show U-factors command under the Calculation menu. If the value is
less than 10%, you can assume that your solution is converged. If the percent error
energy norm is larger than 10%, check the values of the particular results (e.g., U-factor,
local temperatures, etc.) that are of interest to you. Then rerun your problem by
entering a value for the percent error energy norm that is smaller than the one currently
reported in the U-factor dialog box. (Entering a target value for the percent error energy
norm that is a factor of two smaller than the current reported value is reasonable way to
proceed, or you can set the value between 5 and 10 %.) THERM will iterate until the
percent error energy norm of every element in the cross section is less than the target
value or until the specified maximum number of iterations is reached. Verify the change
in percent error energy norm and recheck the results of interest (e.g. U-factors, etc.) for
your cross section. If the results of interest have changed significantly, you may wish to
rerun the calculation after decreasing the percent error energy norm until no significant
change in results is observed. This strategy will allow you to achieve the desired level of
accuracy required for your solution.
Note: The larger the mesh parameter and the smaller the percent error energy norm, the
more elements will be included in your mesh and the longer your calculation time will
be. A fine initial mesh will have a lower maximum percent error energy norm than a
coarse mesh. A fine mesh may reach a converged solution with one run whereas a
coarse mesh may take many iterations to reach the same level of convergence. You can
attempt to achieve a percent error energy norm of less than 5%, but this may result in
over-refinement of the mesh and accumulated round-off error, which will have an
adverse effect on the accuracy of the solution.
Default: checked.

Maximum % Error
Energy Norm
If the Run Error Estimator box is checked, the Maximum % Error Energy Norm value
determines the percent error energy norm allowed. THERM will rerun the simulation
until this value is reached. See Run Error Estimator above regarding when to change
this value. Default: 100%
Maximum
Iterations

THERM 2.0

This box specifies the maximum number of times the program will modify the mesh and
resimulate if the Run Error Estimator box is checked. THERM will stop simulating and
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display a warning message when this value is exceeded even if the target value for the
percent error energy norm has not been reached. The last set of results will be displayed.
Default: 3.
Use CI Model for
Window4 Glazing
Systems
A check box indicates that you want to use the Condensation Index Model when
WINDOW4 glazing systems are imported. Default: unchecked

Figure 7-6. THERM File Options affect how THERM calculates results.

Another category of calculation options is accessed from the Options/Preferences menu, Simulation tab,
which opens a dialog box with the following settings:
Convergence
Tolerance

Relaxation
Parameter

View-Factor
Smoothing
Save Simulation
Results in THM
Files

7-6

This feature is used when the detailed radiation model is chosen. This is an iterative
model that calculates the nonlinear temperature relation that develops in combined
conduction and radiation simulations. The convergence tolerance is the allowable
maximum average temperature difference between two successive iterations. Default:
0.0001
The relaxation parameter is also related to convergence in problems containing the
detailed radiation model. A relaxation parameter of less than one may help a problem
to converge. Default: 1
View-factor smoothing is the least square fit of view factors, which often provides
betters results for view factors. Default: checked

This check box determines how the results are saved. You can save results with the
THERM file, which creates a large file containing all of the mesh, temperature, and Ufactor results for a cross section. If this box is not checked, the files are much smaller
(1K) and only contains the U-factor results; you will be able to view the geometry of the
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cross section, the U-factors, and the report but not the mesh or temperature results. In
this case, the results are current but not available and the Calc/Display Options menu
choice will be inactive (grayed out). Default: checked
Save CONRAD
Results file (.O)

Save simulation
Intermediate files

This option saves the CONRAD results files, that are named with the THERM file name
with an extension of .O. This is an ASCII file that contains all the information about the
model geometry, mesh, temperature and heat flux results. Default: unchecked
This option is useful in determining why a simulation has failed. Intermediate files are
saved in the SIM subdirectory of the THERM directory, and quickly use up disk space.
This is primarily a research feature. Default: unchecked

Figure 7-7. The Simulation preferences accessed from the Options/Preferences menu

7.3. Feedback and Troubleshooting During the Calculation Process
During the calculation process, the feedback bar will identify which stage of the automated calculation
procedure THERM is working on. The stages of the calculation procedure are:


Premeshing



Reading Geometry



Meshing



Generating Input



Simulating



View Factors (optional)



Simulating (optional)

THERM 2.0
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Error Estimator (optional)

This section briefly describes each stage. Also discussed are the possible errors which may occur at each
stage and suggestions on what to do if they occur.
7.3.1. Premeshing
In this stage, the geometry is being prepared for meshing. THERM checks each polygon to make sure that
there are no problems that the mesher cannot handle. If there is a problem with a polygon, you will get a
message saying “Invalid Polygon found, Stopping Simulation,” followed by the polygon ID number. You can
find this polygon by going to the Edit/Special Select menu choice and typing in the polygon ID number in
the ID= field. THERM will then select the problem polygon.
The most common cause for invalid polygons is zero area extensions, shown in Figure 7-8. THERM may
create zero area extensions in two ways.
(1) When very fine details are collapsed. This often happens with acute angles where one of the end points is
less than 0.01 mm away from a line. If this is the case, another point will be added to the line when the
boundary conditions are assigned and the two points will then be merged. The acute angle will be turned
into a zero area extension and with the two points lying on top of one another.
(2) When the Automatically adjust points within tolerance option is chosen during the generation of
boundary conditions. In this case, points within the checking tolerance (a distance of 0.1 mm) are merged
automatically by the program and the possibility of creating an invalid polygon is very high. This is why
it is recommended that you do not automatically adjust bad points without first inspecting them.

The selected
polygon has a zero
area extrusion.

Figure 7-8. An example of a zero area extrusion which will result in an error message of "Invalid Polygon found, Stopping
Simulation".

In order to correct these kinds of invalid polygons you need to delete the tip of the extension, any additional
points that lie on it, and one of the two points that are lying on top of each other. Often it is easier to delete
the polygon and recreate it using the void fill feature.
During the meshing stage, THERM also checks to see if U-factor surface tags have been assigned. The
program was developed in large part for users interested in calculating U-factors so you will be warned if
you have not selected any U-factor surface tags. (See Section 6.2.4, "Define U-factor Surface Tags" for more
information). If none were selected intentionally, click on the OK button and the calculation will continue.
This question is not asked if the models are simulated using the Calc/Calculation Manager menu option.
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7.3.2. Reading Geometry
During this stage, the mesher is reading the input data and storing it in a database for the mesher to read.
This should be a relatively short step, although occasionally a model will cause the program to hang during
this step. If this step takes longer than five minutes you should close THERM using the Microsoft Windows™
Task Manager, restart the program and try to rerun the model. If you are running the program with the
calculation in the background, and you forgot to save the model before calculating, you will be able to save
the model before shutting down the program.
7.3.3. Meshing
In this stage, the mesh is being generated. This is the most time consuming portion of the simulation process.
Occasionally, when modeling building components with multiple cross sections such as greenhouse
windows, or single cross sections with very fine detail, the mesh generator will have a problem creating a
mesh. In this case you will get a message saying “Mesh Generation Error”.
If you get this error message, try simplifying the geometry near the identified point (the x and y coordinates
are given in the error message) or try increasing the Quad Tree Mesh Parameter value in the
Options/THERM File Options menu choice. (See Section 7.2.3, "Calculation Options" for more information
on the Quad Tree Mesh Parameter.) The point indicated by this error will be circled in red for easy location.
If the point is on the inside of a polygon, you will know which polygon is causing the problem. If the point is
on an edge shared by one or more polygons, any one of these polygons could be causing the problem. If this
is the case, the problem was probably caused by too many points too close together, leading to an over
detailed mesh in these areas. The most common cause for this mistake is the over specification of curves (see
section 5.4.1, "Suggestions for Drawing Cross Sections" for more information on modeling curves). It is likely
that the problem with the geometry is near the circled area but the mesh generator could be failing at that
point due to excessive detail somewhere else in the polygon. The polygon needs to be examined as a whole.
Make all possible simplifications to the polygon that do not compromise the accuracy of the simulation.
Usually very small modifications are all that is required.
If upon looking at the polygon there are no details you can change without compromising the model, try
rerunning the model with the Quad Tree Mesh Parameter (in the Options/THERM File Options menu
choice) set to a high value. This process may have to be repeated several times before the mesh can be
generated. In rare cases, the mesher has problems meshing a model because of previous problems with
another model. An easy way to determine if this is happening is to try to simulate a simple square and see if
the mesher fails. If it fails, save your model, exit the program, restart the program and try rerunning the
model. This often provides the necessary clearing of registers so the program can create a mesh.
7.3.4. Generating Input
This stage indicates that the mesher is creating the input file for the CONRAD module. This stage is fast and
rarely produces an error.
7.3.5. Simulating
The finite element calculation takes place during this stage. This stage is fast and rarely produces errors. If
your model does generate an error in this step please contact us.
7.3.6. View Factors (optional)
This stage indicates that the detailed radiation algorithm, VIEWER, is running.
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7.3.7. Simulating (optional)
This stage will reappear if you are running the detailed radiation model. You may get an error message
saying the problem is not converging. In this case, you can increase the convergence criterion found under the
Simulation tab of the Options/Preferences menu choice. This criterion is a measure of the change in
temperature between iterations. The maximum value for the convergence that will yield reasonable accuracy
is 0.01. Do not modify this value unless you have to.
7.3.8. Preparing Input (optional)
You will see this stage if you are running a model that uses the detailed radiation model, such as a detailed
radiation frame cavity, an external radiation enclosure, or the Condensation Index Model. This stage creates
an input file for the VIEWER program.
7.3.9. Error Estimator (optional)
The error estimator is run during this stage. If the results from this analysis indicate that the mesh needs to be
refined, the mesh will also be adapted during this stage. Then the steps of simulating and calculating view
factors will be repeated until the solution meets the convergence criterion. The following warning message
may appear: “The maximum number of meshing iterations reached before the error target was reached.” If
this happens, the last set of results will be displayed. If these results are not acceptable, you will have to
increase the Maximum Iterations value in the Options/THERM File Options menu choice. You may also try
performing the initial simulation at a higher value of the Quad Tree Mesh Parameter.

7.4. Viewing the results
When the program has finished the simulation (the calculation steps in the status bar or the hourglass have
disappeared), you can view the results. There are several different types of results displays:


U-Factors



Finite-Element Mesh



Isotherms



Flux Vectors



Color Infrared



Color Flux Magnitude



Report

Select the Calculation/Display Options menu choice to open the Results Display Options dialog box, shown
in the figure below, which controls how the results are displayed.
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Figure 7-9. The Results Display Options dialog box allows you to choose the results that are displayed.

The following choices are available in the Results Display Options dialog box:
Draw Results

This box must be checked in order for the graphic results to be drawn. Default:
checked.

Show

The Show section has the following choices, only one of which can be active at a time.
The setting will determine what graphic results are drawn by the program when you
click the OK button, as long as the Draw Results option is checked. These choices are
discussed in detail later in Section 7.4.5, "Graphic Results."


Finite Element Mesh



Isotherms



Flux Vectors
Color Infrared: Drawing these results may take several minutes. You can press the
Esc key if you want to cancel the drawing of these results.







Show Min/Max
temperatures

Pixel resolution: this value controls how finely the color infrared is drawn. If
you choose one pixel, THERM draws the image one pixel at a time, which can
be slow but gives the smoothest image. If you choose a higher number, the
program draws in blocks of pixels; the number you have chosen determines
how many pixels make up the sides of the block. The image is drawn faster
than using the one-pixel setting but does not appear as smooth.

Color Flux Magnitude: Drawing these results may take several minutes. You can
press the Esc key if you want to cancel the drawing of these results.

Check this box in order to display the minimum and maximum temperatures in the
simulation. This is discussed in more detail in the Min/Max Temperature section.

Show Element Ids Check this box to see the numerical ID values that have been assigned to each mesh
element. This is primarily a research feature. Default: unchecked.
Show Node Ids

Check this box to see the numerical ID values that have been assigned to each mesh
node. This is primarily a research feature. Default: unchecked.

Set Screen Font

Click this button to access a Font dialog box where you can select a font for the THERM
graphic display from the list of fonts that are installed on your computer. This option
can be useful if, for example, the labels of the isotherms do not display well on your
monitor; changing the font may make them more readable.

7.4.1. U-factors
The U-factor results for the cross section are accessed by selecting the Calculation/Show U-factors menu or
using the Ctrl-F9 keyboard short cut.
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Figure 7-10. Select the Calculation/Show U-factors menu to see the U-Factor results.

The U-factors dialog box will appear, listing the results for the cross section. You can choose whether the Ufactor is based on total surface, projected x dimension, or projected y dimension. The temperature difference,
delta T, and the length used in the U-factor calculations are also displayed in this box. If the Percent Error
Energy Norm value is N/A, this indicates that the simulation was run with the error estimator turned off. (See
Section 7.2.3, "Calculation Options" for more information on the error estimator). If the error estimator was
turned on for the simulation, the value of the Percent Error Energy Norm would appear in this box. Values
between 5-10% are indications of a well converged solution. (Note that "convergence" means that further
refinement of the mesh will not increase the accuracy of THERM’s solution, as discussed in Section 7.2.3, "Calculation
Options".) When more than two U-factors are defined in a model, the additional labels and results appear in a
pull-down list.

Figure 7-11. The U-factor results dialog box
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Figure 7-12 illustrates the definition of Projected X and Projected Y.

Projected Y

Projected X

Figure 7-12. Projected X and Projected Y

To export the U-factor results to a text file, press the Export button, and a Save dialog box opens, allowing
you to save the file using any file name and directory. A "txt" extension is automatically added to the file
name. It is then possible to open the exported results file with any text editor (such as Notepad) or to import
it into a spreadsheet.

Step 1: To export the U-factor results
to a text file, click on the Export
button. The Save As dialog box is
displayed.

Step 3: The U-factor results are now in
a text file, which can be opened with
any text editor, such as Notepad.

Step 2: Type the
results file name
and press Save.

Figure 7-13. You can export the U-factor results to a text file using the Export button on the U-factors dialog box.

THERM 2.0

JUNE 1998

7-13

7. CALCULATING RESULTS

7.4.2. Min/Max Temperature
The maximum and minimum temperatures calculated for the cross section are displayed if the Show
Min/Max temperatures box is checked in the Calculation/Display Options dialog box. When this choice is
checked, the location of the temperatures is indicated by a blue "X" for the minimum and a red "X" for the
maximum; a small dialog box appears, listing the temperature values and their x,y coordinates.

Figure 7-14. Check the Show Min/Max temperatures box in Results Display Options dialog box.

When Show Min/Max temperatures is checked in the Display
Options dialog box, the Min and Max Temperatures dialog box
appears.

The location of the temperatures is
indicated by a blue check for the
minimum and a red check for the
maximum.

Figure 7-15. Display of minimum and maximum temperatures

7.4.3. Temperature at Cursor
When the calculations have been completed, you can view the temperature at any cursor location using the
following technique:


From the View menu, click the left mouse button on the Temperature at Cursor choice. When this option
is active, a check mark will appear to the left of the choice. Clicking this choice will toggle it between
active and inactive.
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A small Temperature dialog box will appear in the drawing area, and it will display the temperature
value of the nearest mesh node point at any cursor location, with no interpolation. It may be helpful to
use this feature with the Finite Element mesh displayed. The temperature is updated every time the
cursor is moved. The value will be N/A for any cursor position outside the cross section.

Step 2: A small Temperature
dialog box will appear,
displaying the temperature at
the current cursor location.

Step 1: From the View menu, click
the left mouse button on the
Temperature at Cursor choice
(when this choice is active, a
checkmark will appear to the left of

Figure 7-16. Display of the temperature at the cursor location


If you want to know the temperature at a specific location in the cross section, you can add that point to
the appropriate polygon (see Section 5.6.6, "Adding a Point"), which will force the mesher to put a node
there. Then you can use the Temperature at Cursor feature to view the temperature at the point after you
have calculated the results.

7.4.4. Average Temperature with Tape Measure
After the calculation has been completed, you can obtain the average temperature along the line between two
points in the cross section using the Tape Measure Average Temperature feature of THERM.
The temperature of the sides of the equivalent rectangularized cavity are required inputs for the NFRC and
CEN method for calculating effective conductivity in frame cavities. Standard default values are provided for
these temperatures. You can use the average temperature feature after the model is run to check the
applicability of these default temperatures to the specific cross section.
To turn on this feature, select the Options/Preferences menu and the Drawing Options tab; check the Tape
Measure Average Temperature box.
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If the Tape Measure
Average Temperature is
checked, the program will
report the temperature with
the Tape Measure toolbar
button.

Figure 7-17. Turn on the Tape Measure Average Temperature feature from the Options/Preferences menu in order to display the
temperature at a specific point.

With this feature turned on, click on the Tape Measure toolbar button, click the left mouse button on the
starting point where you want to measure the average temperature, move the cursor to the ending point, click
the left mouse button again, and a dialog box will display the average temperature between the two points.
Note that the cross section results need to be calculated before the program can display these temperatures.
Based on this temperature, using the simplified frame cavity model, you can edit the Side 1 and Side 2
temperature values in the Properties for Selected Polygons dialog box and then recalculate the results of the
entire cross section.
Note: These temperatures are changed in each frame cavity separately. Access to the temperature input is
obtained by double-clicking on the frame cavity or by using the Libraries/Set Material menu choice or
pressing F4 after the polygon is selected.
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Step 1: Click on the
Tape Measure toolbar
button. The mouse
cursor will turn into a
tape measure.

Step 3: The Tape
Measure dialog box
shows the average
temperature.

Step 2: Click the left
mouse button on the
starting point, move the
mouse to the ending
point, and click the left
mouse button again.

Figure 7-18. Use the Tape Measure to determine the average temperature across a particular surface.

7.4.5. Graphic Results
The graphic results can be displayed by selecting the Calculation/Display Options menu, which accesses the
Results Display Options dialog box. The Show section offers different display options, only one of which
can be active at a time. Color Infrared and Color Flux Magnitude results may take several minutes to draw.
For a quick preview of the Color Infrared results, you can increase the value of the pixel resolution
parameter.

Figure 7-19. Graphic results display options
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7.4.6. Finite-Element Mesh
THERM automatically generates a finite-element mesh at the beginning of its calculations. The cross section is
broken into many discrete elements that are used to perform the finite-element calculation. Clicking on the
Finite Element Mesh choice on the Results Display Options dialog box (you must also have the Draw
Results box checked) causes the program to show the mesh used for the calculation. This reveals the areas in
the cross section where the program has divided the building component being modeled into a very fine
mesh (determined by the cross-section geometry and modified based on the percent error energy norm
criterion; see Section 7.2.3, "Calculation Options" for a discussion of the calculation settings for mesh
parameter and error estimator.)

Figure 7-20. Graphic results: Finite-element mesh
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7.4.7. Isotherms
When the heat-transfer analysis is complete, THERM can display the lines of isotherms through the cross
section. Isotherms are useful for seeing where there are extreme temperature gradients (isotherms very close
together) that may lead to thermal stress or structural problems. Isotherms are also useful for identifying hot
or cold areas in the cross section, in order to predict thermal degradation or condensation.

Figure 7-21. Graphic results: Isotherms
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7.4.8. Flux Vectors
The flux vector results indicate the amount and direction of heat flow through the cross section. There is one
flux vector for each mesh element (see the previous discussion in Section 7.4.6, "Finite Element Mesh" graphic
results). The length of the vector corresponds to the amount of heat going through the element, which is a
function of both the size of the element and the magnitude of the heat flux. These results can only be used for
quantitative comparison with a uniform mesh. The direction of the arrow indicates the direction of heat flow.
This representation of the data is most useful for determining the direction of heat flux.

Figure 7-22. Graphic results: Flux vectors
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7.4.9. Color Infrared
The color infrared results show temperature gradients in the cross section. Each temperature is represented
by a different color; the cooler colors (purples and blues) are low temperatures, and warmer colors (yellows
and reds) are higher temperatures.

Figure 7-23. Graphic results: color infrared
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7.4.10. Color Flux Magnitude
The color flux magnitude results represent the heat flux vectors, with the magnitude of the flux represented
by color; the cooler colors (purples and blues) are low flux and warmer colors (yellows and reds) are higher
flux. This display does not indicate the direction of the flux that is shown in the flux vector results.

Figure 7-24. Graphic results: Color flux magnitude
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7.4.11. Report
THERM generates a report each time a calculation is performed. This report contains a summary of the Ufactor result as well as a description of the elements in the cross section. A sample report is shown below.
From the File menu, select the Report choice to display the report for the currently active THERM file, shown
below. Click on the Print button to print the report; click on the Close button to close the report.

Figure 7-25. You can display the THERM report by selecting the File menu and Report menu choice.

The THERM File Properties dialog box, shown in Figure 7-26, is accessed using the File menu, Properties
choice. You can input information that may be helpful in managing THERM files. In addition, some of the
information in the report comes from this location. The following information can be entered into this dialog
box:
Filename

The name of the THERM file. This is feedback from the program and cannot be edited.

Directory

The full path name where the file is saved. This is feedback from the program and
cannot be edited.

Creation Date

The date the file was created. This is feedback from the program and cannot be edited.

Last Modified

The date the file was last changed. This is feedback from the program and cannot be
edited.

Title

In this field you can give the model a name which is more descriptive than the THERM
file name. For example, the serial number and product name could be included here.

Created by

In this field you can keep track of who created the model

Company

In this field you can indicate your company affiliation.

Client

In this field you can indicate who the work was for.
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Cross Section Type The information in this field will be included in the file that is exported to WINDOW,
indicating what type of window cross section you are modeling. The choices in this pulldown list are:
 Divider


Notes



Head
Jamb



Meeting Rail



Sill

In this field you can include any other information about the model.

Figure 7-26. The File menu, Properties choice allows you to input information about the THERM file for the report.
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Therm Version 2.00.04
Date: Thu Apr 30 14:08:23 1998
Created by:
Created for:
Therm Filename: D:\Thermdev\manual.thm
Cross Section Type:
Underlay Name: C:Files.dxf
U-factors
Name

Length Basis
U-factor
in.
Btu/h-ft2-F
-------------------- ------- ------------ -------Frame
3.22 Projected Y
0.0126
Edge
2.50 Projected Y
0.3784
Condensation Index
Edge Temp
Frame Temp
Solid Materials
Name
------------------------Polysulphide
Butyl Rubber
PVC/Vinyl (Rigid)
Wood (Pine, Spruce, Fir)
Vinyl (flexible)
Fiberglass (PE Resin)
Silicone

Conductivity
Btu/h-ft-F
------------0.11
0.14
0.10
0.08
0.07
0.17
0.21

Emissivity
---------0.90
0.90
0.90
0.90
0.90
0.90
0.90

Cavities
Name: Frame Cavity (NFRC Simplified)
Gas Fill: Air
Convection Model: NFRC
Radiation Model: Standard
Poly
ID

Heat
Flow
Dir
----- ----105 Horz
10 Horz
3 Horz
4 Horz
17 Horz
21 Horz
20 Horz
100 Horz
23 Horz
30 Horz
36 Horz
28 Horz
42 Horz
43 Horz
44 Horz
61 Horz
69 Horz
19 Horz
24 Horz
40 Horz
54 Horz

Side 1
Side 2
Dimension
Nu
Keff
Temp
Emis
Temp
Emis Horz. Vert.
#
F
F
in.
in.
Btu/h-ft-F
-------- ---- -------- ---- ------ ------ ------ -----44.60
0.90 24.80
0.90
0.15 0.04
1.00 0.0179
44.60
0.90 24.80
0.90
0.85 0.19
1.00 0.0342
44.60
0.90 24.80
0.90
1.50 1.25
4.23 0.1263
44.60
0.90 24.80
0.90
0.09 0.50
1.00 0.0186
44.60
0.90 24.80
0.90
0.03 0.03
1.00 0.0155
44.60
0.90 24.80
0.90
0.32 0.10
1.00 0.0241
44.60
0.90 24.80
0.90
0.17 0.14
1.00 0.0218
44.60
0.90 24.80
0.90
1.79 0.58
2.42 0.0893
44.60
0.90 24.80
0.90
0.12 0.22
1.00 0.0203
44.60
0.90 24.80
0.90
0.29 0.20
1.00 0.0264
44.60
0.90 24.80
0.90
0.39 0.04
1.00 0.0174
44.60
0.90 24.80
0.90
0.20 0.07
1.00 0.0206
44.60
0.90 24.80
0.90
0.23 0.38
1.00 0.0257
44.60
0.90 24.80
0.90
0.06 0.10
1.00 0.0171
44.60
0.90 24.80
0.90
0.22 0.29
1.00 0.0249
44.60
0.90 24.80
0.90
0.33 0.06
1.00 0.0204
44.60
0.90 24.80
0.90
1.53 0.67
3.49 0.1043
44.60
0.90 24.80
0.90
0.15 0.25
1.00 0.0215
44.60
0.90 24.80
0.90
0.08 0.08
1.00 0.0176
44.60
0.90 24.80
0.90
0.16 0.13
1.00 0.0213
44.60
0.90 24.80
0.90
0.30 0.42
1.00 0.0287

Glazing Systems
Name

COG U-factor Overall Thickness
Btu/h-ft2-F
in.
-------------------- ------------ ----------------Dbl,low-e, Ar
0.30
0.75

Cavity Height
in.
------------39.37

Standard Boundary Conditions
Name

Temperature Film Coefficient
F
Btu/h-ft2-F
-------------------- ------------ ----------------Exterior Surface
-0.00
5.112
Interior Wood/Vinyl
70.00
1.340
Dbl,low-e, Ar U-fact
70.00
1.353
Dbl,low-e, Ar U-fact
0.01
5.050
Calculation Specifications
-------------------------Mesh Parameter: 7
Estimated Error: Not Calculated

Figure 7-27. An example of a printed THERM report
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7.4.12. Export to WINDOW
THERM has a feature that allows you to export a THERM file to a WINDOW 4.1 file using the File/Export menu,
which accesses a dialog box where you can specify the name of the new file (it is given a t2w, i.e., THERM to
WINDOW extension) and the file format, which defaults to WINDOW 4.1. You can also specify a CSV or tab-delimited
format by scrolling the Format pull-down list.

Figure 7-28. Exporting a THERM file to a WINDOW file format

You can choose to automatically save to a WINDOW 4.1 file every time you save a THERM file; use
Options/Preferences and check the Automatic WINDOW 4 Export on Save box.
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8.1. Tutorial Organization
The tutorial section of this manual is organized as follows:
8.2.

Start THERM.

8.3.

Draw the frame cross-section geometry using different techniques:
8.3.1. by using THERM’s autoconvert DXF file feature,
8.3.2. by importing and tracing an underlay file,
8.3.3. by using a dimensioned drawing.

8.4.

Import a glazing system from WINDOW 4.

8.5.

Define the Boundary Conditions.

8.6.

Run and View the Results.
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8.2. Start THERM


From the Windows 95™ or Windows NT™ Start button, Programs choice, click on THERM to
activate the program.

Figure 8-1. Start THERM from the Start button on the Windows 95™ or Windows NT™ Taskbar.


THERM will open with a blank drawing area and no files loaded. By default, the program will
assign a name of Untitled-1 to the first drawing. When you save the cross section, you can
change the name of the file.

Figure 8-2. THERM starts with a blank drawing area and no files loaded.
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8.3. Draw the Frame Cross-Section Geometry
You can use three methods to input a cross-section geometry. Section 8.3.1 shows how to input a cross
section using the THERM underlay autoconvert feature, which automatically converts polygons from a DXF
file. Section 8.3.2 shows how the same DXF underlay file can be used to trace the polygons. Section 8.3.3
shows how the same profile can be input from a dimensioned drawing.
8.3.1. Import Underlay with Autoconvert On


From the File menu, select the Underlay menu choice.

Figure 8-3. To import an underlay, use the File menu, Underlay choice.


You will see the Underlay dialog box.

Figure 8-4. The Underlay dialog box is used to import a file to use as an underlay for a THERM cross section.


Click on the Browse button.



You will see a standard Windows™ Open dialog box, showing all files in your current working
directory with either a BMP or DXF file extension; you can change working directories and drives if
desired. You should see at least the following sample file that was installed with THERM:




SAMPLE.DXF

Highlight SAMPLE.DXF by placing your cursor over it and clicking the left mouse button.

THERM 2.0
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Figure 8-5. Select SAMPLE.DXF as the underlay file.


Click on the OK button, and you will return to the Underlay dialog box.



In the Underlay dialog box, click on the Autoconvert check box so it has a check mark, and click on
the OK button.

Click on AutoConvert, so a check
mark appears. This will cause
THERM to automatically convert the
polygons in the DXF file.

Figure 8-6. Click the Autoconvert check box when importing the underlay file.


If the DXF file is complex and takes a few seconds to import, a small DXF Import dialog box may
appear, showing a counter as THERM reads the DXF file.

Figure 8-7. The DXF Import dialog box may display the underlay import status,
depending on the complexity of the DXF file and the speed of your computer.


8-4

When THERM has finished autoconverting the underlay file, the cross section is displayed with
polygons defined for all the elements it could interpret. See Section 5.2, "Importing a DXF or
Bitmap File as an Underlay" for details about defining the DXF file so that THERM can
autoconvert the polygons properly.
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The DXF file will have been brought into the drawing area including all the white space in the
original drawing. THERM attempts to fill the drawing area with the autoconverted cross section
while still making the viewing scale as big as possible. In the figure below, you can see both the
THERM origin (corresponding to the origin of the DXF file) and the cross section.
Next draw the frame that the glazing sits in using the same method above, and after that,
draw the inside stop, as shown in Figure 8-20.Next draw the frame that the glazing sits in
using the same method above, and after that, draw the inside stop, as shown in Figure 8-20.
Locator (circle)
DXF file origin and
THERM origin
(crosshair)

Interior Stop
Exterior Stop
Frame

Figure 8-8. The components of the cross section

8.3.1.1. Save the File


Save your work using the Save File toolbar button
or the File/Save menu choice. Type a name
that is not already being used, such as Tutorial (a file named Sample.thm is included in the
installation, so pick a different name to avoid overwriting the sample file), and click on the OK
button. THERM will automatically add the THM extension, so the file name will appear as
TUTORIAL.THM.

8.3.1.2. Edit Cross Section


If you want to zoom in, place the mouse cursor in the area of the underlay that you want to be in the
center of the zoomed view and click the right mouse button. You only need to see the frame area of
the cross section, not the glazing area. If you zoom in too far, hold the Shift key down and click the
right mouse button to zoom back out. If you want to return to the original, centered view, hold down
the Ctrl key and click the right mouse button.



Because of the way this DXF file was defined, only the frame components of the underlay are
converted but not the glazing system. The glazing system will be imported from WINDOW in a
separate step later in the tutorial.

8.3.1.3. Assign Materials to Polygons


Select the polygon representing the frame by placing the mouse cursor inside the polygon and
clicking the left mouse button once. The vertices of the selected polygon will be displayed as squares.
Select Wood (Pine, Spruce, Fir) from the Materials pull-down list on the right-hand side of the
toolbar if the polygon is not already assigned that material. (See Section 5.10, "Assigning Materials
After Drawing Polygons" for more information about selecting materials).
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Figure 8-9. Select the polygon representing the frame and assign it the Wood (Pine, Spruce, Fir) material.


Select the polygons representing the interior and exterior stop (you can select both of them by
holding the Shift key down and clicking the left mouse button on each polygon), and select
Wood (Cedar or Redwood) from the Materials list, as shown in Figure 8-10.

Figure 8-10. Select multiple polygons by holding the Shift key down while clicking on multiple polygons.

8.3.1.4. Save Your Work


8-6

Save your work using the File/Save menu choice or the Save toolbar button
save your files often, because there is no autosave feature in THERM.
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8.3.2. Tracing a DXF Underlay
If you don’t want to use the DXF autoconvert feature, you can create the cross section polygons by tracing the
underlay. This may be necessary for some DXF files that have not been created in a way that autoconvert can
define the polygons properly.


From the File menu, select the Underlay menu choice.

Figure 8-11. To trace the DXF file, select the Underlay choice from the File menu.


You will see the Underlay dialog box.

Figure 8-12. The Underlay dialog box is used to select the DXF file to trace.


Click on the Browse button.



You will see a standard Windows™ Open dialog box, showing all files in your current working
directory with either a BMP or DXF file extension; you can change working directories and drives if
desired. You should see at least the following sample file that was installed with THERM:


THERM 2.0

SAMPLE.DXF

JUNE 1998

8-7

8. TUTORIAL

Figure 8-13. The Open dialog box shows all files with a DXF or BMP extension.


Highlight SAMPLE.DXF by placing your mouse cursor over it and clicking the left mouse button.



Click on the OK button, and you will return to the Underlay dialog box.



Do not change any of the default values in the Underlay box; click on the OK button.



You may see a small DXF Import dialog box, showing a counter as THERM reads the DXF file.

Figure 8-14. A DXF Import file may appear if the file is complex and takes a few seconds to import.


8-8

When THERM has finished reading the DXF file, it will display the underlay cross section in
gray, indicating that the lines are not true polygons but can be traced.
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Figure 8-15. The DXF file has been imported as an underlay, which can now be traced to make the individual polygons.


THERM attempts to fit the DXF cross section in the drawing area while still making the scale as big as
possible. In Figure 8-15, you can see both the THERM origin (cross hairs corresponding to the origin
of the DXF file) and the cross section.



Before you start tracing the underlay, you may need to zoom in on the cross section in order for the
cursor to snap to the correct underlay vertices. To zoom in, place your mouse cursor over the area of
the cross section that you want centered in the new zoomed view and click the right mouse button.
Each click of the right mouse button doubles the zoom percentage.



You can use the horizontal and vertical scroll bars on the drawing area to move the underlay to the
desired location in the drawing area. You only need to see the frame area of the cross section, not the
glazing system.

8.3.2.1. Draw the Cross-Section Components


Click on the Draw Polygon toolbar button
drawing.



Click on the Repeat Mode toolbar button
or use the Draw/Repeat Mode menu choice, so you
don’t have to press the Draw Polygon button each time you finish one polygon and start to draw the
next.

or use the Draw/Polygon menu choice to begin

Draw Polygon

Repeat Mode

Figure 8-16. Push the Draw Polygon and Repeat Mode toolbar buttons.
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Start with the exterior stop on the outside of the glazing system. Because you are in Draw Polygon
mode, the Materials pull-down list on the right side of the toolbar is active, and you can select the
Wood (Cedar or Redwood) material for the exterior stop. (Alternatively, you could access the
Libraries menu, select the Material Library or use the Shift-F4 keyboard shortcut, and pick Wood
(Cedar or Redwood) from the materials pull-down list). The material you select will be used by
THERM when you start drawing the first polygon.

Figure 8-17. Select the appropriate material from the Materials pull-down list (on the right side of the toolbar)
for the first polygon to be drawn.


With the material selected, you are ready to start drawing the polygon for the exterior stop. Place the
drawing cursor on the upper point of the stop nearest the glass and click the left mouse button. This
sets the starting point of the polygon, as shown in Figure 8-18.



Move the mouse to the left and down to the next point on the polygon, click the left mouse button,
and a line will appear between the two points, shown in Figure 8-18. Because you are tracing a DXF
file, THERM recognizes the vertices of the polygons;, therefore you don’t have to be exactly on a
point but only to be within “sticky” distance (defined as half of one side of the drawing cursor) of the
point.

8-10
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Step 2: Move the cursor
to the next point and click
the left mouse button. A
line will be drawn
between the two points.
THERM will snap to the
underlay vertices if the
cursor is within the sticky
distance of the point.

Step 1: Position the
cursor at the starting
point of the polygon
and click the left
mouse button to set
the point.

Drawing Cursor

Figure 8-18. Start drawing the first polygon.


Move the mouse to the next point in a counterclockwise direction (moving in a counterclockwise
direction is not required, but is recommended) and click the left mouse button when you have
reached the next point. Continue around the component until you only have one more line to draw.
To draw the last line and close the polygon, you can either press C (to close) or move the mouse to
the first point and click the left mouse button. Either of these actions will cause THERM to complete
the polygon, as shown in Figure 8-19, and fill it in with the color corresponding to the material
definition (or to a shade of gray on monochrome monitors).

Figure 8-19. The first polygon, representing the exterior stop, has been drawn.

THERM 2.0

JUNE 1998

8-11

8. TUTORIAL



By default, the Snap to Underlay setting is enabled, so the drawing cursor will snap to vertices on the
underlay. If you find the cursor snapping to points you don’t want, zoom in on the drawing by
clicking the right mouse button. Snap to Underlay will snap within the distance of half of one side of
the cursor, so you don’t have to be exactly on a point for the snap to occur.



Next draw the frame in which the glazing sits using the same method above; after that, draw the
inside stop, as shown in Figure 8-20.



If you find that a component you are tracing is too large (and therefore is out of the drawing area) or
too small (the cursor is snapping to the wrong points), you can use the Zoom feature to zoom in and
out even when you are in Draw Polygon mode. For example, if you are drawing a line that ends
outside the THERM drawing area, hold the Shift key down and click the right mouse button. This
will cause the drawing view to be zoomed out so that you can probably see the entire component you
are tracing. Then you can continue to draw the line. When you have finished that line, you may want
to zoom back in to get more detail by clicking the right mouse button.

8.3.2.2. Assign Different Materials to Polygons


The frame components of the cross section can each be assigned a different material. To assign a
different material to a polygon, highlight it by placing the mouse cursor inside the polygon and
clicking the left mouse button once. The vertices of the selected polygon will be displayed as squares.
Select, for example, Wood (Pine, Spruce, Fir) from the Materials pull-down list on the right-hand
side of the toolbar.

Figure 8-20. The wood components have been defined.


Now you have three polygons representing the three main components of the wood frame cross
section.



Press both the Polygon and the Repeat Mode toolbar buttons to turn off the drawing mode, or use
the Draw menu and uncheck (by clicking on them with your left mouse button) Polygon and Repeat
Mode (they are “on” when there is a check mark to the left; this selection toggles on or off each time
you click on the menu choice).

8-12
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8.3.2.3. Save the File


Save your work using the Save File toolbar button
or the File/Save menu choice. Type a name
that is not already being used, such as Tutorial2 (a file named Sample.thm is included in the
installation, so pick a different name to avoid overwriting that file), and click on the OK button.
THERM will automatically add the THM extension, in this case creating the file name
TUTORIAL2.THM.

8.3.3. Using a Dimensioned Drawing
This section explains how to use THERM to draw from a dimensioned drawing. You will learn how to:


Start a drawing from scratch,



Use the keyboard and mouse to navigate and draw,



Use keyboard short cuts.

8.3.3.1. The Dimensioned Drawing


You will be drawing the frame section of the following dimensioned drawing, using a combination of
the keyboard and the mouse.



Note: be sure you are in °F mode (IP) for this exercise. If you are in °C (SI) units, set the units to °F using the
“switch units” button on the menu bar or select it from the Options menu.
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Figure 8-21. Dimensioned drawing of cross section

8.3.3.2. Keyboard Short cuts
The following keys will be used in this exercise:

8-14



F2: Turns Draw Polygon on and off



Shift+F7: Sets the origin



Home: Centers the cursor over the origin cross hair



Space bar: Snaps the drawing cursor to the nearest point, to ensure that the cursor is exactly
on the point. This can be used when the sticky distance, which also causes the cursor to snap
exactly on a point, doesn’t apply.



Esc: Cancels drawing mode (and other modes)



Any Number: Enters the step size for cursor/line movement
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8.3.3.3. Positioning the Drawing


With your mouse, you can use the horizontal and vertical scroll bars on the drawing area to position
the origin (represented by cross hairs) in the lower right corner of the drawing, so you can see the
entire drawing without scrolling. (This position is based on the assumption that you want to start the
drawing on the origin; if not, this step is not necessary.)

8.3.3.4. Setting the Material


Press the F2 key to enable the Draw Polygon mode. This causes the Materials pull-down list on the
right side of the toolbar to become active; you can use your mouse to select the Wood (Pine, Spruce,
Fir) material for the frame. (Alternatively, you can access the Material Library by pressing Shift-F4,
or pressing Alt-L to access the Libraries menu, then typing M to access the Material Library. Use
your mouse to view the choices in the pull-down materials list, or type the first few letters of the
material and use the up and down arrow keys to scroll through the list. Press Enter or click your left
mouse button on the Close button to close the dialog box.)



This defines the material for all polygons you draw until you select another material.

8.3.3.5. Drawing the Dimensioned Part


The polygons representing the frame and the interior and exterior stops will be drawn using the
following procedure:


Type in the line dimension,



Move the dimension length using the arrow keys,



Press Enter to draw the line.



Press the Home key on your keyboard, which causes the drawing cursor to be positioned at the
drawing origin. If you are not in Draw Polygon mode, press Alt-D, P. Press Enter to establish the
current cursor position as the starting point for drawing the polygon.



With the dimensioned drawing example in front of you, begin your drawing from the lower right
corner and move counterclockwise (the program does not require that you draw in a
counterclockwise direction, but this is recommended). The extension at the corner is 0.688” high, so
type 0.688 from the number row or numeric keypad (be sure Num Lock is “on”) of your computer
keyboard.



Note: Do not press Enter (or the OK button on the Step Size dialog box) to accept the step-size;- as soon as
you type the number, the step size is set, and you can immediately use the arrow keys to move the distance you
have selected.

Figure 8-22. The Step Size dialog box appears any time you type a numeric value. You can click on the OK button to set the step size,
or just use the arrow keys while the dialog box is open to move the step size distance.
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Press the up arrow key once. A line will be drawn between your starting point and the new cursor
location.

Figure 8-23. To draw a line using the keyboard: from the origin, type in the step size, move the up arrow key, and press Enter.


Press Enter to draw the line and anchor the end point.



The next line length the extension is 1.000”. Type 1, and you will notice that, on the status bar at the
bottom of the screen, the x,y gives your position relative to the origin. The dx,dy shows change in x
and y, telling you where you are relative to the last point anchored; len tells you the actual length of
the line. If you move the arrow keys, dx, dy and len will reflect the values for the current dimension
being drawn.



Press the left arrow key once, then press Enter to draw the line.



The height of the next step is 0.500” (1.188 - 0.688). Type 0.5, press the up arrow key once, then press
Enter to draw the line



For this example, we will initially simplify the drawing process by squaring off the beveled edge,
marked as .100 CHAMFER in Figure 8-21. This change will have very little effect on thermal
performance. If you would like to include the bevel in your model follow the steps in Section 8.3.3.8.



The next horizontal length is 1.750” (2.75 - 1.00). Type 1.75, press the left arrow key once, then press
Enter to draw the line.



If the interior stop had been made of the same material, we could have included it as part of this
polygon. It is up to you to decide how to combine cross section elements. If there is any chance that
elements may be used with other drawings or may be moved, it is best to keep them separate. If two
polygons are made of different materials, they must be drawn separately.



The next vertical length is 0.500”. Type 0.5, press the down arrow key once, then press Enter to draw
the line.

8-16
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The next horizontal length is 1.813 (seen at the bottom of the drawing). Type 1.813, press the left
arrow key once, then Enter to draw the line.



We’re now about half done with the example. Your drawing should look like this:

Figure 8-24. Using the keyboard, you can type the polygon dimensions and use the arrow keys to draw the lines.

8.3.3.6. Completing the Polygon


The next vertical length is 0.688”. Type 0.688, press the down arrow key once, then press Enter to
draw the line.



The next horizontal length is 0.313”. Type 0.313, press the right arrow key once, then press Enter to
draw the line.



The next vertical length is 0.219”. Type 0.219, press the up arrow key once, then press Enter to draw
the line.



The next horizontal length is 0.250”. Type 0.250, press the right arrow key once, then press Enter to
draw the line.



The next vertical length is 0.219”. Type 0.219, press the down arrow key once, then press Enter to
draw the line.



The next horizontal length is 1.64” (2.203 – 0.313 – 0.250). Type 1.64, press the right arrow key once,
then press Enter to draw the line. Another technique, which lets the program do the arithmetic for
you, would be to type 2.203, press the right arrow key once, type 0.313, press the left arrow key once,
type 0.250, press the left arrow key once, then press Enter to draw the line and anchor the end point.



The next vertical length is 0.219”. Type 0.219, press the up arrow key once, then press Enter to draw
the line.



The next horizontal length is 0.125”. Type 0.125, press the right arrow key once, then press Enter to
draw the line.
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The next vertical length is 0.219”. Type 0.219, press the down arrow key once, then press Enter to
draw the line.



Press C to close the polygon, and the program will automatically draw a line between the current
cursor location and the starting point of the polygon.



When you are finished and the polygon is filled in, press the Esc key to cancel the polygon mode.



Your finished polygon should look like the picture in Figure 8-25.

Figure 8-25. The completed polygon that represents the frame

8.3.3.7. Correcting Mistakes While Drawing
If you make mistakes while drawing a polygon, there are several ways to make corrections without
deleting the entire polygon. Here are a few techniques:
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Wrong Dimension: If you accidentally enter the wrong dimension and move the cursor using the
arrow keys, simply use the arrow keys to backtrack to the last point drawn (len = 0.000).
Alternatively, you can use the mouse to position the cursor over the last good point and press the
Space bar, which causes the cursor to snap exactly to that point. Then type in the correct
dimension and start over (you can also use the technique below to move back).



Accidental Mouse Movement: Movement of the mouse while drawing a polygon may cause the
line to shift, changing the dimensions. If you accidentally move the cursor, use the mouse to
position the cursor over the last good point and press the Space bar, which causes the cursor to
snap exactly to that point. Be sure len = 0.000 before you begin drawing again.



Wrong Point: If you’ve entered the wrong dimension (as in the first technique above) but pressed
the Enter key to anchor the point, you may delete the point by pressing the Esc key once. Use the
mouse to reposition the cursor as in the technique above. Pressing the Esc key twice produces
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the following dialog box shown in Figure 8-26 for deleting additional points or the entire
polygon.

Figure 8-26. This dialog box allows you to delete the last point in a polygon.
You can use your mouse or the arrow keys to move to each button in the box.

8.3.3.8. Drawing Additional Polygons
Interior Stop:


Place the mouse cursor over the corner of the frame where the lower left corner of the interior
stop will be located. Press F3 or Alt-D,R to activate the Draw Rectangle toolbar button. Place the
cursor within the sticky distance (half of one side of the cursor cross hair) and press Enter to set
that location as the starting point for the rectangle. Now you are ready to draw the rectangle
representing the interior stop.



Type the horizontal dimension of the rectangle, 1.094, and press the right arrow key once to draw
the first side of the rectangle. (Do not press Enter yet !)



Type the vertical dimension of the rectangle, 0.50, press the up arrow key once, then press Enter,
and the program will draw the rectangle, assigning it the last used Material, which should be
Wood (Pine, Fir, Spruce).



You can add the bevel on the stop using the mouse and the keyboard as follows:
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Highlight the interior stop polygon by placing your mouse cursor inside the polygon and
clicking the left mouse button once. The vertices of the highlighted polygon will be indicated
by squares.



You may want to zoom in on the drawing by clicking the right mouse button once or twice in
order to see more detail.



Type 0.100 and press Enter (or click the OK button) to set the step size to 0.100".



Click on the Insert Points toolbar button
and place the mouse cursor over the upper
right corner. Press Space bar to locate the cursor exactly on that corner point, press the left
arrow key once to move the cursor 0.100" to the left, and press Enter to insert the new point.



Click on the Edit Points toolbar button
and place the mouse cursor over the same upper
right corner point as in the previous step, so we can move the point. Press the Space bar to
locate the cursor exactly on the point to be moved. A double-pointed arrow should appear,
which indicates that you can move the point. If a four-pointed arrow appears, this indicates
that you are on a line rather than a point, which means that the cursor was outside the sticky
distance of the point. (If you press the down arrow under this condition, the entire line will
move. You will need to zoom in so that you can position the cursor on the point you wish to
select).



Press the down arrow key once, which will move the point down 0.100".



Press Enter to set the point in the new location. The lines attached to the point will be
redrawn at the new angle.
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Exterior Stop:


We will draw the polygon for the exterior stop in a similar fashion. The drawing in Figure 827 contains the dimensions needed to draw this polygon. We will first draw a rectangle, and
then insert and move points to make the beveled sides of the polygon.

0.137

0.137

0.425

0.438

Starting point
for drawing
exterior stop

0.059
0.655

Figure 8-27. Dimensions for the exterior stop.
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We will use the lower left corner of the stop as the starting point for the rectangle. To locate
the drawing cursor at this corner point, first place the cursor on the left corner of the frame
polygon closest to the point. Press the Space bar to locate the cursor exactly on the point. The
lower left corner of the exterior stop is 0.059" to the right of this point, so type 0.059 and press
the right arrow key once. The location of the cursor will be the starting point of the stop.



Press F3 to activate the Draw Rectangle mode. Press Enter to set the current cursor position
as the starting point for the rectangle.



The exterior stop is 0.655" wide, so type 0.655, and press the right arrow once. This
establishes the width dimension of the rectangle. Do not press Enter yet !



The exterior stop is 1.00" high, so type 1, press the up arrow once, and press Enter. You now
have a rectangle 0.655" by 1.00".



Next, we are going to insert a point on the left side of the stop where the bevel starts.
Highlight the exterior stop by placing the drawing cursor inside the rectangle and clicking
the left mouse button once. The vertices of the highlighted rectangle will be displayed as
squares.



Click your mouse on the Insert Points toolbar button
, and place your mouse cursor over
the lower left point (the starting point) of the exterior stop. Press the Space bar to position the
cursor exactly on the point. The point on the left side of the stop where the bevel starts is
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0.438" above the starting point, so type 0.438 and press the up arrow key once. Press Enter,
and a point will be inserted at your cursor position.


Click your mouse on the Edit Points toolbar button
, and place the mouse cursor over
the upper left point on the exterior stop. When you are over the point, the cursor will turn
into a double-pointed arrow. Press the Space bar to place the cursor exactly on the point.



The bevel is 0.137" off the horizontal and vertical lines, so type 0.137, and press the right
arrow key once, then the down arrow key once. Press Enter, and the point will be redrawn in
the proper position, with the attached lines following and forming the beveled edge.



You have now finished drawing all the frame and stop elements and can proceed to the next
part of the tutorial: inserting the glazing system.

Step 2: Press
the Insert Point
toolbar button,
position the
cursor on the
lower left corner
of the stop,
press the
Spacebar, type
0.438, press the
up arrow key
once, and press
Enter. A point
will be inserted.

Step 3: Click on the Edit Point
toolbar button, place the cursor
over the upper left corner of
the rectangle, press Spacebar,
and type 0.137. Press the right
arrow key once and the up
arrow key once. Press Enter
and the point will be moved
and the polygon redrawn with
the bevel.

Step 1: Draw a
rectangle to
represent the
exterior stop.

Figure 8-28. Adding the beveled edge to the exterior stop

8.3.3.9. Save the File


Save your work using the Save File toolbar button
, or the File/Save menu choice. Type a name
that is not already being used, such as Tutorial3 (a file named Sample.thm is included in the
installation, so pick a different name to avoid overwriting that file), and click on the OK button.
THERM will automatically add the THM extension, resulting in this case in creating a file name of
TUTORIAL3.THM.

8.4. Import a Glazing System from WINDOW 4
Now that you have drawn the frame and stop components of the cross section, you are ready to import a
glazing system from the WINDOW program. A sample WINDOW glazing system library is provided with
the THERM installation.

THERM 2.0
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From the Draw menu, click your left mouse button on the Locator choice.

Figure 8-29. Select the Locator choice from the Draw menu.


Move the mouse cursor to the lower left corner where the glazing system is to be inserted, and
click on the left mouse button. A small circle will appear indicating the position of the Locator, as
shown in Figure 8-30. (If you are not using an underlay, first draw the glazing tape to the right of
the exterior stop, to serve as a guide for placing the Locator.)

Position Locator:
Place the drawing cursor in the lower left corner of the location
where the glazing system will be inserted, and click the left
mouse button. A small circle will appear.

Figure 8-30. Position the locator where you want the lower left corner of the glazing system to be placed.
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From the Libraries menu, select the Glazing Systems choice.
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Figure 8-31. Select the Glazing Systems choice from the Libraries menu.


The Glazing Systems dialog box will appear with a pull-down list showing all the choices from
the WINDOW “GLZSYS.W4” file that was installed with THERM. You can use the Browse
button to locate other GLZSYS.W4 files if desired. However, for this example, you should use the
library that is provided with THERM.

Figure 8-32. The Glazing Systems dialog box displays the information about each glazing system choice.


Put the mouse cursor on the pull-down list arrow, click the left mouse button, and the list of
glazing systems will be displayed. Scroll through the list (using your mouse or arrow keys) and
pick the “THERM SAMPLE” choice.

Figure 8-33. Select the THERM SAMPLE glazing system to be inserted in the tutorial example.


THERM 2.0

Press the Import button, and the Insert Glazing System dialog box will appear. Leave all the
default values as they are, and press the OK button. (The Draw Spacer box is left unchecked because
we will insert a custom spacer later in the tutorial).
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Figure 8-34. The Insert Glazing System dialog box appears when you are importing a glazing system from WINDOW.


The glazing system will be inserted into the frame with the lower left corner positioned where the
Locator was placed.

Figure 8-35. The glazing system from WINDOW has been inserted into the frame components.
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Now that the glazing system has been inserted, glazing tape can be drawn between the glazing
system and the interior and exterior stops (if you haven’t already completed this step), as follows:


Click the right mouse button as many times as you need in order to enlarge the drawing so
that you can snap to the points described below. You may have to enlarge it quite a bit.



Press the Draw Rectangle toolbar button



Select Polysiobutylene from the materials pull-down list on the right-hand side of the
toolbar.



Position the drawing cursor in the upper left corner of the space to the left of the glazing
system, and click the left mouse button. Keeping the left mouse button down, move the
drawing cursor down to the lower right corner of the gap; release the mouse button. A
rectangle will be drawn that exactly fits in the space.
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Step 2: Position
the drawing
cursor in the
upper left corner
of the space.
Click the left
mouse button
and hold it down.

Step 3: Keeping the left mouse
button down, move the drawing
cursor to the lower right corner of
the space, and release the
mouse button. A rectangle will be
drawn that fills the space.

Step 1: Select the
material for the glazing
sealant.

Figure 8-36. Draw a rectangle that fills the space between the exterior stop and the glazing system.


In the same manner, draw a rectangle for the glazing tape between the interior stop and the
glazing system.

Draw a rectangle to represent
the glazing tape between the
glazing system and the interior
stop.

Figure 8-37. Draw a rectangle that fills the space between the interior stop and the glazing system.


The lower right corner of the exterior stop does not lie exactly on the frame, and because it is
necessary to either fill or delete all voids, we have to decide what to do with this area. One
solution is to move that corner down to the frame, as follows:


THERM 2.0

Highlight the exterior stop by placing the mouse cursor inside the polygon and clicking the
left mouse button once. The vertices of the selected polygon will be displayed as squares.
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Click the left mouse button on the Edit Point toolbar button



You may want to zoom in (click the right mouse button) one or two times to enlarge the cross
section. Position the mouse cursor over the lower right-hand corner of the exterior stop. The
cursor will be displayed as a double-pointed arrow, which means you can move the point.



Hold down the Shift key to restrain the cursor movement to the vertical direction. Then,
holding the left mouse button down, move the mouse (and the point will follow) down to the
frame. Release the mouse button.

.

Step 1: Click on the
Edit Point toolbar
button

Step 2: Place the mouse cursor
over the point to be moved. The
cursor will change to a doubleheaded arrow when it is over the
point.

Step 3: Holding the left mouse button down, move the
mouse cursor to the new location of the point, in this
case down to the frame.

Figure 8-38. With the Edit Point toolbar button activated, place the mouse cursor over the point to be moved,
hold the left mouse button down, and move the mouse to the new point location.
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The point and attached lines are moved, and the polygon is redrawn, as shown in Figure 839.
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The point and all attached
lines are moved and the
polygon is redrawn with the
new shape.

Figure 8-39. THERM will move the point and the lines attached to that point and redraw the cross section with the new geometry.


Another option for this space would be to define it as a cavity. In that case, you should make this sliver a
separate cavity polygon from the main cavity area. The effective conductivity of the cavity is based on the
overall dimensions of a cavity and if you include the sliver you effectively double the size of the main
cavity. The first solution, to bring the exterior stop corner down to the frame and model that area as
wood, is a better thermal approximation than modeling the whole area as one cavity.


You can copy and paste into the cross section a spacer from another THERM file, as follows:


THERM 2.0

Use the File menu, Open option to open SPACER.THM, another sample file that was
installed with the THERM program. This file contains a cross section of a custom spacer that
we can copy and paste into our tutorial cross section.
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Figure 8-40. Use the Draw/Locator menu choice to position the Locator in the upper left corner of the spacer.


Use the Draw/Locator menu to place the locator circle in the upper left corner of the spacer
drawing (if it is not already there), as shown in Figure 8-41.

Select Locator from the Draw menu, place the cursor
in the upper left corner of the spacer, and click the left
mouse button. The Locator circle will appear.

Figure 8-41. Position the Locator in the upper left corner of the spacer.
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Use the Edit/Select All menu to select all the polygons in the spacer file. Or you can click on
a point above and to the left of the spacer, and holding the left mouse key down, move the
cursor to a point below and to the right of the spacer. A dashed box will be displayed
showing the area you have moved your cursor, and all the polygons inside that area will be
automatically selected.
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Use the Edit/Copy menu, or Ctrl-C, to copy the selected polygons to the Windows™
clipboard.

Figure 8-42. Use the Edit/Select All menu choice to select all the polygons in the spacer;
then, use Edit/Copy (or Ctrl-C) to copy these polygons into memory.


Use the Window menu to select the tutorial cross section file.



Use the Draw/Locator menu to place the locator circle in the upper left corner of the recess
under the glazing system cavity where you want the upper left corner of the spacer to be
located.



Use the Draw/Paste menu, or Ctrl-V, to paste the spacer into the SAMPLE cross section. The
spacer will be placed in the cross section by matching up the positions of the two Locators.

Locator positions for the
cross section and the
spacer are matched up
when the spacer is pasted
into the cross section.

Figure 8-43. Use the Edit/Paste menu choice to paste the spacer into the cross section.
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Select the Libraries menu, Material Library choice (or press Shift-F4), and select the Frame Cavity
NFRC Simplified material from the Materials list.



Select the Fill tool and click in the area between the glass and the stop. This area will automatically be
filled by the program with a polygon of the material Frame Cavity NFRC Simplified.

Figure 8-44. Use the Fill tool to fill in the cavities in the cross section.
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When you have finished these polygons, Zoom the drawing back out, either holding down the
Shift key while clicking the right mouse button repeatedly until the drawing is the size you want
it to be, or Ctrl right mouse click to zoom to fit the drawing in the screen.
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Figure 8-45. The finished cross section.

8.5. Define Boundary Conditions


Next, you need to define the boundary conditions for the cross section.



Press the Boundary Conditions toolbar button
menu choice.



If the program detects any flaws in the drawing while assigning the boundary conditions, a
message will appear, and you may have to fix the problems before the program can continue
defining the boundary conditions. See Section 6.3, "Error Detection in THERM" for detailed
discussions of this situation.



THERM will automatically draw an exterior boundary around all the cross-section components,
indicated by a heavy line. The boundary condition is actually made up of many boundary
segments, which can each be given different boundary condition definitions.

THERM 2.0
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Figure 8-46. When you press the Boundary Conditions toolbar button,
THERM draws an exterior boundary around all the cross-section components.


The default boundary condition for all the boundary elements except the glazing system is adiabatic.
The glazing system is automatically given THERM SAMPLE U-factor Inside and THERM SAMPLE
U-factor Outside boundary conditions (the program automatically adds the glazing system name, in
this case THERM SAMPLE, as a prefix to the boundary condition name) if the glazing system was
inserted from a WINDOW glazing system.



Select the lower right boundary segment on the interior frame (the right side) by moving the mouse
cursor to it and pressing the left mouse button. Round points on each end of the segment indicate
that it has been selected.



Hold the Shift key down, and click on the segment on the interior stop. The program automatically
selects all boundary segments between the first and last selected segments, moving in a
counterclockwise direction, as shown in Figure 8-47.



Press Enter and the Boundary Condition Type dialog box will appear. Select Interior Wood/Vinyl
Frame for the boundary condition and Frame for the U-Factor Surface as shown in Figure 8-47. Press
the OK button.

8-32
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Step 3: The Boundary Condition
Type dialog box will open, and you
can select the appropriate
Boundary Condition and U-factor
Surface.

Step 2: Hold the Shift key down, and
double click on the last boundary segment,
moving in a counterclockwise direction.

Step 1: Click the left
mouse button on the
first boundary
segment.

Figure 8-47. Select multiple boundary segments for the interior side of the cross section, and define their boundary conditions.


Use the same technique to define the boundary conditions for the exterior (left side) of the cross
section, as shown in Figure 8-48. Select the exterior boundary segments for the exterior stop and
the frame, and assign them the Boundary Condition of Exterior Surface.

Step 3: The Boundary Condition Type dialog box will
open, and you can select the Exterior Surface
boundary condition.

Step 1: Click the left mouse
button on the first boundary
segment.
Step 2: Hold the Shift key
down, and click on the last
boundary segment, moving in a
counterclockwise direction;
then, press Enter.

Figure 8-48. Select multiple boundary segments for the exterior side of the cross section, and define their boundary conditions.
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To view the boundary conditions automatically defined for the imported WINDOW glazing
system, place the mouse cursor on the inside boundary segment of the glazing system, and
double-click the left mouse cursor. The Boundary Condition Type dialog box will appear.
THERM SAMPLE: Inside U-factor will already be selected for the Boundary Condition, and
Edge for the U-Factor Surface, as shown in Figure 8-49. Press the OK button.

Figure 8-49. You can view the boundary condition definitions for the glazing system by double-clicking the left mouse button on the
glazing system boundary.


Save the file using the Save File toolbar button

, or the File/Save menu choice.

8.6. Run and View the Results


Press the Calculation toolbar button



The status bar at the bottom of the THERM screen will display the steps of the calculation, as shown
in Figure 8-50.

8-34

, or select the Calculation/Calculation menu choice.
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To begin the calculation,
click on the Calculation
toolbar button.

As the calculation
proceeds, the status bar
will display the steps.

Figure 8-50. Click on the Calculation toolbar button; as the calculation proceeds, the steps will be displayed on the status bar.


When the simulation is finished, the default isotherm results will be drawn on the cross section, as
shown in Figure 8-51.

Figure 8-51. When the calculation has finished, the program will display the results as isotherms.
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You can view the U-factor results using the Calculation/Show U-Factors menu choice.

Figure 8-52. U-Factor results, accessed from Calculation/Show U-Factors menu choice.


You can view other results in other formats using the Calculation/Display Options menu choice,
which opens the Results Display Options dialog box. For more detailed information about the types
of results available from THERM, see Chapter 7, "Results."

Figure 8-53. Other results can be displayed by changing the values in the Results Display Options dialog box, access from the
Calculation menu, Display Options choice.

8-36

JUNE 1998

THERM 2.0

9. REFERENCES
1.

Arasteh, D. K. Finlayson, E. U., and Huizenga, C. 1994. "WINDOW 4.1: A PC Program for Analyzing
Window Thermal Performance in Accordance with Standard NFRC Procedures." LBL Report 35298.
Berkeley, CA.

2.

Finlayson, E. U., Arasteh, D. K., Huizenga, C., Rubin, and M. D., Reilly, M. S., 1993. "WINDOW 4.0:
Documentation of Calculation Procedures." LBL Report 33943. Berkeley CA.

3.

Enermodal Engineering Ltd. 1991. "FRAME -- A Computer Program to Evaluate the Thermal
Performance of Window Frame Systems, Version 3.0." Waterloo, Ontario, Canada.

4.

Finlayson, E. U. , Arasteh, D. K., Rubin, M. D., Sadlier, J, Sullivan, R., Huizenga, C., Curcija, D., and Beall,
M. 1995. "Advancements in Thermal and Optical Simulations of Fenestration Systems: The Development
of WINDOW 5." Proceedings of the Thermal Envelopes Conference VI, Clearwater, Florida.

5.

Baehmann, P. L. Wittchen, S.L., Shephard, M.S., Grice, K.R. and Yerry, M.A., 1987. “Robust,
Geometrically Based, Automatic Two-Dimensional Mesh Generation.” International Journal for Numerical
Methods in Engineering. 24, 1043 - 1078..

6.

Shapiro, A. B. 1986. "TOPAZ2D - A Two-Dimensional Finite Element Code for Heat Transfer Analysis,
Electrostatic, and Magnetostatic Problems" Lawrence Livermore National Laboratory, Rept. UCID-20824.

7.

Shapiro, A. B. 1990. "TOPAZ2D Heat Transfer Code Users Manual and Thermal Property Data Base",
Lawrence Livermore National Laboratory, Rept. UCRL-ID-104558, May 1990.

8.

Zienkiewicz, O. C.; and Taylor, R. L. 1989. The Finite Element Method. 4th ed. Vol. 1. McGraw Hill,
Maidenhead, UK.

9.

Pepper, P. W. and Heinrich, J. C. 1992. The Finite Element Method Basic Concepts and Applications.
Hemisphere Publishing Corporation, Washington.

TM

10. Curcija, D.; Power, J. P.; and Goss, W. P. 1995. "CONRAD: A Finite Element Method Based Computer
Program Module for Analyzing 2-D Conductive and Radiative Heat Transfer in Fenestration Systems".
Draft Report, University of Massachusetts at Amherst.
11. Rohsenow, W. M., Harnett, J. P., and Ganic, E. N., 1985. Handbook of Heat Transfer Fundamentals, 2nd
Edition, McGraw Hill.
12. Shapiro, A. B., 1983. FACET – A Radiation View Factor Computer Code for Axisymetric, 2D Planar, and
3D Geometries with Shadowing. Lawrence Livermore National Laboratory, Rept. UCID-19887.
13. Sullivan, H. F., Wright, J. L., and Fraser, R. A., 1996, Overview of a Project to Determine the Surface
Temperatures of Insulated Glazing Units: Thermographic Measurements and Two-Dimensional
Simulation. PP 516-522, ASHRAE Transactions, Vol 102, Part 2.
14. Zhao, Y., Curcija, D., and Goss, W. P., 1996, Condensation Resistance Validation Project - Detailed
Computer Simulations Using Finite - Element Methods. PP 508-515, ASHRAE Transactions, Vol 102, Part
2.
15. Curcija; D., and Goss, W. P. The 'Variable-h' Model For Improved Prediction of Surface Temperatures in
Fenestration Systems, DRAFT June 1998 University of Massachusetts Report.

THERM 2.0

JUNE 1998

9-1

9. REFERENCES

16. ASHRAE Standard 142P, Standard Method for Determining and Expressing the Heat Transfer and Total
Optical Properties of Fenestration Products, Public Review Draft, October 1996, American Society of
Heating, Refrigerating and Air-Conditioning Engineers, Inc., Atlanta, GA.
17. 1997 ASHRAE Handbook of Fundamentals, American Society of Heating, Refrigerating and AirConditioning Engineers, Inc., Atlanta, GA.
18. Zienkiewicz, O.C. and Zhu, J.Z. 1992a. “The Superconvergent Patch Recovery and A Posteriori Error
Estimates. Part 1: The Recovery Technique.” International Journal for Numerical Methods in Engineering. Vol
33. pp. 1331-1364.
19. Zienkiewicz, O.C. and Zhu, J.Z., 1992b. “The superconvergent patch recovery and a posteriori error
estimates. Part 2. The error estimates and adaptivity.” International Journal for Numerical Methods in
Engineering. Vol 33. pp. 1365-1382.

9-2

JUNE 1998

THERM 2.0

10. ACKNOWLEDGEMENTS
This work was supported by the Assistant Secretary for Energy Efficiency and Renewable Energy, Office of
Building Technology, State and Community Programs, Office of Building Systems of the U.S. Department of
Energy under Contract No. DE-AC03-76SF00098. The program authors wish to thank the window
manufacturers who supplied data on their products for use in the program; Ken Nittler, Jeff Baker, and Ross
DePaola of WestLab for their review of pre-release versions; Mark Shephard, Mark Beall, and Scientific
Computation Research Center (SCOREC) at Rensselaer Polytechnic Institute for their contribution to the
mesh generation and error estimation algorithms in the program; Art Shapiro of Lawrence Livermore
National Laboratory for his help in modifying TOPAZ2D for use with THERM; Brent Griffith and Christian
Kohler for debugging and testing the program; Nan Wishner for her time and effort editing this document;
and Pat Ross for all her many daily contributions including the final production of the program and manual.

THERM 2.0

JUNE 1998

10-1

Appendix A: Glossary of Terms
Adiabatic
A boundary condition that assumes a perfectly insulated or a symmetric
condition.

Adjacent polygon
A polygon that shares a common side with another polygon.

ASHRAE
The American Society for Heating, Refrigerating and Air-Conditioning
Engineers, Inc.

ASHRAE summer conditions
Environmental conditions, used to determine Solar Heat Gain boundary
conditions, with the following characteristics:


Exterior Temperature: 31.7°C



Room Temperature: 23.9°C



Wind Speed on Exterior Surface: 3.4 m/sec, windward



Direct Solar Radiation: 783.0 W/m2

ASHRAE winter conditions
Environmental conditions, used to determine U-factor boundary conditions,
with the following characteristics:


Exterior Temperature: –17.8°C,



Room Temperature: 21.1°C,



Wind Speed on Exterior Surface: 6.7 m/sec, windward



Direct Solar Radiation: 0.0 W/m2.

Aspect ratio
The dimension perpendicular to the heat flow (vertical for horizontal heat
flow) divided by the dimension parallel to the heat flow (horizontal for
horizontal heat flow). This value is used to determine the effective
conductivity in frame cavities.

Assembly drawings
Drawings that show many separate parts put together. These drawings
often show deformable pieces that overlap. When creating a THERM model
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from an assembly drawing the user must turn these overlapping pieces into
polygons with no voids or overlaps.

Autoconvert
An option when importing DXF files into THERM that allows closed
polylines and curves to be turned into polygons.

AutoLISP programs
Programs created to automate commands in AutoCAD ™ that can be used to
improve the applicability of a DXF file for the THERM autoconvert feature.

Bad Points
Two points that are closer than 0.1 mm are considered "bad points", because
they should actually be the same point. These bad points are marked with
red circles when the boundary conditions are drawn. If they are defects in
the drawing they should be fixed, but if they are areas of fine detail they can
be ignored. The bad points can be cleared using the Draw/Clear Bad Points
menu choice. View the red circles is controlled using the View/Bad Points
menu choice.

Bitmap file
An file format that THERM can use as an underlay to be traced. Bitmap files
do not contain information about lines and vertices, so THERM cannot snap
to vertices as it can with a DXF underlay. Bitmap files sometimes distort the
dimensions of the cross section and should be used with care.

Black Body Radiation
Electro-magnetic radiation governed by the Stefan Boltzman law:

q = σT 4
The sun is a source of black body radiation. The emissivity of a surface is a
measure of how a surface compares to a black body, which is defined with
an emissivity of 1.0.

Blocking surfaces
When calculating radiation heat transfer between the model and a radiation
enclosure, THERM automatically calculates the view factor between all
surfaces. The view factor calculation takes into account which surfaces block
the view between other surfaces. By default, all surfaces of a radiation
enclosure are blocking surfaces, meaning that they can potentially block the
view between two other surfaces. Optionally, the blocking surface option
can be turned off for any surface. Turning off the blocking surface option
will speed the view factor calculation process, but should only be done for
surfaces that will never block the view between two other surfaces.

A-2

JUNE 1998

THERM 2.0

Appendix A: Glossary of Terms

Boundary conditions
The properties and/or relationships that define the edges of the model are
called boundary conditions. For the steady state energy equation solved in
THERM, the boundary conditions either specify the heat flux and/or the
temperature. Environmental conditions, film coefficients, surface
emissivities, radiation view factors, and thermal conductivities are used to
determine the boundary conditions of the model. The default boundary
condition in THERM is an adiabatic or perfectly insulating boundary.

Boundary segment
A boundary segment is the line segment between any two points on the
boundary (or edge) of the model. Boundary segments must be assigned
boundary conditions and may be tagged to be included in the U-factor
calculations.

CAD
Computer Aided Design. A category of computer drafting programs that
can create a DXF file that can be used as an underlay in THERM.

Cavities
There are two types of cavities mentioned in the THERM manual. A glazing
cavity is the gas filled gap between glazing layers in a multilayer glazing
system. A frame cavity is an air filled cavity that occurs in window frames,
especially in extruded vinyl and aluminum frames.

Cavity height
The total height of the glazing system cavity, including two edge regions and
a center of glass region. This value is a necessary input for the Condensation
Index calculation.

Cavity Model
The cavity model refers to one of several options for modeling frame cavities
in THERM. The various cavity models have different methods of
approximating non-rectangular cavity geometry, effective conductivity and
radiative heat transfer.

CEN
The standard body of the European Community analogous to ASTM.

CEN radiation model
The simplified radiation model used with the CEN frame cavity models.
This model approximates a frame cavity as a rectangular cavity with
isothermal walls. The radiative conductance (hr) uses a view factor (F) for a
rectangular section and a linearized Stephan Boltzman law:
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3
hr = E ⋅ F ⋅ 4σ ⋅ Tavg

E = (ε 1−1 + ε 2−1 − 1) −1
1
F = 1 + 1 + (L / H )2 − L / H
2

(

)

Where T is Temperature, ε is emissivity, L is the cavity dimension in the
direction parallel to the heat flux and H is the cavity dimension in the
direction perpendicular to the heat flux.

Center-of-glass
The region in a glazing system where the frame and spacer effects are
negligible and one-dimensional heat transfer occurs. The thermal properties
for the center-of-glass region are determined in the WINDOW program.

Condensation Index
Refers to the calculation procedure that uses local film coefficients and the
radiation enclosure model to obtain local temperatures that are more
accurate than those obtained using the effective conductivity method for
glazing systems.

Conduction
Heat transfer resulting from a temperature difference between adjacent
objects governed by the thermal conductivity.

Conductivity
A measure of the rate at which heat flows through a material. Materials that
are good conductors of electricity (i.e. metals) are usually good conductors of
thermal energy as well and have a high thermal conductivity. An insulating
material is a poor conductor of thermal energy and has a low thermal
2
conductivity. Units are Btu/hr-ft-F, Btu-in/hr-ft -F or W/m-K.

Constant heat flux magnitude
Heat flux is vector quantity, meaning that the heat flux at any point in the
model has both a magnitude and a direction. The Constant Heat Flux
Magnitude result only indicates the magnitude of the heat flux, which is
useful in identifying thermal bridges and evaluating thermal breaks.

Convection
Heat transfer resulting from gas movement caused either by a temperature
gradient or by an incident wind.

Convection correlations
Convection heat transfer is treated approximately in THERM using
correlations developed from experimental and computational research.
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These correlations are used to determine the effective conductivity in frame
cavities. They provide results that are a function of the thermal properties,
geometry, and temperature difference in the cavity.

Cross section geometry
A two dimensional view cut through a three dimensional object, represented
in THERM by polygons. This geometry is derived from a DXF file or a
dimensioned drawing.

Cursor sticky distance
The area of influence of the cursor relative to a vertex. If the mouse is clicked
when the drawing cursor is within this distance from a vertex, the cursor will
"stick" to the vertex. This helps prevent voids and overlaps from being
unintentionally created in the drawing. The sticky distance is 3mm at 100%
scale, which is about half the length of one side of the drawing cross hair.
This distance is fixed, so as you zoom in, it becomes smaller with respect to
the detail of the drawing. If you are having trouble with the program
snapping to the wrong vertices, try zooming in on the area of interest which
effectively reduces the sticky distance.

Curve fit model
The simplified radiation model associated with the NFRC and User Defined
frame cavity models that uses the length (L), height (H) and average absolute
temperature (Tavg) to determine the approximate radiative conductance
(16)
(hr) :

hr = exp(1.53 − 0.194 ∗ L / H ) ∗ (Tavg / 273)3

Deformable pieces
Components of a cross section, such as glazing stops, glazing tape and
weather-stripping, which will change size and shape (i.e., deform) when they
are assembled into a real product. They are often drawn in their undeformed
state in assembly drawings, resulting in overlapping regions. Because there
can be no overlapping regions or voids in a THERM cross section, these
objects should be modeled as they will actually occur in the real product
rather than how they appear in the assembly drawing.

Detailed radiation model
The detailed radiation model uses an element to element view factor method
(see Appendix C for more information) to determine the radiant exchange
between every element in the enclosure it is applied to. The detailed
radiation model accounts for the temperature and emittance of these
elements.

Dialog box
A THERM program window that displays information and allows user
input. For example, if the user selects the File/Open menu choice, a small
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program window, or dialog box, opens, allowing the user to choose the file
to be opened.

Dimensioned drawing
A representation that includes all the dimensions needed to represent an
object as a cross section in THERM.

DXF file
An export file format from a CAD program that can be used as an underlay
in THERM. THERM can preferentially snap to the vertices in a DXF file and
can convert the closed polylines into polygons.

DXFOUT command
The command used in a CAD program to create a DXF file.

Edge effects
The two dimensional heat transfer that occurs in the glazing system due to
the thermal bridging effects of the spacer and frame.

Effective conductivity
A method that converts the convection and radiation effects of a volume of
gas into a conductance that is combined with the thermal conductivity to
model the gas volume as if it were a solid.

Emissivity
The ratio of the actual emission of radiation by an object to the emission of a
black body at the same temperature.

Entities
An object such as a line, circle, arc or polyline treated as a single element in a
CAD program in order to simplify creation, manipulation and modification
of those objects.

Environmental conditions
The conditions that define the environment surrounding the model from
which the boundary conditions are derived (see ASHRAE summer
conditions and ASHRAE winter conditions for examples).

External Radiation Enclosure
A THERM material type used to model a space through which radiation heat
exchange takes place between the model and other external surfaces. Each of
these external surfaces can have its own temperature and emissivity.
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Finite element mesh
A collection of non-overlapping three and four sided elements upon which
the finite element analysis is performed. The mesh is generated
automatically by THERM based on the geometry of the model. Subsequent
adaptation of the mesh based on the heat flux in the model can be achieved
using the error estimator option.

Finite-element analysis
The numerical method used in THERM to solve the two dimensional energy
equation. The equation is set up on each element of the finite element mesh
and then a solution for each element that minimizes the global error of the
entire mesh is obtained by solving a matrix of related variables.

Floating point tolerance
The minimum distance between points in THERM, which is set at 0.01 mm.
Points that are closer together than this distance are merged together.

Flux
See heat flux.

Frame cavities
See Cavities.

FRAMETM F30 file
A file created by the FRAME 3.0 program developed by Enermodal
Engineering Ltd.

Glazing cavity
See Cavities.

Glazing layers
Transparent layers, such as glass and acrylic, combined with spacers and fill
gases, to create glazing systems.

Glazing system
In THERM, a glazing system imported from the WINDOW4 computer
program. It is a series of polygons that represent the thermal properties, heat
transfer characteristics, and boundary conditions of a glazing unit. A sample
WINDOW4 glazing system library is provided with THERM. Additional
glazing systems can be created using the WINDOW4 program.
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Heat flux
Heat flux is the vector quantity determined from the thermal conductivity
and the local temperature gradient surrounding a node on the finite element
mesh.

Heat transfer analysis
Heat transfer analysis is a term applied to the solution of the energy equation
in its many forms. There are three main modes of heat transport:
conduction, convection and radiation. All three of these modes are modeled
in THERM.

Heat-flux vectors
Heat flux is a vector quantity that has a magnitude and a direction, resulting
from the finite element analysis. These vectors are determined for every
node in the finite element mesh. They are a function of the thermal
conductivity and the local temperature gradient. The heat flux vector plot
shows one heat flux vector for each element. This vector is determined by
integrating the heat flux over the entire element. Its magnitude is a function
of the heat flux and also the size of the element. The heat flux vector plot
gives an qualitative representation of the direction of heat flux through the
cross section.

Horizontal heat flow
The default assumption in frame cavity models is that heat flow is occurring
largely between the two vertical sides of the cavity (or its equivalent
rectangle) and thus the flow is horizontal. This heat flow is driven by a
temperature difference between these two sides. Other possible models are
vertical flow up and vertical flow down.

Isotherms
Lines of constant temperature.

Keff
See Effective Conductivity.

Local film coefficients
Local convective film coefficients vary as a function of position. They
provide improved accuracy in the calculation of local temperatures and are
used in the Condensation Index Model.

Local temperatures
Temperatures at a specific location in contrast to temperatures averaged over
an area.
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Material properties
The thermal conductivity and emissivity characteristics of a material. For
example, the material properties for a frame cavity are the geometry, the
emissivity, the thermal properties of the gas, and the temperature difference
across the cavity.

Mesher
The algorithm based on the Finite Quadtree method that automatically
creates the finite element mesh.

NFRC
The National Fenestration Rating Council, whose mission is to provide a fair,
accurate, and credible rating system for windows and other fenestration
products.

Non-contiguous polygons
Polygons that do not share a common edge.

Non-planar surfaces
A surface that has dimensions in more than one plane, i.e., the horizontal and
the vertical plane. For example, a greenhouse window has non-planar
surfaces.

Nusselt number
The Nusselt number is the ratio of convective to conductive heat transfer. A
Nusselt number of 1.0 is an indication of still air.

Overlapping regions
A situation caused when part of one polygon lies on top of another polygon.
THERM cannot perform the calculation if this situation exists, and the
program tries to prevent it during the drawing process. Sometimes the check
for overlapping regions is overly cautious and a warning comes even when
an overlap doesn’t exist. If this happen you can turn off the “always check
for overlapping polygons” option. In general it is best to keep this option
turned on when drawing. After the model is completed and the boundary
conditions are drawn the program will identify any overlapping regions,
which must be corrected before the model can be simulated.

Polygon
A closed shape made up of a minimum of three sides. In THERM, a polygon
cannot intersect itself; therefore shapes such as "figure eights" and donuts are
not acceptable polygons.
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Polylines
A term used in CAD programs to describe a series of line segments
connected into a continuous line. A closed polyline in a DXF file can be
autoconverted into a polygon by THERM.

Projected length
The dimension obtained by projecting the frame profile on either a
horizontal (Projected X) or vertical plane (Projected Y). This value is used as
a basis for the U-factor, which is the heat flow per unit temperature
difference per unit projected length.

Radiation
The electromagnetic radiation modeled in THERM is the long wavelength
thermal radiation that is emitted by opaque bodies at temperatures greater
than absolute zero.

Radiation blocking surface
See blocking surface.

Radiation heat transfer
The net energy transfer between two bodies that are radiating to each other.
The amount of radiation heat transfer between two bodies depends on the
surface emissivities, the radiation view factors and the absolute temperatures
of the bodies.

Radiation Model
There are three radiation heat transfer models used in THERM. The detailed
radiation model, the curve-fit radiation model and the CEN radiation model.
See glossary listings for information on each of these models.

Radiation view-factor
The radiation view-factor is a measure of how much one surface sees of
another. A view-factor of 1 means that one surface sees only another surface
and nothing else. A view-factor of 0 means that one surface does not see
another. Partial viewing will result in a view factor that falls between these
extremes. The radiation view factor is calculated by THERM using the cross
string method.

Self viewing
The ability of a non-planar product to radiatively see itself. If there is a
significant temperature gradient along the surface the radiation heat transfer
caused by self-viewing can have a marked effect on the overall heat transfer
in the cross section. This is especially true in projecting fenestration products
such as greenhouse windows.
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Sight line
The point on the room side of the glazing system corresponding to the
highest point on the window frame (either exterior or room side). This point
is used to determine whether boundary segments on a glazing system are
tagged as edge or frame for the U-factor calculation. The height of the edge
region is measured from the sight line.

Simulation
The simulation process involves everything necessary for solving the energy
equation , including mesh generation, finite element analysis, error
estimation, and mesh refinement.

Snap-in pieces
Parts of an assembly that are "snapped" into a main extrusion to create
separate cross sections. For example, a window frame head and sill might
have a single main extrusion and may differ only in a few snap-in pieces. In
THERM the main extrusion could be modeled once, and then cut and paste
could be used to model both the head and the sill.

Solar gain
The thermal energy that enters a room through transmission, absorption, and
subsequent radiation of solar energy.

Solar Heat Gain Inside Film
The boundary condition that is imported with a glazing system from
WINDOW4 corresponding to ASHRAE summer conditions for application to
the room side boundary of the glazing system.

Solar Heat Gain Outside Film
The boundary condition that is imported with a glazing system from
WINDOW4 corresponding to ASHRAE summer conditions for application to
the exterior boundary of the glazing system.

Solid material
An opaque material that is fully defined for analysis purposes by a thermal
conductivity and emissivity.

Spacer height
The distance from the top of the spacer to the bottom of the glazing. The
height determines the height of the glazing cavity in a glazing system that is
imported from WINDOW4. A rectangle the height of the spacer height and a
width of the glazing cavity will be left empty when the glazing system is
imported. THERM can automatically fill that rectangle with a solid material
to approximate a spacer if the Draw spacer check box is checked when
importing the glazing system.
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Step size function
Used in conjunction with the arrow keys to move the cursor a specified
amount. Typing in a numeric value defines the step size. Holding down the
control key causes the step size to be temporarily decreased by a factor of 10.

Sticky distance
See cursor sticky distance.

Temperature difference
The difference in temperature between the warm and cold sides of a cross
section. The temperature difference is the driving force behind conduction,
natural convection, and radiation heat transfer.

Thermal bridges
Materials of high thermal conductivity that connect a cold area with a warm
area, facilitating heat transfer between these areas.

Thermal conductivity
See Conductivity.

Two-dimensional (2D) conduction heat transfer analysis
An analysis assumption that energy is transported in the horizontal (x) and
vertical (y) directions but that nothing is driving the heat flow in the
transverse (z) direction.

U-factor
The U-factor is a measure of the heat transfer characteristics of a cross section
under specific environmental conditions. In THERM, the U-factor calculation
integrates the heat flux over the tagged boundary segment or segments,
divides that flux by the projected length of the segment and the defined
temperature difference, and returns a U-factor.

U-factor Inside Film
The boundary condition that is imported with a glazing system from
WINDOW4 corresponding to ASHRAE winter conditions for application to
the room side boundary of the glazing system.

U-factor Outside Film
The boundary condition that is imported with a glazing system from
WINDOW4 corresponding to ASHRAE winter conditions for application to
the exterior side boundary of the glazing system.
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U-factor tags
Labels given to boundary segments over which the heat flow will be
integrated in order to obtain U-factors. These boundary segments need not
be contiguous nor do they need to be defined with the same boundary
condition.

Underlay
A DXF file or a Bitmap file that can be traced over to create the cross-section
geometry in THERM.

Vertex (Vertices)
A vertex is a point where two line segments come together in a DXF file or a
point on a polygon in a THERM cross section.

Void
An undefined space created between two polygons with unmatched edges.
After the model is completed and the boundary conditions are drawn the
program will identify any voids. These must be corrected before the model
can be simulated.

WINDOW4
A software program developed by the Lawrence Berkeley National
Laboratory to calculate center of glass and total window thermal
performance indices.

WINDOW4 glass library
The database of glazing layers used to create glazing systems in the
WINDOW4 program. This library contains information on the thickness,
optical properties, surface coatings and thermal conductivity of the glazing
layers.
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The following is a partial list of THERM warning and error messages, their
probable causes, and possible solutions. Updated information on error
messages can be found at http://windows.lbl.gov/software/software.html.

Array overflow in Mesher. Try reducing the Quad Tree Mesh
Parameter in Therm File Options.
Cause: A very detailed mesh can exceed the limits of the automatic mesh
generator.
Solution: Reduce the Quad Tree Mesh Parameter value under
Options/Therm File Options. If you are getting this error message because
you increased the mesh parameter in response to another message telling
you to "simplify the geometry or increase the mesh parameter", you should
reduce the Quad Tree Mesh Parameter and then simplify the geometry.
Often very minor simplifications in the geometry in areas of fine detail will
result in the mesher being able to generate a mesh.

Calc Manager is Paused. The file won’t be run until you
start it. Do you want to start it?
Cause: The Calc Manager has been set to pause the file on which you are
now trying to do a calculation.
Solution: Unpause it in the Calc Manager, or click on the Yes button to this
message. If you do not want the file to be calculated, click on either the No or
Cancel buttons.

Calculation not successful
Cause: This error message can have many possible causes.
Solution: Read the calculation log by going to the Calc Manager option of
the Calc menu.

Can’t delete a point from a 3-sided polygon.
Cause: Deleting a point from a 3-sided polygon will create an invalid
polygon.
Solution: This error is often caused by the cursor sticking to a different point
than you intended. Try zooming in on the area of interest.

Can’t find glass library (glass.dat) in the glazing system
directory. All glass surface emittances will default to 0.84.
Cause: Emittance data is read from the WINDOW4 library file “glass.dat”.
If THERM does not find this file, it will default all glass emittances to 0.84.
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Solution: Copy the file glass.dat to the same folder as the glazing system
library file glzsys.w4. You only need to do this if you are using the
condensation index or the radiation enclosure model.

Can’t insert a point on top of another point. Try zooming in.
Cause: You are trying to insert a point that is too close to an adjoining point
(within 0.01 mm).
Solution: Use the Zoom feature (click the right mouse button) one or more
times to enlarge the area enough that you can insert the new point at a
distance greater than 0.01 mm from the adjacent point.

Condensation Index Model currently does not support user
defined gas types. Glazing Cavity has a cavity with gas type
Cause: If you import a glazing system from WINDOW that has a userdefined gas (i.e. something other than air, argon or krypton), you will not be
able to use the Condensation Index Model with this version of THERM.

Error: Autofill created an invalid polygon.
Cause: In rare cases, the autofill feature can’t resolve the geometry and will
not be able to fill the cavity.
Solution: Either draw the polygon by hand or try resolving any fine detail
in the surrounding polygons. This often occurs when there are small gaps in
a cavity. Occasionally it occurs when there is detail less than 0.01 mm apart.

Error: There is a radiation enclosure that does not have any
boundary conditions on the model with enclosure radiation
enabled. To change this, the boundary conditions must be
changed to "comprehensive" and the enclosure radiation
model must be checked. Enclosure Polygon ID=
Cause: Every boundary condition that faces a radiation enclosure must have
the enclosure radiation model enabled.
Solution: Edit the boundary condition, make sure the Comprehensive
model is selected and check the Radiation Enclosure Model check box. The
boundary conditions that come in with an imported glazing system from
WINDOW are not compatible with the radiation enclosure model.

Invalid polygon found, stopping simulation. Polygon ID=
Cause: An invalid polygon has been found by THERM, preventing the
calculation from continuing. The error message will list the polygon ID # of
the offending polygon.
Solution: Using the Edit/Select Special menu choice, you can locate the
offending polygon and either correct the problem, or delete the polygon and
redraw it. Invalid polygons are usually created as a result of the point
merging algorithms in THERM. Automatic adjustment of bad points can
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result in invalid polygons. The most common invalid polygon has a zero
area extension. These extension have two points on top of one another. In
order to fix this kind of invalid polygon you must delete one of these points
as well as the end of the extension.

Library names must be unique.
Cause: When defining a new library entry, this error message indicates that
you have used a name that is already in use.
Solution: Use a different name for the new entry that isn’t already being
used.

Maximum number of cavities (9) is exceeded
Cause: A cross-section geometry cannot have more than 9 glazing cavities.
Solution: Reduce the number of glazing cavities in the cross section,
possibly by combining adjacent cavities.

Mesh generation error. Try simplifying the geometry near
point (or try increasing Quad Tree Mesh Parameter in
THERM File Options.
Cause: The finite element mesh generator has encountered problems
generating the mesh in the geometry because the cross section contains too
much detail.
Solution: Simplify the geometry by reducing the number of points in
polygons or combining similar polygons. In addition, you can try increasing
the value of the Quad Tree Mesh Parameter in the Options/Therm File
Options menu. The maximum value allowed is 11.

Model geometry and Boundary Conditions need to be
properly defined before a calculation can be performed.
Cause: If boundary conditions have not been defined for a geometry, you
will get this error message when trying to do a calculation. This can occur if
you do not regenerate the boundary condition after fixing voids and
overlaps.
Solution: Generate the boundary conditions before doing a calculation.

Overlapping regions are not allowed!
Cause: THERM cannot simulate a cross section that has polygons which
overlap adjacent polygons. As you are drawing, if the program detects that
you are about to generate a polygon which overlaps another polygon, it will
display this error message.
Solution: Do not try to draw a polygon which overlaps another polygon. It
may be necessary to zoom in on the area you are drawing in order to avoid
potential overlaps. Sometimes the algorithm for checking for overlaps thinks
you are creating an overlap when you really are not. If you are getting this
message you can turn off the checking under Options/Preferences/Drawing
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Options/Always check for overlapping polygons. In general it is good
practice to keep this feature turned on.

Please enter a positive number for the step size, or choose
absolute coordinate mode.
Cause: You can only enter positive numbers in the Step Size dialog box, if
you are entering Relative values.
Solution: Enter a positive number and use the arrow keys in the direction
opposite to the one you want to go in, or change the Step Size setting to
Absolute in order to enter a negative number.

Points of a polygon cannot overlap. Try Zooming in for
detailed work.
Cause: You are working at too low of a zoom level and the point you are
trying to insert is snapping back to an existing point. This would create two
points on top of each other and THERM does not allow this.
Solution: Zoom in, effectively reducing the sticky distance. This can cause a
problem if you are working with WINDOWS 95 which has limited zooming
abilities. If this is the case try drawing everything around this polygon and
create the polygon using the fill void feature.

Polygon already exists at selected point
Cause: You are trying to use the fill void feature and the cavity is already
filled.
Solution: This can happen when you are filling cavities with the material
colors turned off so turn on the colors and you will be able to tell if the cavity
is filled. It can also happen if you are zoomed out and the cursor in not
located within the cavity that you want to fill, in which case try zooming in.

Solution failed to converge. Try changing relaxation
parameter or decrease convergence tolerance.
Cause: The comprehensive radiation model is an iterative solution and the
convergence criterion is not being met.
Solution: Make the convergence criterion OPTIONS/Preferences/
Simulation larger. The maximum allowable value in 0.01.

The Glazing system can’t be inserted because it overlaps
with existing materials. Try repositioning the Glazing
System Locator or adjacent materials.
Cause: THERM will not allow polygons to overlap one another. This error
message is issued when the glazing system you are trying to insert will
overlap with other polygons in the cross section.
Solution: One possible solution is to move the Locator, which determines
where the lower left corner of the glazing system will be inserted. You may
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need to Zoom in to the drawing in order to see accurately where the Locator
is currently positioned. If changing the Locator position does not solve the
problem, it may be necessary to delete some polygons adjacent to the glazing
system (such as those representing the glazing tape), insert the glazing
system, and then redraw the polygons once the glazing system is in place.
(Glazing tape is specified in its undeformed state, but it will deform when a
real glazing system is inserted into a window. Drawing the polygons
representing the glazing tape in their compressed state is a more realistic
model.) Note that THERM allows you to specify the width of the glazing
system to four decimal points in IP units but WINDOW only specifies it to
three, so measuring the glazing cavities in SI units (reported to three decimal
places in THERM) may help the glazing system fit. Since the match has to be
exact this difference can cause the glazing system not to fit. You can try
pasting the glazing system outside of the cross section and then cutting and
pasting it into location. This may cause overlapping regions but they can be
corrected.

There are materials that lie outside of the Boundary
Conditions
Cause: This is caused by noncontiguous polygons.
Solution: THERM can only analyze one continuous cross section at a time.
You will have to delete any other polygons. The major cause for this error is
very small cracks in the model that are open to the environment.

There are no Ufactor tags defined. Simulate anyway?
Cause: This is a warning based on the assumption that most people are
going to be using THERM to determine U-factors
Solution: If you want to obtain U-factor calculations from THERM, you
must define the U-factor Surface Tags when defining the cross-section
boundary conditions. If you do not, you can ignore this message.

This file is currently being simulated. The changes you
have made may effect the results, so the calculation is
being stopped.
Cause: If you make a change to a file that is currently being calculated, the
program will issue this error message.
Solution: Cancel the calculation (using the Calc Manager), save the changes
to the file, and redo that calculation.

Trouble loading library file.
Cause: When loading one of the libraries (material.lib, bc.lib, or ufactor.lib)
the program either couldn’t find the file or couldn't read it.
Solution: Make sure all the libraries are in the THERM working directory. If
they are there, they may be corrupted. You can reinstall the default libraries
from the installation diskettes.
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Trouble reading Bitmap file.
Cause: If THERM can not read a bitmap file that you are bringing in as an
underlay, this message will be displayed, due to a file format
incompatibility.
Solution: Try generating the bitmap file with another drawing program.

Trouble reading DXF file.
Cause: If THERM can not read a DXF file that you are bringing in as an
underlay, this message will be displayed, due to a file format
incompatibility.
Solution: Try generating the DXF file with another drawing program, or in a
different manner.

Trouble with Auto BC Generation near point:
Cause: Very fine detail that the program cannot resolve.
Solution: Make minor adjustments to the geometry to avoid details less than
0.01 mm.

Trouble with Auto Fill near point:
Cause: Very fine detail that the program cannot resolve.
Solution: Make minor adjustments to the geometry to avoid details less than
0.01 mm.

Trouble with geometry at segment
Cause: Very fine detail that the program cannot resolve.
Solution: Make minor adjustments to the geometry to avoid details less than
0.01 mm.

U-factors are not valid for exporting to Window 4. Check
the U-factor tags and U-factors.
Cause: U-factors other than Frame and Edge are included in the model
Solution: Only Frame and Edge U-factors can be imported into WINDOW.

Unable to fix some trouble with detailed geometry. The
problem areas are circled in red.
Cause: Automatic adjustment of bad points failed.
Solution: Make sure to save the file before you perform the automatic
adjustment of points because this command cannot be undone. If you have
saved the file, when you see this error message redo the boundary conditions
but don’t adjust any bad points. If you have not saved the file you will have
to fix the geometry that THERM has created.
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Warning: The maximum number of meshing iterations
reached before the error target was reached.
Cause: Too low of a percent error energy norm target value for the number
of iterations specified.
Solution: Check the results of interest to make sure that the level of the
percent error energy norm you have specified is required. If it is, increase
the number of iterations. You can also reduce the number of iterations
required by starting with a finer mesh (higher mesh control parameter).

Warning: Can’t find matching glass types for all glazing
systems in the glass.dat library. Emittances for these glass
types will be defaulted.
Cause: Emittance data is read from the WINDOW4 library file “glass.dat”.
If THERM can not find all of the glazings in a glazing system in this library,
it will default all glass emittances to 0.84.
Solution: Add the glazing layer to the glass library within the WINDOW
program. You only need to do this if you are using the condensation index
or the radiation enclosure model.

Warning: There are Materials and/or Boundary Conditions
used by this file that were not stored in the file and are not
in the Libraries. These will display with ""??"" after the
name when they are selected and you need to redefine
them before simulating.
Cause: This sometimes occurs when you are importing files into THERM
that were created in previous versions.
Solution: Unfortunately you will have to redefine the material properties
and boundary conditions.

You can’t close a file while calculations are being
performed. Do you want to stop the calculations and close
the file?
Cause: You have tried to close a file that is currently being simulated.
Solution: Wait until the calculation has finished to close the file, or allow the
program to stop the calculation and close the file.

You need to calculate results first.
Cause: You have tried to view the U-factors for a cross section without
simulation results.
Solution: Calculate the results before trying to view the U-factors. The
Calculation/Display Results is grayed out if the results have not been
calculated for a model. If a file has been saved without the results (the Save
Simulation Results in THM Files box is not checked in the
Options/Preferences menu choice, Simulation tab), the Calculation/Display
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Options menu will be grayed out, but the Calculation/Show U-factors will
be available.

You need to have at least two non-adiabatic boundary
conditions to do a simulation. Check your boundary
condition definitions.
Cause: The cross section does not have two non-adiabatic boundary
conditions.
Solution: The default boundary condition for all boundary segments, except
glazing systems imported from WINDOW4, is Adiabatic. You need to assign
realistic boundary conditions to the boundary segments before the program
can proceed with the calculation.

You need to select a Polygon before doing this
Cause: Trying to add a point to an unselected polygon
Solution: Select the polygon before trying to add a point. A selected
polygon has squares on the vertices.
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Appendix C: Theoretical Background
This manual describes how to specify the geometry, material properties, and boundary conditions required
by THERM. Once those have been defined by the user, THERM automatically, meshes the cross section,
performs the heat transfer analysis, runs an error estimation, refines the mesh if necessary and finally returns
the converged solution. This appendix describes the technical algorithms behind each of these functions in
detail.
AUTOMATIC MESH GENERATION
The first step in a finite-element analysis is the definition of a mesh. This mesh is made up of a finite number
of non-overlapping subregions, known as elements, that cover the whole region under analysis. The manual
creation of a well-conditioned finite-element mesh requires sophisticated knowledge of the solution method.
This labor-intensive component of the finite-element analysis is accomplished for the user in THERM by the
(5)
automatic meshing algorithm, Finite Quadtree. The Finite Quadtree mesh generator is based on a spatial
decomposition procedure that represents the domain of an object as a set of non-overlapping squares,
referred to as quadrants, that are stored in a hierarchic tree. The object to be meshed is placed in a square
universe that entirely encloses it. The square represents the “parent” quadrant; it is subdivided into four,
“daughter”, quadrants. The remainder of the tree is then defined in a recursive manner by subdividing the
boundary and interior quadrants until all quadrants are at the level dictated by the geometry of the object.
The subdivisions continue until each quadrant contains only one material. The mesh control parameter
determines the minimum number of subdivisions preformed by Quadtree. The higher the mesh control
parameter the smaller the maximum size of the finite element in the model. After the quadtree has been
defined, all terminal quadrants are checked to ensure that only one tree level difference exists between them
and their neighbors so that there is not a large size difference between adjacent finite elements in the final
mesh. The final step in the algorithm is to convert the quadtree into a combination of well shaped
quadrilaterals and triangles. For analysis purposes all elements are treated as quadrilaterals. A triangle is
defined as a quadrilateral element in which two of the nodes are coincident. Once the mesh is created it is
sent to the finite element solver.
FINITE ELEMENT SOLUTION
The finite element solver in THERM, Conrad, is derived from the public-domain computer programs
(6,7,12)
TOPAZ2D and FACET
. The governing equation for two-dimensional heat conduction, under the
assumption of constant physical properties, is derived from the general energy equation and is given by the
partial differential equation shown in Eq. 1.

 ∂ 2T ∂ 2T 
 +q = 0
k
+
 ∂x 2 ∂y 2  g



(1)

where,

q g = internal heat generation
subject to the following set of boundary conditions:

qf = 0
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T = f ( x , y)

Temperature boundary condition

qf = q

known heat flux, q , boundary condition

q c = h (T − T∞ )

convection/linearized radiation boundary condition,

q r = ε i σTi 4 − α i H i

radiation boundary condition.

For radiation boundary conditions, THERM assumes that radiating surface segments are gray and isothermal,
so absorptance equals emittance, or α = ε. H is irradiation on the surface. Equation 2 shows the value of H
for a surface i.

Hi =

(

1
B i − ε i σTi 4
1 - εi

)

(2)

where,

B i = radiosity of the surface “i”

B j = radiosity of the surface “j” that views surface “i”

(

)

n

Bi = ε i σTi 4 + 1 − ε i ∑ Fij B j .

(3)

j =1

Equation 3 represents a system of n linear algebraic equations which is solved for Bi, and substituted in Eq. 2.
View factors are calculated using the “cross-string” rule which is illustrated in Figure C-1 and given by Eq. 4.

Fij =

C-2

r12 + r21 − (r11 + r22 )
2L i
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Figure C-1. Cross-String Rule
When partial, or third-surface shadowing exists, the two radiating surfaces are subdivided into n finite
subsurfaces and contributions to the summation in Eq. 5 of those subsurfaces in which ray rkl intersects a
shadowing surface are excluded, as shown in Figure C-2.
n n

Fij = ∑ ∑ Fkl

(5)

k =1l =1

Figure C-2. Third-Surface Shadowing
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The magnitude of the heat flux vector normal to the boundary, q = q + q + q is given by Fourier’s law,
f
c
r
shown in Eq. 6.

 ∂T

∂T
q f + q c + q r = − k
nx +
n y 
∂y
 ∂x


(6)

THERM uses finite-element analysis based on the method of weighted residuals. The method of weighted
residuals seeks to solve an equation of the form shown in Equation 7.

∫∫Ω Wℜdxdy=0

(7)

The residual function, ℜ, results when an approximation for the actual temperature field is substituted in Eq.
1. The residual function is zero for the exact temperature field. The weighted residual method does not seek
to force the residual function to zero everywhere in the domain; instead, the residual function is multiplied
by a weighting factor, W, forcing the integral of the weighted expression to zero and minimizing the error of
the approximate solution. This is accomplished by first integrating Eq. 6 by parts and substituting in the
boundary conditions as shown in Eq. 8.


 ∂ W ∂T ∂ W ∂ T
k ∫∫Ω 
+
− Wq g  dx dy + ∫ Γ Wh c (T − T∞ ) dΓh − ∫ Γ WqdΓq
h
q

 ∂x ∂x ∂y ∂y

[ (

)

]

(8)

− ∫ Γ W ε i σ 4T i 3Ti − 3T i 4 − α i H i dΓr = 0
r

Because the radiation boundary conditions make the problem non-linear, it is necessary to use an iterative
4
technique to obtain the final solution. Term T is linearized by using the first two terms of its Taylor series
i
expansion about T i , the temperature from the previous iteration (the initial temperature is a guess for the
first iteration).
Equation 8 is the “weak” form of the energy equation because it contains only first derivatives. The Galerkin
form of the weighted residual method, used in THERM, relies on algebraic shape functions, N , for the
i
weighting function, W = N , and to approximate the temperature field, T = N T . Equation 4 is set up
i
i i
for each element in a mesh. The integration over each element is approximated by a numerical integration
using second-order Gaussian quadrature where the integration points are as shown in Figure C-3. The local
systems of equations are combined into a global matrix, and a solution is obtained for the unknown nodal
temperatures and heat fluxes.
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Figure C-3. Integration Points for Second-Order Gaussian Quadrature
Once the solution has been obtained on the initial mesh, it is sent to the error estimator, to check for
(18,19)
convergence. The error estimator follows a published method
. Although a detailed description of this
method is beyond the scope of this appendix we include a conceptual overview. Recall that the finite-element
method solves the “weak” form of the energy equation, Eq. 4. We know that some points in the element have
a higher order of convergence than others have, these are called superconvergent points. For quadrilateral
elements used in CONRAD, the superconvergent points coincide with the Gaussian integration points, (g1-g4
in Figure C-3). The first step in error estimation is to use this knowledge of the finite-element solution to
make a good guess at a better solution at all the nodal points. To accomplish this, a least squares method is
used to fit a smooth function to the values of the gradient at the supercovergent points in a patch of elements
around the node. The patch of elements around a node is defined as all the elements sharing that node. A
better solution for the vector field of heat fluxes, q r , at the nodal points is recovered from this smooth
function. The shape functions from the original problem are then used to interpolate the nodal solutions in
order to obtain values for the recovered solutions throughout each element. Using the recovered fluxes, q ,
r
and the original fluxes, q , we calculate the contribution to the global error for each element as:

(

)(

)

1

T
e =  ∫Ω q r − q q r − q dΩ  2



(9)

If the global error is above a specified value, then the error estimator signals the mesh generator, and the
mesh is refined in areas where the potential for error is high. The refined mesh is sent back to CONRAD, and
a new solution is obtained. This process continues until the global error is less than the predetermined
convergence value. The percent error energy norm is the maximum value of the error energy norm divided
by the energy norm of the sum of the recovered fluxes and the error multiplied by 100:
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% Error Energy Norm =

e
qr

× 100

(10)

NOMENCLATURE

e
h
k
nx, ny
qg
q
q

error estimate
Surface heat transfer coefficient
Thermal conductivity
Vector components of the outward facing normal to the boundary
Internal energy source
Known heat flux on the boundary

Nodal flux vector used in error estimation
T
Temperature
x,y
Spatial coordinates
N
Shape functions
ℜ
Residual function
W
Weighting function
Γ
Boundary surface
Ω
Element or problem domain.
Subscripts
∞
Ambient Conditions
Superscripts
T
Transpose
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